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Int roduct ion 

The California Central Valley Groundwater-Surface Water Simulation Model (C2VSim) is an integrated 
hydrologic model that simulates water movement through the Central Valley’s land surface, groundwater and 
surface water flow systems. The C2VSim model was developed with the California Department of Water 
Resources’ (DWR) Integrated Water Flow Model (IWFM) programs.  IWFM uses a unique land-use-based 
approach to calculate water demand and optionally adjust groundwater pumping and/or surface water 
diversions to meet this demand. The C2VSim model contains monthly historical stream inflows, surface water 
diversions, precipitation, land use and crop acreages from October 1921 through September 2009. The model 
simulates the historical response of the Central Valley’s groundwater and surface water flow system to 
historical stresses, and can also be used to simulate the response to projected future stresses. C2VSim can be 
used for integrated regional water management plans, planning studies, groundwater storage investigations, 
assessing infrastructure improvements, evaluating ecosystem enhancement scenarios, conducting climate 
change studies, and assessing the impacts of changes to water operations. 

This tutorial gives an overview of the C2VSim model, the IWFM program, and several useful tools and 
applications. Its goal is to provide users with an understanding of C2VSim as they work with the model and 
modify the model to simulate fictitious case studies. The first section, Getting Started, describes all of the 
programs and files that will be used in the tutorial, where to get them, and how to install them in your 
computer. The section Software Tools gives a brief introduction to some of the programs that will be used. The 
section Using the C2VSim Model shows how to run the C2VSim model using IWFM, how to import model 
results into Excel, how to use the C2VSim ArcMap Tool to view model results, and how to create animations 
with TecPlot.  

The final three sections are the heart of the tutorial, and provide detailed walkthroughs for simulating 
fictitious scenarios with the C2VSim model. In the first scenario, three groundwater wells are added to the 
simulation, and are used to pump water for agricultural use. In the second scenario, an aquifer storage and 
recovery program is simulated. In the third scenario, a groundwater-substitution water transfer program is 
simulated. Each scenario contains detailed instructions for modifying input files and analyzing model results. 
These scenarios show how easy it is to use C2VSim to model proposed water resources projects. 

The C2VSim Model 

DWR developed the C2VSim model as a tool to aid in water management planning in California’s Central 
Valley. The C2VSim model simulates water movement through the interconnected land surface, surface water 
and groundwater flow systems in the systems in the 20,000 mi2 (51,000 km2) area defined by the fresh-water 
alluvial portion of the Central Valley aquifer. The model includes a detailed database of monthly precipitation, 
land use, crop acreage, river inflow and surface water diversion information from October 1921 through 
September 2009. This information is used to calculate historical agricultural and urban water use, 
groundwater pumping, and changes in aquifer storage. 

The C2VSim model simulates the historical response of the Central Valley’s groundwater and surface water 
flow systems to historical stresses, and can also be used to simulate the effects of projected future stresses. 
The model can be used to estimate groundwater pumping rates, which historically have not been measured or 
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reported in the Central Valley. The model can also be used to understand water flows between rivers and 
groundwater aquifers, which are essential for evaluating the impacts of many conjunctive use and water 
transfer programs. The C2VSim model is also the basis for the groundwater component of CalSim 3, a water 
resources planning model for simulating operation of the California State Water Project and Federal Central 
Valley Project, developed in conjunction with the U.S. Bureau of Reclamation. 

C2VSim was developed using the DWR’s IWFM application. IWFM couples a three-dimensional finite element 
groundwater simulation process with one-dimensional land surface, river, lake, unsaturated zone and small-
stream watershed processes. C2VSim dynamically calculates crop water demands, allocates contributions from 
precipitation, soil moisture and surface water diversions, and calculates the amount of groundwater pumping 
required to meet the remaining demand. Model input was compiled from DWRs’ extensive Central Valley land 
and water use data, which has been continuously collected since 1921. 

Required Computer Hardware and Software 

This tutorial will make extensive use of Excel, TextPad and ArcMap, and will also include a demonstration of 
TecPlot. These programs are described below. Instructions for downloading and installing TextPad and 
TecPlot, and extensions for Excel and ArcMap, are detailed in the next section. The IWFM programs and the 
C2VSim model can be run on computers using any recent version of Windows and the Ubuntu version of 
Linux. The auxiliary applications used in this tutorial require Windows 7 or 8. 

TextPad 6 

The C2VSim model is basically a collection of text files that are read by the IWFM application. A text editor is 
required to view and modify these files. The IWFM and C2VSim developers have found that TextPad is a very 
versatile text editor with several useful features. These include the ability to create macros, block select mode, 
syntax highlighting and a tool to display the differences between two files. 

Excel (2007 or  2010) 

The C2VSim model has many input files containing time-series data. These are plain text files, and the data in 
these files is in a tab-delimited format. A spreadsheet program is an Excellent tool for preparing and modifying 
these input data sets. It is very easy to open a file up in a text editor, copy a block of data from the file, and 
paste it into a spreadsheet, where the tab-delimited data will be automatically parsed into rows and columns. 
Similarly, a block of data copied from a spreadsheet can easily be pasted into a C2VSim input file. This tutorial 
makes extensive use of Excel.  

DWR has developed several utilities that work with Excel to greatly facilitate reviewing model results. The 
IWFM Tools Add-In for Excel 2007-2010 adds a new tab to Excel named “IWFM Tools” that holds three 
utilities. One of these utilities will quickly import data from IWFM Budget binary files into Excel; this tool will 
be used extensively in this tutorial to analyze model results. Another tool exports data to text files without 
wrapping lines, and is useful when IWFM input data prepared in Excel must be exported to a text file with 
right-aligned data columns. The third tool can be used to convert time series data into a Water Year-by-Month 
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table and optionally to generate charts, and is very useful in preparing reports and presentations of model 
results.  

ArcMap (10.0 or  later ) 

Geographical Information Systems (GIS) software is extremely useful for preparing model inputs and reviewing 
model results. ArcMap 10 will be used for this tutorial. DWR and RMC-WRIME have developed an ArcMap 
Tool, the C2VSim ArcGIS GUI, to analyze C2VSim model results. This tool will be used extensively in the 
tutorial.  

TecPlot  360 

TecPlot 360 is a computer graphics tool that can be used to visualize model results. The C2VSim model creates 
two files which contain the groundwater heads and land-surface subsidence values in a TecPlot-readable 
format. TecPlot can then be used to create animations or contour maps of groundwater heads and land-
surface subsidence.  
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Gett ing Started 

This tutorial requires the use of a Windows computer with several programs and utilities installed. The tutorial 
exercises involve extensive use of three applications: Excel (2007 or 2010), TextPad and ArcMap 10. There is 
also a brief introduction to TecPlot. You should also download the C2VSim model files and the C2VSim ArcGIS 
files and place them in a convenient location.  

 

Download the C2VSim model files 

Go to http://baydeltaoffice.water.ca.gov/modeling/hydrology/C2VSim/index_C2VSIM.cfm to download the 
C2VSim model files and documentation.  

Two versions of the model files are posted at the web site, C2VSim 3.02-CG Water Years 1922-2009 and 
C2VSim 3.02-CG Water Years 1973-2009. The main differences between the two versions are the starting date 
and the initial condition file. The version at C2VSim 3.02-CG Water Years 1922-2009 has an initial condition of 
October 1, 1921, and the version at C2VSim 3.02-CG Water Years 1973-2009 has an initial condition of 
October 1, 1972.  

Clicking on each of these links will download a zip file. Open the zip file to extract the model files and place 
them in a convenient location on your computer. The examples in this tutorial were placed in the top level of 
the D: drive (D:\). 

This tutorial will use the version in C2VSim 3.02-CG Water Years 1973-2009 because it covers a shorter time 
period, and therefore takes less time to run. 

 

Download the Tutorial files 

While you are at http://baydeltaoffice.water.ca.gov/modeling/hydrology/C2VSim/index_C2VSIM.cfm, scroll to 
the bottom of the page and click the link Additional Resources. This will take you to a site with additional 
C2VSim material including tutorial files and archived versions of the model. Select the C2VSim Training 
Materials folder, then the C2VSim Tutorial folder. Download the zip files posted there. Unzip each file and 
place the contents in a convenient place on your computer.  

The file Tools.zip also contains several items that will be used in this tutorial. Two TecPlot files, 
CVGWheadTecPlot.lay and CVSubsidenceTecPlot.lay, can be placed in the Results folder of the C2VSim 3.02-
CG Water Years 1973-2009 model version to view simulation results in TecPlot. The Excel workbook 
utmconversions.xls will be used to convert coordinates from decimal degrees to the coordinate system used by 
the C2VSim model. 

http://baydeltaoffice.water.ca.gov/modeling/hydrology/C2VSim/index_C2VSIM.cfm�
http://baydeltaoffice.water.ca.gov/modeling/hydrology/C2VSim/index_C2VSIM.cfm�
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The other three files contain completed versions of the examples that will be worked in the tutorial. 
GWP_Example_Complete.zip contains Case Study 1, in which several additional groundwater pumping wells 
are added to the C2VSim model.  ASR_Example_Complete.zip contains Case Study 2, in which an aquifer 
storage and recovery program is simulated using the C2VSim model. GST_Example_Complete.zip contains 
Case Study 3, in which a groundwater-substitution water transfer program is simulated using the C2VSim 
model. Your modified files can be compared to the files in these completed examples, or you can simply follow 
along using the completed examples if you do not feel comfortable modifying the input files yourself. 

Download and install the C2VSim ArcGIS GUI 

Go to http://baydeltaoffice.water.ca.gov/modeling/hydrology/C2VSim/index_C2VSIM.cfm and use the link 
labeled Tool Installer to download the C2VSim ArcGIS GUI installer. Use the links ArcGIS Files: C2VSim 3.02-
CG Water Years 1922-2009 and ArcGIS Files: C2VSim 3.02-CG Water Years 1973-2009 to download the 
ArcGIS files for use with this tool. (This tool was developed for Windows 7 and ArcMap 10.0 or 10.1.) 

The Tool installer link will download the installer program C2VSim_ArcGIS_GUI_Setup.exe. Run this program 
to install the C2VSim ArcGIS GUI. Quit ArcMap before this installation. The installer may ask you to install 
additional programs, such as .Net, if they are not already installed on your computer. 

The C2VSim ArcGIS GUI was developed to work with ArcMap 10 running under Windows 7. Every effort has 
been made to configure the installer to work with most computers. However, conflicts can occur with other 
specific Windows versions or other installed programs. If you encounter problems installing the C2VSim ArcGIS 
GUI, please email the C2VSim ArcGIS GUI developer at IWFMtechsupport@water.ca.gov detailing your 
problems.  

After running the installer, open ArcMap. The C2VSim ArcGIS GUI tool icon should be in the menu bar: 

. If you do not see the C2VSim ArcGIS GUI tool icon, go to the Customize menu, select ‘Customize 
Mode…’, and then the ‘Commands’ tab. Scroll down in the Categories window and select ‘C2VSim ArcGIS 
GUI’. Drag the ‘C2VSim ArcGIS GUI’ item from the Commands window to the toolbar. 

http://baydeltaoffice.water.ca.gov/modeling/hydrology/C2VSim/index_C2VSIM.cfm�
mailto:IWFMtechsupport@water.ca.gov�
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Two versions of the ArcGIS files are available from the web site. ArcGIS Files: C2VSim 3.02-CG Water Years 
1922-2009 corresponds to the model files in C2VSim 3.02-CG Water Years 1922-2009 with an initial condition 
of October 1, 1921. ArcGIS Files: C2VSim 3.02-CG Water Years 1973-2009 corresponds to the model files in 
C2VSim 3.02-CG Water Years 1973-2009 with an initial condition of October 1, 1972. Each of these ArcGIS 
files includes an MXD file; double-click on this MXD file to load the associated data set into ArcMap. 

 

Download and install TextPad  

Go to http://www.TextPad.com/download/index.html. Download the installer, and install an evaluation copy 
of TextPad 6 on your computer.  This is a sophisticated programmer’s text editor with several advanced 
features. TextPad will be used extensively throughout the tutorial. You may also choose to use a different text 
editor that you are more comfortable with. 

 

Download and install the IWFM Excel Tools 

This IWFM Excel Tools will be used to import C2VSim budget tables into Excel to analyze the results of the 
tutorial examples.  

Go to http://baydeltaoffice.water.ca.gov/modeling/hydrology/IWFM/SupportTools/index_SupportTools.cfm. 
Click on the link IWFM Tools Add-in for Excel 2007-2010 and install the tool.  After downloading the setup 
file, double-click it and follow the instructions for installation. After the installer finishes, open Excel and look 
for the “IWFM Tools” tab.  

These tools were developed for Windows 7 and Excel 2007 or 2010. Every effort has been made to configure 
the installer to work with most computers. However, conflicts can occur with other installed programs. If you 

http://www.textpad.com/download/index.html�
http://baydeltaoffice.water.ca.gov/modeling/hydrology/IWFM/SupportTools/index_SupportTools.cfm�
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encounter problems installing the IWFM Tools, please email the developer at IWFMtechsupport@water.ca.gov 
detailing your problems. 

 

Download and install TecPlot , and get a 3-day trial license 

Go to http://www.TecPlot.com/downloads/free-trial-software/. Create a user account and sign in to download 
an evaluation version of the TecPlot 360 program. You can request a 3-day evaluation license. Do not request 
this license until you are ready to do the TecPlot examples, so it will work when you are doing them! 

This program will be used to visualize the change in groundwater heads and land-surface subsidence.  

mailto:IWFMtechsupport@water.ca.gov�
http://www.tecplot.com/downloads/free-trial-software/�
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Software Tools 

This section provides brief tutorials on TextPad, the IWFM Excel Tools and TecPlot. 

TextPad  

This section contains a brief introduction to TextPad and some of the key features that are useful in preparing 
and modifying C2VSim files. Open the TextPad program and explore the tools discussed here. 

TextPad Tools 

TextPad is a text editor that has a number of useful tools and functions. This section shows how to find the 
differences between two files, use block select mode, and enable syntax highlighting. Other useful functions 
include the ability to show line numbers in the left margin, the ability to have multiple files open at the same 
time and do search-and-replace operations across all of them, and the ability to record and save macros.  

Compar ing f iles 

Open two files in TextPad. Select Tools -> Compare Files or use the command <Ctrl-F9>. 

 

This will open the compare files command window. By default, this window contains the top two files in 
TextPad. You can optionally navigate to other files using this window. 

 

Click “OK” and TextPad will display the differences between the two files. The figure below shows an 
example from one of the tutorial cases. The file lines that are different are preceded by either ‘<’ or ‘>’ to 
specify which file they are in. 
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Block se lect  m ode 

Block select mode allows the user to select a block of text. This block can be copied or cut, and search-and-
replace operations can be confined to the selected block of text. This is very useful for extracting data from 
files. 

 

There are two ways to turn block select mode on: through the menus via Configure-> Block select mode, and 
with the key combination <Ctrl-Q> B. 
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Syntax highlight ing  

TextPad can optionally highlight syntax in files, using the file extension to choose the highlight style. The 
example below shows syntax highlighting in a batch file, with the keyword ‘pause’ highlighted in blue. 

 

Syntax highlighting options can be adjusted by selecting Configure -> Preferences -> Document classes: 
syntax highlighting.  

 

Syntax highlighting rules are contained in syntax files. Many TextPad syntax files are available. Several are 
listed below. For C2VSim, we generally use the dosBat.syn file to activate batch file syntax highlighting. 

 

Commonly  Used TextPad Commands 

Find  <F5> 
Find and replace <F8> 
Compare files <Ctrl-F9> 
Block-select <Ctl-Q>B 
Record a Macro <Ctrl-Shift-R> 
Run the Macro <Ctrl-R> 
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IWFM Excel Tools 

The IWFM Excel Tools, available from the DWR web site, contain three Excel add-ins that are useful when 
preparing IWFM input files and reviewing IWFM results. This section explains how to use these tools. 

Space-delim ited  Text  Exporter  

Sometimes we wish to export data from Excel to a space-delimited file, with right-justified data columns. Excel 
allows users to save as ‘Formatted Text (Space delimited) (*.prn)’. However, this option cuts the file into 
blocks approximately 240 characters wide, so it is not suitable for large data sets. The IWFM Space-delimited 
Text Exporter will export large data sets to space-delimited text files without chopping the data into blocks or 
word-wrapping long lines. 

To use this tool, first select the area to be exported using the cursor. Clicking on the ‘Space Delimited Text’ 
button brings up the standard Excel ‘Save As’ dialog, with the type ‘Space delimited text (*.prn)’ and the 
default file name ‘Output.prn’. 

 

This window can be used to navigate to the folder where the new file is to be saved and to provide a name for 
the file. (The file extension can be changed from ‘prn’ to something else, such as ‘txt’, by enclosing the entire 
file name in double quotes.) When the ‘Save’ button is pressed, a dialog window opens to specify the column 
width: 

 

Enter the preferred column width, and press the ‘OK’ button. The dialog box will show the progress of the file 
conversion, and then close when the conversion is complete. 
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Here are sample results: 

 

 

Water-Year  Table Maker  

The C2VSim model contains monthly input data for water years 1922-2009. A water year runs from October 1 
of the previous year to September 30; for example, water year 2009 is October 1, 2008 to September 30, 
2009. It is often convenient to summarize input and output data for reports and presentations in tables with 
one row for each water year and a column for each month.. However, Excel’s standard formulas only work for 
calendar years. In addition, water data must often be converted between units of cubic feet per second (cfs) 
and acre-feet (AF), and between acre-feet, thousand acre-feet (TAF) and million acre-feet (MAF), which require 
conversion factors that are not standard in Excel. The WY-Month tool was created to tabulate time-delimited 
data by water year and to convert data between cfs, AF, TAF and MAF. 

Clicking the ‘WY-Month’ button in the IWFM Tools ribbon brings up the ‘WY-Month’ window. 

 

Click in the ‘Data Range’ area and use the cursor to select the dates, click in the ‘Time Series Data Range’ area 
and select the data, and then click in the ‘Output Range’ area and select a single cell in an empty region of a 
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worksheet where the new table will be created. Optionally use the ‘Unit Conversion’ section by selecting the 
current units of the data under ‘Time Series Data’ and the desired output units under ‘Table’. Use the section 
at the bottom of the window to choose formatting options (the number of decimal places to show, and 
whether to use a 1000’s separator), and to add optional charts (monthly averages and annual totals). Click 
‘OK’ to create the table and the optional charts. 

The resulting table has the water year in the left-most column, monthly values for October through September 
in the central columns, and the water-year total in the right-most column. Rows for the average, maximum 
and minimum monthly and water-year values are added to the bottom of the table. Graphs of the monthly 
averages and annual totals are created to the right of this table. 

 

 

Budget-to-Excel 

The IWFM Budget program reads binary files produced by the Simulation program, and produces space-
delimited text files containing Budget tables in a consistent format. The Budget-to-Excel tool runs the Budget 
program within Excel, and imports the resulting Budget tables to Excel workbooks. This makes it easy to 
analyze, tabulate and graph model results. 

Before using this tool, run the IWFM Simulation program and check that the Simulation binary output files are 
present in the Results folder; Excel will crash if this tool is used when the binary files are not present.  

To use this tool, first create a new, blank Excel workbook. Next, in the ‘Budget to Excel’ panel of the ‘IWFM 
Tools’ ribbon, use the ‘IWFM version’ drop-down menu to select ‘3.02’. (The C2VSim model uses version 3.02 
of IWFM.) 
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This will open the ‘Budget to Excel (3.02)’ dialog box with the word ‘Ready…’ in the lower left corner.  

 

Click the ‘Browse…’ button and navigate to the Budget folder of your C2VSim model run, and select the 
Budget Control File (usually named CVBudget.in). The status indicator will change to ‘Importing…’ as the 
Budget Control File and the binary files produced by the Simulation program are read. A list of the available 
Budget tables will appear in the window below ‘Choose Budget Table’ and the status indicator will change to 
‘Ready…’. This window shows seven Budget tables; this tool does not currently work with the ‘Diversion 
details budget’; do not select this Budget table or Excel will quit. 

 

Select the Budget table to be imported, and then click the ‘Transfer to Excel’ button. The Budget tables will be 
loaded into the Excel workbook, with one worksheet for each table. For tables organized by subregion, there 
will be one tab for each subregion. There will be one tab for each river reach in the Stream Reach Budget, one 
tab for each lake in the Lake Budget, and one tab for each small-stream watershed in the Small Watershed 
Budget.  

After importing a Budget table, save the workbook with an appropriate name. Always open a new blank 
workbook before importing another Budget table.  

  



 C2VSim Hands-On Tutorial  

19 
 

C2VSim ArcGIS GUI 

This section gives a brief overview of the C2VSim ArcGIS GUI, focusing on the components that will be used in 
the tutorial. A more detailed explanation of this tool is available in the C2VSim ArcGIS GUI User’s Manual, 
which is available under the tools’ Help menu. 

Start ing the C2VSim ArcGIS GUI 

The first step you must take when you start the C2VSim ArcGIS GUI tool is to tell the tool which files to use. 
For this tutorial, we will always open the MXD file (and a linked geodatabase) before opening the tool.  

When the MXD file is open, click the C2VSim ArcGUI GUI icon in the menu bar:  This opens the 
window: 

 

To view a PDF version of the C2VSim ArcGIS GUI help document, select the ‘Help’ menu and then ‘User’s 
Manual’. 

To link the tool to the file geodatabase of the MXD file, click the ‘File’ menu and select ‘Use Current’. 

 

Graphing C2VSim results 

Before we can create a graph, we have to display and select an object that is associated with the item we 
want to graph. For example, if we want to graph data associated with a river reach, we must first turn on the 
StreamReaches feature class, and then select the river reach or reaches we want to use. The C2VSim ArcGIS 
GUI requires one additional step: we must make the layer we are interested in the only selectable layer. For 
the StreamReaches feature class, we do this by right-clicking on the StreamReaches layer in the Table of 
Contents window, choosing ‘Selection’ from the drop-down menu, and then choosing ‘Make This The Only 
Selectable Layer’ from the drop-down sub-menu. Later, if we want to graph data associated with another 
feature class such as Subregions, we have to first make that feature class the only selectable layer. 
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Next, you will need to select the individual feature you want to work with. Activate the ArcMap ‘Select 
Features by Rectangle’ tool (the white arrow) in the toolbar. Use this to select a river reach. Then, click on the 
‘Graph’ button in the C2VSim ArcGIS GUI to open the ‘Time Series Graph’ window. Select the ‘Stream Reach 
Budget’ table in the ‘Time Series table’ drop-down menu, then choose a category in the ‘Sub-Data Type Name’ 
drop-down menu, and optionally choose a date range. Click on the ‘OK’ button to produce the graph. Here are 
the results for the ‘Gain from Groundwater’ on Reach 48. 

              

A more detailed walk-through is provided in the section below titled “The C2VSim ArcGIS GUI”. 
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TecPlot  

TecPlot is a powerful graphics program with numerous capabilities for viewing and displaying model output. 
In addition to the ability to make two-dimensional color-map and contour graphs, TecPlot can easily animate 
time series, and can generate three-dimensional color-maps with interior slices. The exercises in this tutorial 
explore only the two-dimensional capabilities of TecPlot. 

Layer  f iles 

TecPlot uses ‘layer files’ to store graphical configuration information. Each layer file contains the name and 
structure of an associated data file. Two TecPlot layer files are available in the Tools folder. These two files are 
associated with the C2VSim 3.02-CG Water Years 1973-2009 version of the C2VSim model. Layer file 
CVGWheadTecPlot.lay uses the simulation results in the file CVGWheadTecPlot.out. Layer file 
CVSubsidenceTecPlot.lay uses the simulation results in the file CVSubsidTecPlot.out. 

To run TecPlot, copy these two files to the Results folder of the C2VSim 3.02-CG Water Years 1973-2009 
folder, and then double-click on one of the layer files. It should open the TecPlot program and display a color 
map of the selected data (heads or land-surface subsidence). It may take a few moments to load the file. 

This tutorial will use the layer file CVGWheadTecPlot.lay for the 1973-2009 model. Double-click on this file, 
and TecPlot will open and display the color map of the initial water table. (All dates in the C2VSim model are 
for the end of a time period. The initial condition is for midnight 9/30/1972, which is equivalent to the start of 
10/1/1972.) The legend has the name of the output file data set ‘GWHEAD1’, which corresponds to the 
groundwater head of model layer 1. 
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Choose the ‘Data’ menu, then ‘Data Set Info…’ to display a window showing the data sets in the data file. 

 

The ‘Zone/Variable Info’ tab shows that this data file has five pieces of data for each point: the X and Y 
locations and the values of GWHEAD1, GWHEAD2 and GWHEAD3, for each month from 9/30/1972 to 
9/30/2009. We can also see information about each variable by selecting it in the right panel. Close the 
window. 

Under the ‘Options’ menu, make sure the Standard sidebar is checked. This will make the left panel visible,  
exposing several useful commands. Place a check box next to ‘Mesh’ to display the finite element mesh. 
Remove the check mark next to ‘Edge’ to remove the rivers. 

 

Contour  colors 

Click the box to the right of ‘Contour’ in the sidebar to open the ‘Contour & Multi-Coloring Details’ dialog. Use 
the drop-down menu to choose which data set to display (GWHEAD1 is the water table, GWHEAD2 is the 
upper confined zone, and GWHEAD3 is the lower confined zone).  

 

Click in the box to the right of the drop-down menu (labeled ‘>>’) to display the color map options. The 
‘Levels’ tab controls the numbering in the legend. The ‘Coloring’ tab controls the range of color values; click 
the box to the right of the grayed-out ‘Use Color Map Group’ to change the colors. The ‘Legend’ tab controls 
the formatting of the legend. Close the window. 
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Display  opt ions 

Clicking on the ‘Zone Style’ button will open the ‘Zone Style’ window, shown below. In TecPlot, each time step 
in the C2VSim output is a separate zone. The ‘Zone Style’ window controls how the data will be displayed, for 
example whether a color map or contour lines (or both) will be displayed. The graphical options for the 
C2VSim data sets are under the ‘Contour’ tab. The ‘Zone Show’ column controls what ‘zone’ is visible. To 
display the map for a different date, select the date row then left-click the ‘Zone Show’ title box and choose 
‘Show Selected Only’. To change the display from a color map to contours, click the ‘Contour Type’ title box 
and choose ‘Lines’, then click the ‘Line Color’ title box and choose ‘Multi1’ in the lower left corner. Color maps 
are generally best for animations. Close the window when you are done. 

 

Animat ion 

To create a movie of the change in groundwater head, select the ‘Animate’ menu and then ‘Zones…’. This 
opens the ‘Animate Zones’ dialog box. 

 

Use the ‘Start Zone’ and ‘End Zone’ drop-down menus to choose the starting and ending dates of the 
animation. Use the ‘Zone Skip’ value to set the number of months in each movie frame (generally 1, 2, 3, 6 or 
12). Use the ‘+’ and ‘-‘ buttons next to ‘Current Zone’ to review the display for individual time steps. Use the 
‘Animate’ drop-down menu to select whether you want to see the animation on the screen, or want to 
generate a movie file. Generally it’s best to view the animation on-screen each time you change a display 
parameter until you are satisfied, then save is as a WMV file (or another file type). Close the dialog box when 
you are done. 
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Using the C2VSim Model 

The C2VSim model is run from the command line using the four IWFM programs Preprocessor, Simulation, 
Budget and Z-Budget. This section shows how to run the C2VSim model, how tom import results to Excel 
workbooks, and how to use the C2VSim ArcGIS GUI. 

Integrated Water Flow Model (IWFM) 

The Integrated Water Flow Model (IWFM) is a water resources management and planning model developed by 
DWR that simulates groundwater, surface water, stream-groundwater interaction, and other components of 
the hydrologic system. IWFM models groundwater flow as a quasi three-dimensional system and solves the 
governing flow equation using the Galerkin finite element method. A unique feature of IWFM is the land use 
based approach of calculating water demand. IWFM simulates stream flow, soil moisture accounting in the 
root zone, flow in the vadose zone, groundwater flow, and stream-aquifer interaction. Agricultural and urban 
water demands can be pre-specified, or calculated internally based on different land use types. Water re-use is 
also modeled as well as tile drains and lakes or open water areas. Another notable feature of IWFM is a “zone 
budget” type of post-processor that includes subsurface flow computations across element faces. IWFM was 
developed by staff in the Modeling Support Branch of the Bay-Delta Office, which is also responsible for its 
technical support. The IWFM application, manuals and tools are available at the DWR IWFM web page, which 
you can find by searching for ‘IWFM’. 

All IWFM input files are text files. The control files for the IWFM programs use the extension ‘.in’, and all other 
files use the extension ‘.dat’. The IWFM programs produce text files with the extensions ‘.out’ and ‘BUD’, and 
binary files with the extension ‘.bin’. The binary files are read by other IWFM programs. 

IWFM input files also support the inclusion of comments within the files. This allows each file to contain 
documentation describing the sources, units, assumptions, etc. for the data in the file. Lines that begin with 
the ‘C’, ‘c’ or ‘*’ character in the first character position are treated as comments and are ignored by the IWFM 
programs. 
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Running C2VSim 

The C2Vsim model is run with four IWFM programs. We will run the C2VSim 3.02-CG Water Years 1973-2009 
version of the model in this tutorial. Most of the input files are identical to the C2VSim 3.02-CG Water Years 
1922-2009 version of the model, with the exception of the initial conditions file and a few lines in the 
Preprocessor Control File. 

This tutorial will give brief explanations of some C2VSim input files. See the C2VSim User Manual, available at 
the C2VSim web site http://baydeltaoffice.water.ca.gov/modeling/hydrology/C2VSim/index_C2VSIM.cfm, for 
detailed descriptions of the input files, including data sources and any assumptions used in compiling the 
data. 

A typical C2VSim run involves executing the Preprocessor, Simulation and Budget programs one time each in 
sequence, and then executing the Z-Budget program one or more times to produce budgets for different user-
defined zonal configurations. Each program can accept the name of the corresponding main input file on the 
command line. The following example shows how the IWFM programs are executed for a C2VSim run. These 
commands are usually written to a batch file so all of the programs can be easily executed in sequence. 

 > Preprocessor3_02 CVPreproc.in 

 > Simulation3_02 CVSim.in 

 > Budget3_02 CVBudget.in 

 > Zbudget3_02 ZBudget_All.in 

 > Zbudget3_02 ZBudget_HRs.in 

 > Zbudget3_02 ZBudget_SRs.in 

 > Zbudget3_02 ZBudget_Elem.in 

 > Zbudget3_02 ZBudget_Elem_L1.in 

 > Zbudget3_02 ZBudget_Elem_L3.in 

 > Zbudget3_02 ZBudget_Elem_L2.in 

 

  

http://baydeltaoffice.water.ca.gov/modeling/hydrology/C2VSim/index_C2VSIM.cfm�
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The Preprocessor  program  

The Preprocessor program compiles the model framework (nodes, elements, rivers, lakes, specified wells, etc.) 
and produces a binary output file that is read by the Simulation program. 

We will examine several Preprocessor input files before running the Preprocessor program. 

Open the Preprocessor folder. 

Preprocessor Control File 
Open CVpreproc.in with TextPad. 

The Preprocessor Control File CVpreproc.in contains four sections. The first section has three lines describing 
the model version that are read by the Preprocessor program and written to the output log file 
PreprocessorMessages.out. The second section lists the files that are used by the Preprocessor program. 
The third section contains two flags to select output options. The final section lists the units and factors to be 
used to convert simulation length and area units to output units. 

The Preprocessor program uses the following files: 

No. File Name Type File Contents 
4 CVpreout.bin Binary Output file (binary format) 
5 CVpreproc.in Text Main input file 
7 CVelement.dat Text Element and node specification 
8 CVnode.dat Text Nodal x-y coordinates 
9 CVstrat.dat Text Aquifer stratigraphy 

10 Cvrivers.dat Text River network configuration 
11 CVlake.dat Text Lake configuration 
12 Cvwells.dat Text Well locations and characteristics 
13 CVcharac.dat  Text Element hydrologic characteristics 

 

Other Files 
Open several of the input files with TextPad, including CVnode.dat, CVelement.dat, CVstrat.dat and 
CVriver.dat, and review their contents. The C2VSim User Manual contains detailed explanations of the 
contents and data sources for each of these files.  

Run the  Preprocessor  program  

Find the file Run_Preprocessor.bat and open it with TextPad (either right-click on the file and choose 
TextPad, or drag it onto an open TextPad window; double-clicking will run the commands in the batch file). 
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The first item ‘..\bin\PreProcessor3_02.exe’ points to the Preprocessor program in the bin directory, and the 
second item is the name of the Preprocessor Control File. The ‘pause’ command in the second line causes the 
command window to remain open so the user can see if the program ran to completion. 

Close the file. 

Double-click Run_Preprocessor.bat to run the Preprocessor program. 

Review Preprocessor  results 

The Preprocessor program produces two output files. The binary file CVpreout.bin is read by the Simulation 
program. The text file PreprocessorMessages.out lists properties of the model finite element grid, rivers 
and specified wells. 

Open the file PreprocessorMessages.out with TextPad.  

The first section of PreprocessorMessages.out repeats the three title lines from the Preprocessor Control 
File. The second section lists the input file names. The third section lists the model subregions and model 
properties. Next, the model nodes, elements, and stratigraphy are listed. This is followed by a listing of the 
river nodes, including the river reaches, ground surface altitude at each river node, and invert (river bottom) 
altitude. The last section provides a list of the specified wells, followed by the apportionment of pumping at 
each well to the model layers. 
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The S im ulat ion program  

The Simulation program reads the CVpreout.bin file produced by the Preprocessor program, then reads a 
number of specification and time-series data files to simulate the evolution of the hydrologic system through 
time. The program produces binary files read by the Budget and Zbudget programs, and several types of text 
files. The text files include a log file; groundwater, surface water, tile drain and subsidence hydrograhs; 
average subregion evapotranspiration; TecPlot data files; the groundwater heads at each node for each time 
step; and the final condition. All of these text files can be read with a text editor.  

CVSim.in 
Open the Simulation Control File CVSim.in with TextPad. 

The file CVSim.in has seven sections. The first section has three lines describing the model version that are 
written to the output log file SimulationMessages.out. The second section lists the input and files used by 
the Simulation program and the output files it produces. The third section contains the starting and ending 
times and the time step (in HEC-DSS format). This is followed by sections for output and debugging options, 
output units, solver controls, and controls specifying the water budget calculation method. 

The following table lists the input files in the Simulation Control File CVsim.in. This includes the binary file 
produced by the Preprocessor program and 21 text files with the ‘.dat’ extension. (The CVpreout.bin file is 
usually in the Preprocessor folder, and the name usually includes the path to the file.) 

No. File Name Type File contents 
5 CVpreout.bin Binary Binary input generated by pre-processor 
7 CVparam.dat Text Hydrologic parameters 
8 CVbound.dat Text Boundary condition data file 
9 [not used] Text Time series boundary conditions data file 
10 CVprint.dat Text Print control file 
11 CVinit_1972.dat Text Initial aquifer heads and pre-consolidation heads 
12 CVsupplyadj.dat Text Supply adjustment specification data file 
13 CVlanduse.dat Text Land use data file 
14 CVcropacre.dat Text Crop acreage data file 
15 CVprecip.dat Text Precipitation data file 
16 CVevapot.dat Text Evapotranspiration data file 
17 CVtiledrn.dat Text Tile drain specification data file 
18 CVurbanspec.dat Text Urban water use specification data file 
19 [not used] Text Agricultural water supply requirement data 
20 CVurbandem.dat Text Urban water demand file 
21 CVinflows.dat Text River inflow data file 
22 CVcropdem.dat Text Crop demand data file 
23 CVPuSp.dat Text Pumping specification data file 
24 CVpump.dat Text Pumping Data File 
25 Cvdivspec.dat Text Surface water diversion specification file 
26 CVdiversions.dat Text Surface water diversion data file 
27 CVIrFr.dat Text Irrigation fraction data file 
28 CVmaxlake.dat Text Maximum lake elevations data file 
29 CVruf.dat Text Irrigation water re-use factor data file 
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Each of the other C2VSim input files is a text file containing a specific type of data. For example, the diversion 
specification file CVdivspec.dat lists all of the surface water diversions, including the source river node, 
destination subregion and land use type (agricultural or urban), evaporative and seepage loss fractions, and 
the data column of the file CVdiversions.dat that holds the diversion volumes. Each of these files is 
explained in detail in the C2VSim User Manual.  

The following table lists the Simulation program output files. This includes one binary file (CVZB.bin) used by 
the Zbudget program, eight binary files used by the Budget program, and nine text files. (Most of the output 
files are written to the Results folder, and the name usually includes the path to the file.) The Simulation 
program also produces a log file, SimulationMessages.out, as it runs. 

No. File Name Type File contents 
31 CVZB.bin Binary Binary output for groundwater zone budget 
32 CVsmwshed.bin Binary Binary output for small watershed flow components 
33 [not used] Binary Binary output for element sub-group details 
34 Cvdiverdtl.bin Binary Binary output for diversion details 
35 CVstreamrch.bin Binary Binary output for stream budget by reach 
36 CVlake.bin Binary Binary output for lake budget 
37 CVlandwater.bin Binary Binary output for land and water use budget 
38 CVstream.bin Binary Binary output for stream budget 
39 CVrootzn.bin Binary Binary output for root zone moisture budget 
40 Cvground.bin Binary Binary output for groundwater budget 
41 CVSubsHyd.out Text Subdicence hydrograph output file 
42 CVAvgET.out Text Virtual crop characteristics output file 
43 [not used] Text Element face flow output file 
44 [not used] Text Boundary flow output file 
45 CVtiledrn.out Text Tile drain/subsurface irrigation hydrograph 
46 CVSWhyd.out Text Stream flow hydrograph 
47 CVGWhyd.out Text Groundwater level hydrograph 
48 CVGWheadall.out Text Groundwater level output at every model node 
49 [not used] Text Layer vertical flow 
50 CVGWheadTecPlot.out Text Groundwater heads for TecPlot 
51 CVSubsidTecPlot.out Text Subsidence output for TecPlot 
52 CVfinallist.out Text Final simulation results 

 

CVprint.in 
Open the Simulation Print Specification File CVprint.dat with TextPad.  

The Simulation program can produce several types of hydrograph output. The user controls the number and 
locations of these hydrographs using the Print Specification File CVprint.dat. 

The Print Specification File has six sections. The first section contains a list of the groundwater hydrograph 
locations, specified by either a node number or X-Y location. Stream hydrograph locations are specified by 
river node number in the second section. Tile drain hydrograph locations are listed in the third section. The 
fourth section has subsidence hydrograph locations, specified by either a node number or X-Y location. The 
final two sections, boundary node flow hydrographs and element face flow hydrographs, are not used in the 
C2VSim model.  
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Any information to the right of that required by the Simulation program is ignored by IWFM. We can use this 
area to the right of each specified hydrograph to add comments describing the hydrograph location. In the 
C2VSim CVprint.dat file, comments have been added for each of the hydrographs listing, for example, the 
observation well or stream gage that corresponds to the hydrograph. 

Close the CVprint.dat file.  

 

Running the S imulat ion program  

Find the file Run_Simulation.bat and open it with TextPad.  

 

The contents and format are similar to the Run_Preprocessor.bat file described above. The first item 
‘..\bin\Simulation3_02.exe’ points to the Simulation program in the bin directory, and the second item is the 
name of the Simulation Control File. The ‘pause’ command in the second line causes the command window to 
remain open so the user can see if the program ran to completion. 

Close the file. 

Double-click Run_Simulation.bat to run the Simulation program. 

Review Simulat ion results 

The Simulation program produces nine binary files and nine text files, listed above, and the log file 
SimulationMessages.out. The log file and final conditions file (CVfinallist.out) are written to the 
Simulation directory, and the other files are written to the Results directory.  

Simulation log file 
Open SimulationMessages.out with TextPad. 

The first section of SimulationMessages.out repeats the three title lines from the Simulation Control File. If 
the value of KDEB in the Simulation Control File was set to 1, then the next section will list the aquifer 
parameter values for each node. The next section has the solver messages for each iteration and time step. 
The last line gives the total run time for the Simulation program. 

Close SimulationMessages.out. 

Final conditions 
Next, open the file CVfinallist.out with TextPad. 
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The CVfinallist.out file has the final groundwater heads, unsaturated zone water content, root zone water 
content, etc. for the simulation. This is stored in the same format as an initial condition file, so this final 
condition can be used as the initial condition for a subsequent model run.  

The TextPad ‘Find’ command can be used to quickly review this file. Press the <F5> key to open the ‘Find’ 
window, then enter a capital ‘C’, a space, 5 stars and another space (“C ***** “), then press the return key. 
These characters are repeated at the beginning of each section of this file. Once this character string is entered 
in the ‘Find’ command, we can use <Ctrl-F> to move to the occurrence of this string.   

The first line that begins with “C ***** “ lists the simulation time step number. Use <Ctrl-F> to move to the 
next occurrence. The second line that begins with “C ***** “ is the start of the groundwater heads section. 
Use <Ctrl-F> to move to the start of the root zone soil moisture for each subregion and land use type, the 
unsaturated zone water content for each element, the small-stream watershed soil moisture and groundwater 
content, the lake surface elevations, and finally the interbed thickness and preconsolidation head value at 
each groundwater node.  

Results directory 
The remaining Simulation output files are in the Results directory. Move up one level and then down into the 
Results directory. 

Compare the list of .out and .bin files in CVsim.in (and the table above) to the files in the Results folder. 

CVGWhyd.out 
Open the file CVGWHyd.out with TextPad. 

The groundwater hydrographs specified in the CVprint.dat file are written to the CVGWHyd.out file.  

The CVprint.dat file specifies 1387 groundwater hydrograph locations. The CVGWHyd.out file has one 
column with the date and 1387 columns for the groundwater hydrographs. The header lines at the top of the 
file list the aquifer layer and element of each hydrograph. The left-most column contains the time step in HEC-
DSS format with the month, day, year, underline character, and the hour. For example, the first time step is 
“10/31/1972_24:00“.  

The files CVSWHyd.out, CVSubsHyd.out and CVtiledrn.out contain hydrographs for surface water flows, 
land-surface subsidence, and tile drain output. 

 

  



 C2VSim Hands-On Tutorial  

32 
 

The Budget  program  

The Budget program reads binary files produced by the Simulation program and creates Budget tables as text 
files. For each binary file, the Budget program produces a text file with the same root name and the extension 
‘.BUD’. For example, when it reads the groundwater budget binary file CVground.bin, it produces the 
groundwater budget text file CVground.BUD. 

The Budget Control File is in the Budget directory. From the Results directory, move up one level, and then 
down into the Budget directory. 

Budget Control File 
Open CVBudget.in with TextPad. 

The Budget Control File CVBudget.in contains five sections. The first section lists the files that are used by 
the Budget program. The second section lists output unit names and conversion factors to convert from model 
units (feet) to budget output units (for example, acres or acre-feet). The next sections have the cache size and 
output control options. The final section lists the subregions names and print options. These are explained in 
more detail in the C2VSim User Manual. 

No. File Name Type File contents 
1 CVlandwater.bin Binary Land And Water Use Budget  
2 CVstream.bin    Binary Streamflow Budget 
3 CVrootzn.bin    Binary Root Zone Moisture Budget 
4 CVground.bin    Binary Groundwater Budget 
5 [not used] Binary Element Sub-Group Details  
6 CVsmwshed.bin   Binary Small Watershed Flow Components 
7 CVlake.bin      Binary Lake Budget 
8 CVstreamrch.bin Binary Stream Budget By Reach  
9 CVdiverdtl.bin  Binary Diversion Details   

 

Close the CVBudget.in file. 

 

Run the  Budget  program  

Open the file Run_Budget.bat with TextPad. 

 

The contents and format are similar to the Run_Preprocessor.bat file described above. The first item 
‘..\bin\Budget3_02.exe’ points to the Budget program in the bin directory, and the second item is the name of 
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the Budget input file. The ‘pause’ command in the second line causes the command window to remain open 
so the user can see if the program ran to completion. 

Close the file. 

Double-click Run_Budget.bat to run the Budget program. 

Review Budget  results 

The Budget program reads eight binary files and produces eight text files for the C2VSim model (listed above) 
and the log file BudgetMessages.out. The log file is written to the Budget directory, and the others are 
written to the Results directory.  

Budget log file 
Open BudgetMessages.out with TextPad. 

The BudgetMessages.out does not contain much information. There is a message stating that the program 
ran successfully, and the run time.  

Close BudgetMessages.out. 

Results directory 
The remaining Budget output files are in the Results directory. Move up one level and then down into the 
Results directory. 

Compare the .bin and .BUD files listed in CVBudget.in (and the table above) to the files in the Results folder. 
For each .bin file (with the exception of CVZB.bin, used by the ZBudget program), there should be a 
corresponding .BUD file with the same root name. 

CVground.BUD 
Open the Groundwater Budget File CVground.BUD with TextPad. 

The Groundwater Budget File has 22 tables, one for each of the 21 model subregions, and one (labeled 
‘Subregion 22’) summarizing the groundwater budget for the entire model area. Each table begins with three 
title lines listing the IWFM version, the budget and subregion, and the subregion area. This is followed by a 
three-line table header with column titles. The third line of this header contains either a (+) or a (-) symbol, 
indicating the flow direction for the items in this column.  

The groundwater budget table format is identical for the 21 subregions and the entire model area (subregion 
22). There are 16 columns: the date and time, 13 flow terms, the discrepancy (error for the time step), and the 
cumulative subsidence volume. Each line has a complete water balance, with the 13 flow terms and the 
discrepancy adding to zero. 

The characters 'IWFM' are repeated at the beginning of each subregion section, making it easy to step through 
the file. We can use ‘Find’ to quickly move through the file. Press the <F5> key and enter the letters ‘IWFM’, 
then his return. Then use <Ctrl-F> to move to the title area for each model subregion. 
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We can also explore this table and the other budget tables with the IWFM Excel Tools and C2VSim ArcGIS 
GUI. 

Close the CVground.BUD file. 

You can repeat this for the other budget files. 

 

 

The Z-Budget  program 

The ZBudget program uses information in the CVZB.bin file to create budget tables for user-specified aquifer 
zones. The elements in these zones are specified in a ZBudget Control File. Several ZBudget Control Files with 
different zonal configurations are distributed with the C2VSim model, and are listed in the table below.  

File Zones 
zbudget_SRs.in Subregions 
zbudget_HRs.in Hydrologic regions 
zbudget_all.in Model area (one zone) 
ZBudget_Elem.in Individual elements 
ZBudget_GWBasins_All.in Groundwater basins (B116) 

 

The ZBudget Control Files are in the ZBudget directory. Move up one level from the Results directory and then 
down into the ZBudget directory. 

 

ZBudget_SRs.in 
Open the ZBudget Control File ZBudget_SRs.in with TextPad. 

The ZBudget_SRs.in Control File specifies 21 zones identical to the 21 model subregions. The 
ZBudget_SRs.in file has four sections. The first section lists the input binary file produced by the Simulation 
program, and three output control items. A key output control option is the value of ZEXTENT: if ZEXTENT = 0 
then the layer is specified for each zone, and if ZEXTENT = 1 then the zone includes all aquifer layers. The 
second section contains the starting and ending times (in HEC-DSS format). The third section lists the 
elements, the positive integer zone number each element is in, and (if ZEXTENT = 0) the model layer in that 
zone. ZEXTENT = 1 for this file, so this section has only two columns, for the element number and zone 
number. The final section list the zones that will be compiled and printed to the output file. All 21 zones are 
listed. 

Running the ZBudget  program  

Find the file zbudget_SRs.bat and open it with TextPad.  
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The file begins with two comment lines, one of which describes the zonal configuration of the ZBudget Control 
File.  

In the first command line, the first item ‘..\bin\ZBudget3_02.exe’ points to the ZBudget program in the bin 
directory, and the second item is the name of the ZBudget Control File.  

The ZBudget program produces a budget file with the same root name as the input binary file, CVZB.BUD for 
the C2VSim model. This can lead to problems because the ZBudget program is commonly run several times, 
for several different zonal configurations, for each C2VSim scenario. The batch file includes commands to copy 
this generically named output file to a file with the same root name as the ZBudget Control File, and to copy 
the ZBudgetMessages.out log file to a file with the same root name as the ZBudget Control File and the 
file extension ‘.out’.  

The ‘pause’ command at the end of the file causes the command window to remain open so the user can see if 
the program ran to completion. 

Close the ZBudget_SRs.bat file. 

Double-click ZBudget_SRs.bat to run the ZBudget program. 

Review ZBudget  results 

When the ZBudget program is run with the ZBudget_SRs.in Control File and the ZBudget_SRs.bat batch 
file, two files are created in the Results directory. ZBudget_SRs.BUD holds the ZBudget output, and 
ZBudget_SRs.out is the log file.  

ZBudget log file 
Open ZBudget_SRs.out with TextPad. 

 

The ZBudget log file ZBudget_SRs.out is similar to the Budget program log file. It reports that the program 
ran and lists the run time. 

Close ZBudget_SRs.out. 
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ZBudget budget file 
Open ZBudget_SRs.BUD with TextPad. 

The ZBudget file is similar to the Groundwater Budget file, but the ZBudget file contains significantly more 
details. The ZBudget output file for the 21 model subregions has 21 tables, one for each subregions. Each 
table begins with two title lines listing the IWFM version and the zone number. This is followed by a four-line 
table header with column titles. The first column has the data and time, and the last column has the 
discrepancy. All of the other columns are paired, with inflow volumes in the left column and outflow volumes 
in the right column.  

The first 12 items (after the data and time) are repeated in all of the tables in the file; each item has two 
columns, yielding 24 data columns. To the right of these are columns listing the flows between the subject 
zone and adjacent zones. The number of data columns depends on the number of adjacent zones. 

Each row of the ZBudget file has a complete water balance. If the values are added up, with the correct sign 
applied for inflow and outflow, the sum will equal the value in the Discrepancy column. 

The characters 'IWFM' are repeated at the beginning of each zonal section, making it easy to step through the 
file. We can use ‘Find’ to quickly move through the file. Press the <F5> key and enter the letters ‘IWFM’, then 
his return. Then use <Ctrl-F> to move to the title are for each zone. 

Close the ZBudget_SRs.BUD file. 

 

This section provided a brief introduction to the C2VSim input files. More detailed information is provided in 
the C2VSim User Manual.  
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Importing C2VSim Results to Excel 

The IWFM Excel Tools contain a utility to import C2VSim budget files into Excel workbooks. It is generally 
much easier to work with the Excel version of a Budget table than with the text version. 

To begin, open Excel and create a new blank workbook.  

Follow the instructions in the section Budget-to-Excel above to open the CVBudget.in file, select 
"Groundwater Budget", and then select "Transfer to Excel". The Groundwater Budget is transferred to the 
open Excel workbook, with one tab for each subregion (1 to 22). Close the ‘Budget to Excel (3.02)’ window. 
Save the Excel workbook as ‘Groundwater Budget.xlsx’. 

Groundw ater  Budget .x lsx  

Go to the far left tab, labeled ‘Subregion 1 (DSA 58)’, and compare the values to those in the file 
CVground.BUD (open this file in TextPad). The columns, text and values in the two versions should be 
identical. 

Making a Graph 

Next, we will make a graph of ‘Gain from Stream’ for subregion 1.  

First, select cells F6- F449. Then go to Insert -> Scatter -> Scatter with straight lines 

 

The graph will appear in the middle of the screen. Next, we have to add the series name, format the axes, etc. 

To add the series name, right click on the line in the graph and choose Select Data. This will open the ‘Select 
Data Series’ panel. Select ‘Series1’ and then Edit. This will open the ‘Edit Series’ window. Click the box with 
the red arrow, next to the white box below ‘Series name:’, and then select cell F5. Click the box with the red 
arrow, next to the white box below ‘Series X values:’ and select cells A6-A449. Then click ‘OK’ to close the 
‘Edit Series’ window, and click ‘OK’ again to exit the ‘Select Data Source’ panel. The graph now has dates on 
the x-axis. 
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Before continuing, move the graph to its’ own worksheet page by right-clicking in the graph and selecting 
Move Chart and then New Sheet. 

Next, we can format the x-axis for a yearly time step. Right-click on the x-axis and select ‘Format axis…’ to 
open the ‘Format Axis’ panel. Change the radio button from ‘Auto’ to ‘Fixed’ for ‘Minimum’, ‘Maximum’, 
‘Major unit’ and ‘Minor unit’. Then set the value of ‘Minimum’ to ‘26603’ (the value for 10/31/1972), the 
value of ‘Maximum’ to ‘40086’ (the value for 9/30/2009), the value of ‘Maximum unit’ to ‘3652.5’ (or 10 
years), and the value of ‘Minor Unit’ to ‘365.25’ (one year). Then select ‘Number’ in the left panel, uncheck 
the box next to ‘Linked to source’, and change the text in the ‘Format code:’ box to ‘mm/yyyy’ and then click 
the ‘Add’ box. Next select ‘Alignment’ in the left pane and use the ‘Text Direction’ drop-down menu to select 
‘Rotate all text 270o’. Then click on the ‘Close’ button to close the ‘Format Axis’ panel. 

Next we can format the y axis. Right-click on the y-axis and select ‘Format axis…’ to open the ‘Format Axis’ 
panel. In the bottom part of the ‘Axis Options’ panel, change the value for ‘Axis value’ to ‘-1e7’. Select 
‘Number’ in the left panel, uncheck the box next to ‘Linked to source’, change the number next to ‘Decimal 
places’ (near the top of the panel) to zero, and check the box ‘Use 1000 separator (,)’, and then click the ‘Add’ 
button. 

 

This graph shows the monthly fluctuations in flows between the stream and the adjacent aquifer. The flow 
direction depends on the sign and the perspective. This graph is from the perspective of the groundwater flow 
system. When the flow value is negative, flow is from the groundwater to the stream (the stream is gaining), 
and when the flow value is positive, flow is from the stream to the groundwater (the stream is losing). 
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Creat ing  a Water  Year  table  

We often need to format model output to better understand what the model says is happening, and to prepare 
reports. The IWFM Water Year Tool was created to create tables and graphs summarizing model output by 
water year. We will make a water year table of the ‘Gain from Stream’ values for subregion 1. 

First, click on the ‘WY-Month’ button in the IWFM Tools ribbon to bring up the ‘WY-Month’ window. Click in 
the ‘Data Range’ area and then use the mouse to select the dates range A6-A449. Next, click in the ‘Time 
Series Data Range’ area and use the mouse to select the data range F6-F449. Click in the ‘Output Range’ area 
and use the mouse to select cell U6. Set the ‘Decimal Digits’ value to zero, and check the three boxes at the 
bottom of the panel. Click ‘OK’ to create the table and graphs. 

Monthly and long-term patterns of stream-groundwater flows are easier to see using this table and graphs. 
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The C2VSim ArcGIS GUI 

The C2VSim ArcGIS GUI was recently developed to facilitate working with the C2VSm model input files and 
results. The C2VSim ArcGIS GUI is in beta release. Keep this in mind when working with this tool: save your 
work frequently and keep backups of important files.  

The C2VSim ArcGIS GUI works with two linked files, an ArcMap project file (with an mxd extension) and a 
geodatabase. Double-click on the C2VSim_CG_1972IC_R369.mxd project file to open it. 

Add a Background 

When you import model results into the C2VSim ArcGIS GUI, the ArcMap project file will not hold an 
associated background file. You can add the dynamic world imagery and world topographic maps 
backgrounds using layer files distributed by ESRI.  

First, right-click on Layers and choose Add data. Navigate to the two layer files World_Imagery.lyr and 
World_Topo_Map.lyr and select them, then click the ‘Add’ button. 

 

Change the order  of  the items 

The Table of Contents pane shows the model components that are available for display. The item at the top in 
the Table of Contents appears at the top in the viewing window, the next item in the Table of Contents 
appears beneath the top item in the viewing window, etc. The ArcMap project file Table of Contents lists the 
items in the order that they were assembled when the project file was created. It is generally useful to re-
arrange them so wells are on top, followed by river nodes, nodes, river reaches, elements, subregions and 
small-stream watersheds.  

In the Table of Contents, drag the items into this order, and then save the project file. 

1) Calibration well 
2) Production well 
3) StreamNode 
4) Node 
5) StreamReaches 
6) Element 
7) Subregion 
8) Small_Watersheds 

 

 



 C2VSim Hands-On Tutorial  

41 
 

ArcGIS overview  

This section provides a brief introduction to some key ArcMap features and tools. You can skip to the next part 
if you are familiar with ArcMap.  

Table of Contents 
All of the feature classes and basemap layers that make up a project are listed in the Table of Contents. The 
visibility of items is also controlled using the Table of Contents. Items with a check mark to their left are 
visible, and items without a check mark are invisible. Items on the top of the list are closest to the viewer and 
items at the bottom may be hidden behind feature classes above them. 

 

In the Table of Contents above, the StreamReaches, Element, Subregion, SmallWatershed and World_Imagery 
layers are visible. The StreamNode, Node, CalibrationWell and ProductionWell layers are not visible. 

Turn the selection box for Subregion off (click in the white box to remove the check mark) and the Subregion 
items will become invisible. Turn the selection box for Subregion on (click in the white box again to add the 
check mark) and the Subregion items will reappear.  

‘Zooming’ in and out 
The magnifying glass tools with the ‘+’ and ‘-‘ marks in the center allow you to zoom in and out; you may also 
be able to do this with the mouse’s scroll wheel. Select the ‘+’ magnifying glass in the toolbar. Use the 
magnifying glass and left mouse button to draw a square around an area. When you release the mouse 
button, ArcMap will zoom in to the selected area.  Select the ‘-‘ magnifying glass in the toolbar. Use this 
magnifying glass and the left mouse button to draw a square. When you release the mouse button, ArcMap 
will zoom out in proportion to the size of the area you selected. 

Moving around 
The hand-shaped tool in the ArcMap toolbar is called the ‘pan’ tool. With this tool, you can move the picture 
inside the ArcMap frame to see other parts of the coverages. Select the hand tool, click inside the map, and 
slide the mouse to one side as you hold the mouse button. 

Returning to the previous view 
Sometimes you move the map to see something, and then want to go back to the area you were previously 
viewing. ArcMap refers to these views as ‘Extents’. There are two blue arrows in the tool bar, one pointing left 
and one pointing right. Click on the left one to go to the previous extent, and then click on the right one to go 
to the next extent.  
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‘Zoom’ to see the entire model 
To see the entire model, right-click on Subregion in the Table of Contents and select 'Zoom to layer' 

Changing Subregion properties 
The colors, thicknesses and other properties of layers are controlled through ArcMap’s ‘Properties’ controls. 
Double-click on Subregion in the Table of Contents to bring up the ‘Layer Properties’ control panel.  

Select the ‘Display’ tab. The box next to ‘Transparent:’ should have a zero. Change this to ‘70’ and click 
‘Apply’ in the lower right corner of the panel. You should now be able to see through the Subregion items.  

Select the ‘Labels’ tab. Click in the box at the upper left next to ‘Label features in this layer’ to turn labeling 
on. Click on the drop-down menu in the ‘Text String’ area next to ‘Label Field:’ and select ‘Subregion_ID’. Use 
the items in the ‘Text Symbol’ area to change the font properties to red, bold, 12 point. Click ‘Apply’ in the 
lower right corner of the panel. You should now be able to see the Subregion numbers. 

Select the ‘Symbology’ tab. This is where you can change the colors and thicknesses of items. We will leave 
the default settings in place for now. 

Click ‘OK’ to exit the ‘Layer Properties’ panel. 

Changing stream reach properties 
Double-click on Streamreaches in the Table of Contents to bring up the ‘Layer Properties’ control panel. 

Select the ‘Symbology’ tab. In the left pane, choose ‘Categories’. In the dropdown under ‘Value Field’ choose 
‘ReachID’. The box in the middle will show one line for each river reach. Position the mouse pointer over any 
one of the reaches in this box, right-click and select ‘Properties for all symbols’. The ‘Symbol Selector’ panel 
will open. On the right side of this panel, set the number in the box next to ‘Width:’ to 3.00, and then click on 
‘OK’ to close the ‘Symbol Selector’ window. Click ‘Apply’ to see the changes applied to the stream reaches. 

Select the ‘Labels’ tab. Click in the box at the upper left next to ‘Label features in this layer’ to turn labeling 
on. Click on the drop-down menu in the ‘Text String’ area next to ‘Label Field:’ and select ‘Reach_ID’. Use the 
items in the ‘Text Symbol’ area to change the font properties to ultra blue, bold, 12 point. (When selecting the 
color, hold the mouse pointer over a color for a second and a pop-up with the color name will appear.) Click 
‘OK’ in the lower right corner of the panel to close the panel. You should now be able to see the Reach 
numbers. 

You can use these stream reach numbers with the reach table in the C2VSim User Manual to identify the 
reaches. 

Quickly turning labels on and off 
Subregion and stream reach numbers were turned on above. To turn Subregion labels off, right-click on 
Subregion. In the menu that pops up, you should see a check box next to ‘Label Features’. Highlight ‘Label 
Features’ with the cursor and let go of the mouse button to switch the mode of the labels, from off to on or 
from on to off. Do the same for the StreamReaches layer. 
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Another way to ‘zoom’ 
In the Table of Contents, right-click on Subregion and select ‘Open attribute table’. This will open a table with 
all of the items in the Subregion feature class, one row for each item (each model subregion). Find the row 
that has ‘4’ in the column labeled ‘Subregion_ID’. Click with the left mouse button in the tiny gray box on the 
left end of this row to select subregion 4. Then put the mouse cursor in the tiny gray box on the left end of this 
row again, and right-click. Choose ‘Zoom to selected’ in the pop-up menu. ArcMap will zoom in or out so this 
subregion is in the center of the window. 

Click on the ‘Table of Contents’ tab at the bottom of the pane to return to the Table of Contents. Right-click 
on Subregion and select ‘Zoom to Layer’ and ArcMap will show the entire C2VSim model centered in the 
window. 

 

C2VSim  Fram ework  

The C2VSim framework is defined in the Preprocessor input files. The information in these files was used to 
create the basin feature classes used in the C2VSim ArcGIS GUI geodatabase. These are in turn used in the 
C2VSim ArcGIS GUI  to display model information. 

The basic building block of the C2VSim model is the nodes. To see the nodes, turn on the check box next to 
the Node layer. (You may want to turn off other layers, and/or change the color through the ‘Properties’ 
panel.)  

The nodes are used to construct elements. To see the elements, turn on the check box next to the Element 
layer.  

The rivers are delineated using river reaches and river nodes. River nodes are at the same locations as model 
nodes. River reaches link river nodes into a flow network. To see the river nodes, turn on the check box next to 
the StreamNode layer. To see the river reaches, turn on the check box next to the StreamReaches layer.  

Elements are grouped into subregions for water budget calculations. Turn on the check box next to the 
Subregion layer to see the subregions.  

Surface water and groundwater flow from ungaged watersheds adjacent to the model boundary is calculated 
using small-stream watersheds. Turn on the check box next to the Small_Watersheds layer to see these. 

 

Start ing the C2VSim ArcGIS GUI 

Open the ArcMap project file C2VSim_CG_1972IC_R369.mxd by double-clicking on it. This will start 
ArcMap and load the contents of the C2VSim_CG_1972IC_R369 geodatabase. This geodatabase contains 
feature classes of the C2VSim model components (nodes, elements, etc.) and tables of model input and output 
data. 
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Open the C2VSim ArcGIS GUI with the icon in the menu bar:  This will open the C2VSim ArcGIS GUI 
panel. 

Under the ‘File’ menu, select ‘Use Current’. This will tell the GUI to use the C2VSim_CG_1972IC_R369 
geodatabase for subsequent operations. 

 

 

Running C2VSim  

The C2VSim ArcGIS GUI can be used to run the C2VSim model. C2VSim results can then be loaded into a 
geodatabase and viewed through the GUI. Running a model and loading the results are too time-consuming 
for this tutorial, but are covered in the C2VSim ArcGIS GUI manual, accessable through the GUI’s ‘Help’ menu.  

 

 

Viewing C2VSim Results 

There are three ways to view C2VSim results with the C2VSim ArcGIS GUI. These can be accessed using the 
‘Analysis’ menu. Budget table items associated with individual model features can be viewed using the 
‘Graph’ function. Summary statistics for selected items can be produced using the ‘Statistical Analysis’ 
function. Groundwater head maps can be created using the ‘GW Head Raster/Contour’ function.  
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You can create graphs using either the ‘Graph’ item in the ‘Analysis’ menu or the ‘Graph’ button on the lower 
right corner of the ‘Analysis’ tab. 

 

Creating a Graph 
The Graph tool allows us to create graphs of any Budget table item associated with a feature class. For 
example, a time-series graph of each of the columns in each of the Budget tables associated with Subregion 
20 (Land and Water Use, Root Zone, Groundwater, Streams) can be created by selecting the subregion and 
then using the Graph function. Similarly, all of the items in the Stream Reach Budget table for reach 53 can be 
graphed by selecting reach 53 and then using the Graph function.  

We will explore this capability by creating a time-series graph of the groundwater pumping for Subregion 20. 
We will then add a time-series for subsidence, and place subsidence on a separate Y axis. We will then export 
the data in the graph to an Excel workbook. 

Create a Pumping Graph 
In the ‘Table of Contents’ panel, right-click ‘Subregion’, select the ‘Selection’ option, and then ‘Make This The 
Only Selectable Layer’. 
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Next, select subregion 20. This can be done by dragging out a small rectangle inside the subregion using the 
‘Select Features by Rectangle’ tool (the white arrow), or by right-clicking on Subregion in the Table of 
Contents, opening the attribute table and selecting the subregion. 

After selecting the subregion, press the ‘Graph’ button in the C2VSim ArcGIS GUI window. This opens the 
‘Time Series Graph’ panel. Select ‘Groundwater Budget’ in the ‘Time Series Table’ drop-down menu. The ‘Sub-
Data Type Name’ drop-down menu will become active. Select ‘Pumping’ in the ‘Sub-Data Type Name’ drop-
down menu.  

 

Click ‘OK’ and the graph will appear. 
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Add Subsidence to the Graph 
We can add the monthly subsidence to this graph to see if the relationship between pumping and subsidence 
appears relevant. 

Press the ‘Graph’ button in the C2VSim ArcGIS GUI window again. This opens the ‘Time Series Graph’ panel. 
‘Groundwater Budget’ is already in the ‘Time Series Table’ drop-down menu and ‘Pumping’ is in the ‘Sub-Data 
Type Name’ drop-down menu. Change the ‘Sub-Data Type Name’ drop-down menu to ‘Subsidence’ and click 
‘OK’. The subsidence time series will be added to the graph. 

 

The maximum pumping volume is much greater than the maximum subsidence volume, and the minimum 
subsidence volume is less than zero. This makes it difficult to compare pumping and subsidence to see how 
they are related. We can see the relationship better if we move subsidence to the right-hand axis. Right-click 
in the graph and choose ‘Properties…’ from the menu. The ‘Graph Properties of Groundwater Budget’ panel 
will appear. Click in the ‘Subsidence’ tab at the bottom, if it is not already selected. Use the drop-down menu 
next to ‘Vertical Axis’ to change the vertical axis from ‘Left’ to ‘Right’, and click ‘OK’. Subsidence will now be 
on the right-hand axis, and the relationship between pumping and subsidence will be clearer.  
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Exporting Data from the Graph 
The graphing capability of the C2VSim ArcGIS GUI is useful for exploring model results. The graph can be 
exported as a picture in 10 file formats, including GIF, PDF, JPEG and postscript. The data in the graph can 
also be exported in four data formats including as a text file and as an Excel workbook. 

To export the data from the graph to an Excel workbook, right-click in the graph and choose ‘Export…’ from 
the menu.  This opens the ‘Export Dialog’ panel. There are three tabs at the top: ‘Picture’, ‘Native’ and ‘Data’. 
Choose the ‘Data’ tab an you will see four options in the ‘Format’ section: Text, XML, HTML and Excel. Choose 
Excel by clicking to the left of it. Click ‘Save…’ and navigate to a folder and create an Excel workbook with 
the data from the graph.  

When you are done, close the graph by clicking the ‘X’ in the upper right corner of the graph window. 

 

Statistical Analysis 
The Statistical Analysis tool can be used to calculate summary statistics for a specified time interval. We will 
demonstrate this tool by graphing precipitation at each element for water year 2001. 

Select the ‘Analysis’ menu and then ‘Statistical Analysis’. This will open the ‘Time Series Data Statistical 
Analysis Tool’ panel. 

 

Follow these steps to create a new shapefile of elemental precipitation for water year 2001. You can also click 
on the button labeled ‘Show Help >>’ at the lower right to display a help panel to the right. 

1. In the top field labeled ‘C2VSim Geodatabase’, click on the folder icon to the right of the field and 
navigate to the C2VSim_CG_1972IC_R369.gdb geodatabase. Double-click on the geodatabase. 

2. Use the drop-down menu in the second field ‘Feature Class’ to select ‘Elements’. 
3. Use the drop-down menu in the field ‘Data Type’ to select ‘Precipitation’ (the only item available for 

elements) 
4. The ‘Budget Type (optional)’ field is grayed out for this item 
5. In the field ‘Statistics Layer Name’, type ‘Precipitation_WY2001’  
6. Do not check the box next to ‘Yearly Statistics’ 
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7. In the ‘Begining Date’ field type ‘10/01/2000’ (the first day of water year 2001) 
8. In the ‘End Date’ field type ‘09/30/2001’ (the last day of water year 2001) 
9. In the bottom field ‘Statistics Type’, select Sum. 
10. Click on the ‘OK’ button at the bottom of the panel. 
11. When the tool finishes, close the panel. 

 

The tool creates a new feature class with precipitation for water year 2001 for each element, and loads it into 
ArcMap.  

Exporting to a Shapefile 
We can export the new feature class to a shapefile, for example to use the information in another ArcMap 
project or send it to someone. In the ‘Table of Contents’ panel, right-click on the feature class name, and 
select ‘Data’ then ‘Export Data…’ 
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This opens the ‘Saving Data’ panel. Navigate to the folder where you want to save the data. Replace the 
default file name ‘Export_Output.shp’ with a descriptive file name such as ‘Precipitation_WY2001.shp’, 
and use the drop-down menu next to ‘Save as type:’ to select ‘Shapefile’. Click the ‘Save’ button to close the 
‘Saving Data’ panel and open the ‘Export Data’ panel. Click ‘OK’ to export the precipitation rates to a new 
shapefile. An alert window will open asking if you want to add the exported data to the current map; click 
‘No’. 

 

Groundwater Head Maps 
The C2VSim ArcGIS GUI also contains a tool that creates maps of the simulated groundwater head for one 
model layer for the months of March or October of each year. This tool can also be used to create a ‘Raster 
Catalogue’ containing many maps from a time series. You can also export the maps.  

Before we use this tool, we will use ArcCatalog to create a separate geodatabase to hold the rasters. Open the 
ArcCatalog program and navigate to the directory hoding the C2VSim geodatabase. In the ‘Catalog Tree’ 
panel, right-click on the folder holding the C2VSim geodatabase, and select ‘New’, then ‘File geodatabase’. 
This will vreate a file geodatabase called New File Geodatabase.gdb. Rename this with an appropriate 
descriptive name, such as C2VSim_CG_1972IC_GW_Rasters.gdb. 

Switch to ArcMap and the C2VSim ArcGIS GUI. Select the ‘Analysis’ menu and then ‘GW Head 
Raster/Contour’. This will open the ‘Create GWL Raster/Contour Tool’ panel. 

 

Follow these steps to create a raster of confined heads for October 2008.  

1. In the top field labeled ‘C2VSim Geodatabase’, click on the folder icon to the right of the field and 
navigate to the C2VSim_CG_1972IC_R369.gdb geodatabase. Double-click on the geodatabase. 

2. Use the drop-down menu in the second field ‘Output Raster Geodatabase’ to select the geodatabase 
for the output, C2VSim_CG_1972IC_GW_Rasters.gdb.  

3. Use the drop-down menu in the field ‘Layer’ to select the model layer. ‘1’ is the water table, ‘2’ is the 
upper confined zone, and ‘3’ is the lower confined zone. We will use ‘2’. 

4. Put an integer month value in the field ‘Initial Month’. We will use ‘10’ for October. 
5. Put an integer year value in the field ‘Initial Year’. We will use ‘2008’.  
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6. Next, we have to choose which type of map to produce. We can click on ‘Create Contour’ or ‘Multiple 
Raster’. For this example, click on ‘Create Contour’, and a section will open below the heading 
‘Create Contour’. 

7. Place a check in the box next to ‘Create Contour (optional)’ 
8. Leave the ‘Contour Interval (optional) field empty. 
9. Click on the ‘OK’ button at the bottom of the panel. 
10. When the tool finishes, close the panel. 

 

 

For this example, the tool creates two feature classes displaying the simulated heads in model layer 2 for 
October 2008. It creates a line shapefile called ‘Con_200810L2’ with labeled contours at 100-foot intervals, 
and a raster called ‘L2_200810’ with the range from lowest to highest heads divided into 15 contour intervals. 
(The raster ‘L2_200810’ is added to the Table of Contents below the Subregions feature class, so you will need 
to uncheck Subregions to see the raster.) 

Exporting Data  
The contours shapefile or the raster feature class can be exported for use in other programs by right-clicking 
on the item in the Table of Contents, and choosing ‘Data’ then ‘Export data’.  

 

If you quit ArcMap, do not save the project file. 
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Animating C2VSim Results with TecPlot  

This section describes how to view C2VSim results using the TecPlot program. 

Copy the files CVGWheadTecPlot.lay and CVSubsidenceTecPlot.lay from Tools.zip to the Results 
folder of the C2VSim 3.02-CG Water Years 1973-2009 folder.  These files contain layout information used by 
TecPlot to draw a map, including where to place titles, how to format the legend, and the name of the input 
data file to be read. The file CVGWheadTecPlot.lay reads information from the C2VSim output file 
CVGWheadTecPlot.out, and the file CVSubsidenceTecPlot.lay reads information from the 
CVSubsidTecPlot.out file. 

Double-click on the CVGWheadTecPlot.lay file. This should open the TecPlot program and display a color 
map of the initial water table altitude. It may take a few moments to load the file. The initial condition is for 
midnight 9/30/1972 (which is equivalent to the start of 10/1/1972.) The legend has the name of the output file 
data set ‘GWHEAD1’, which corresponds to the groundwater head of model layer 1. 

 

To create a movie of the change in groundwater head through time, select the ‘Animate’ menu and then 
‘Zones…’. This opens the ‘Animate Zones’ dialog box. 
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Click on the ‘Animate’ button at the lower left and the animation will run. It may be slow because the 
program re-draws the map for each time step.  

Use the drop-down menu next to the word ‘Animate’ to select ‘to WMV file’. Click on the ‘Animate’ button in 
the lower left to open the ‘Export’ panel. Click ‘OK’ and navigate to the place you want to save the movie file, 
name the file, and click ‘Save’. TecPlot may take some time to generate the movie. When TecPlot is finished 
creating the movie file, close the ‘Animate Zones’ panel. Open the folder where you stored the movie file. 
Double-click on the file to open Windows Media Player and run the movie. 

Close TecPlot. 
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Scenar io 1 − GWP: Adding Three Groundwater  Pumping Wells 

Description:  This is a fictional case study. Three wells will be added to the C2VSim model at various distances 
from modeled rivers, and we will investigate the impacts of these wells on groundwater levels, river flows and 
water movement in the root zone. Each well will pump 2,000 AF/mo for three months, June-August, for 
agricultural use. This example will show how to modify the Well Specification File, Pumping Specification File 
and Pumping Data File to add new wells, and how to analyze simulation results. 

 

Initial Steps 

The first steps are to set up the project folders, and identify the coordinates of the new pumping wells and 
nearby river nodes. 

Set  up the project  fo lders 

Start by creating folders for the groundwater pumping scenario and the unmodified base case.  

1) Create a folder in a convenient place (such as the top directory of the D: drive) called 
GWP_Case_Study. This folder will hold subfolders with two versions of the model – one for the case 
study and one for the unmodified base case. 

2) Copy the folder C2VSim_CG_1972IC_R369 into the folder GWP_Case_Study and rename it 
GWP_Case. The C2VSim files in this folder will be modified to represent the scenario. 

3) Copy the folder C2VSim_CG_1972IC_R369 into the folder GWP_Case_Study again, and rename it 
Base_Case. Only the C2VSim ‘CVprint.dat’ file in this folder will be modified. 
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Find the  well locat ions using  ArcMap 

Next, we will use the feature classes in a C2VSim geodatabase to locate the three wells, determine what 
model subregion and element they are in, and what river reach they are closest to. For this exercise, we 
arbitrarily selected the three locations in this table: 

Well Latitude Longitude 
A 38.86 -121.72 
B 39.15 -121.45 
C 39.47 -122.20 

 

Double-click on the ArcMap project file C2VSim_CG_1972IC_R369.mxd to open it, if it is not already open. 
Right-click on ‘Subregion’ in the ‘Table of Contents’ pane and select ‘Zoom to Layer’ to center the C2VSim 
model on the screen.  

When using ArcMap, the coordinates of the pointer appear in the lower right-hand corner. 

 

Use the ‘Zoom In’, ‘Pan’ and ‘Select Features by Rectangle’ tools to locate the three wells. Record the model 
element and subregion of each well in the table below. Find the river node closest to each well and record the 
river node number and river reach number. You can use the river reach number and Table 5 in the C2VSim 
User Manual to determine the name of the river. 

Note: The Glenn-Colusa Canal appears as a modeled river reach in the ArcMap view near Well C. The Glenn-
Colusa Canal is specified in the C2VSim model, but is turned off in the model. No water flows into or out of 
this river reach and the bottom conductance is set to zero. Ignore the Glenn-Colusa Canal and select a river 
node on the Sacramento River to the east of Well C. 

Well Latitude Longitude Element Subregion River Node River reach 
A 38.86 -121.72 

    B 39.15 -121.45 
    C 39.47 -122.20 
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The figure above shows the ArcMap window with a green dot at the location of Well A. The cursor does not 
appear in the screen-shot, but is positioned over the green dot labeled ‘A’. The latitude and longitude of the 
cursor (and Well A) are in the lower right. Note the subregion number in red, the element boundary and 
element number in light gray, the river node and river node number in dark blue, and the river reach and river 
reach number in lighter blue.  

 

When you are finished, your table should be similar to this: 

Well Latitude Longitude Element Subregion River Node River reach 
A 38.86 -121.72 315 4 300 53 (Sacramento River) 
B 39.15 -121.45 232 5 284 60 (Yuba River) 
C 39.47 -122.20 184 3 202 51 (Sacramento River) 

 

Find the  well coordinates in UTM zone 10 

We need to enter the well coordinates into the C2VSim model using the UTM zone 10N coordinate system. 
However, the feature classes in this map document are not projected; that is, they are described in decimal 
degrees of latitude and longitude. We need to convert the latitude-longitude coordinates to UTM zone 10N 
northing and easting coordinates.  
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The file Tools.zip contains an Excel workbook utmconversions.xls, developed by Steve Dutch at the 
University of Wisconsin at Green Bay. This workbook is also available at 
http://www.uwgb.edu/dutchs/usefuldata/utmconversions1.xls. With this workbook, we can convert the well 
coordinates to the format required by the C2VSim model.  

Open the utmconversions.xls workbook and choose the tab ‘Main Page’. The top section, in red and pink, 
will convert latitude and longitude to UTM coordinates. The middle section, in yellow, will convert UTM 
coordinates to latitude and longitude. 

Use this workbook to determine the UTM 10N coordinates of each well. 

Well Latitude Longitude Easting Northing 
A 38.86 -121.72 

  B 39.15 -121.45 
  C 34.47 -122.20 
   

 

Modify C2VSim for the Case Study 

This section shows how to change the C2VSim input files to model the case study. First, the Preprocessor files 
will be modified and the Preprocessor program will be run. Next, the Simulation files will be modified and the 
Simulation program will be run. Finally, groundwater and surface water hydrographs and Budget output tables 
will be imported to Excel workbooks and analyzed. 

Modify  the C2VSim  Preprocessor  Files 

We need to add the three new pumping wells identified above to the Preprocessor Well Data File. Make the 
following modifications to the files in the folder GWP_Case_Study\GWP_Case\Preprocessor: 

Modify the main Preprocessor Control File 
1) Rename file Preprocessor Control File CVpreproc.in to CVpreproc_GWP.in 
2) Open file CVpreproc_GWP.in in TextPad 

a) Add a comment line describing the project 
b) Change the title line to describe the project 

Leave this file open in TextPad while we work on the Preprocessor Well Data File.  

http://www.uwgb.edu/dutchs/usefuldata/utmconversions1.xls�
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Add the new pumping wells to the Preprocessor Well Data File 
We need to add the three wells to the Preprocessor Well Data File. We will use the Easting value calculated 
above as the X value and the Northing value as the Y value. PERFTOP and PERFBOT are the altitude in feet 
of the top and bottom of the screened interval. When you add real wells to the model, you will use well logs 
to determine the screen interval. For this exercise we are using fictitious wells, so the screen intervals were 
arbitrarily chosen. The well radius has no significant impact on the simulation results for this model because 
the element width is much larger than the well radius, so RWELL is set to 1.  

1) Rename the Well Data File CVWells.dat to CVWells_GWP.dat 
2) Open CVWells_GWP.dat in TextPad 

a) Add a comment line describing the project 
b) Increase the value of NWELL by 3 from 133 to 136 
c) Add three lines at the bottom of the file with the well descriptions: 

WellID X Y RWELL PERFTOP PERFBOT Comment 
134 610971 4302018 1 -50 -100 / GWP Well A 
135 629711 4333940 1 -200 -250 / GWP Well C 
136 568982 4369575 1 -100 -200 / GWP Well C 

 
3) Save and close the file  
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Make changes to file CVpreproc_GWP.in 
Once the Well Data File has been changed, the file names in the Preprocessor Control File have to be changed. 

1) Change file name CVWells.dat to CVWells_GWP.dat 
2) Change file name Cvpreout.bin to CVpreout_GWP.bin 
3) Change file name Cvpreproc.in to CVpreproc_GWP.in 
4) Save and close the file  

 

 

Modify the Preprocessor Batch File 
The command to run the Preprocessor program is “PreProcessor3_02.exe CVpreproc_GWP.in”. We generally 
recommend using a batch file to run the IWFM programs. A batch file is provided, but we have to change the 
name of the Preprocessor Control File before we can use it. 

1) Open the file Run_Preprocessor.bat in TextPad 
2) Change the Preprocessor Control File name in Run_Preprocessor.bat to CVpreproc_GWP.in 
3) Save and close the file  
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Run the  C2VSim Preprocessor  Program  

Now we can run the Preprocessor: 

• Double-click on the file Run_Preprocessor.bat 

The Preprocessor program should run to completion in a few seconds. It creates two files, 
PreprocessorMessages.out and CVpreout_GWP.bin.  

Review the Preprocessor results 
Open the file PreprocessorMessages.out in TextPad and review it. The three new wells appear in the last 
two tables, the ‘Well Inventory’ and the list of ‘Adjustment Coefficients for Partial Well Penetration’.  

The ‘Well Inventory’ table repeats the X and Y coordinates from the Well Data File. It is generally good 
practice to review this information to assure it is correct. This table also lists the element and subregion each 
well is in. Compare these to the element and subregion we determined using ArcMap. The numbers to the 
right in parentheses indicate how the pumping volume will be apportioned between the nodes of each 
element. 

The ‘Adjustment Coefficients for Partial Well Penetration’ table lists the element each well is in and how the 
pumping volume will be apportioned to model layers. These numbers generally do not add up to 1.0, and can 
be adjusted by changing the well perforation interval.  
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Trouble-shooting the Preprocessor program 
If the Preprocessor program does not run to completion, there is probably a typo in one of the modified input 
files. First, see if the program prints out an error message that points to the error. For example, (a) the file 
name in CVpreproc_GWP.in may not be the same as the actual file name, (b) there may be an extra blank 
line in one of the modified files, or (c) there may be missing or extra characters in one of the modified files. 
Check your work and see if you can find and fix the error.  

If you can’t find the reason the program fails, you can use the ‘Compare files’ tool in TextPad to compare each 
of your modified files to the files in the folder GWP_Example_Complete\GWP_Case\Preprocessor. Once you 
find and fix the error, the Preprocessor program will run to completion. 

 

Modify  the C2VSim  S imulat ion Files 

Next, we will change the Simulation program input files to incorporate the new pumps. This will involve 
changing the Simulation Control File, Pumping Specification File, Pumping Data File and Print Specification 
File. 

Make the following modifications to the files in the folder GWP_Case_Study\GWP_Case\Simulation: 

Modify the Simulation Control File 
1) Rename the Simulation Control File CVsim.in to CVsim_GWP.in 
2) Open the file CVsim_GWP.in with TextPad 

a) Add a comment line describing the project 
b) Change the title line to describe the project 
c) Change the name of the Preprocessor output file to CVpreout_GWP.bin, the file created above 

with the Preprocessor. 
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Modify the Pumping Specification File 
Three new wells were added in the Preprocessor Well Data File. We use the Pumping Specification File to say 
how these wells will be used.  

1) Rename the Pumping Specification File CVPuSp.dat to CVPuSp_GWP.dat 
2) Open CVPuSp_GWP.dat with TextPad 

a) Add a comment line describing the project 
b) Add the new pumps to the Pumping Specification File 

The top section of the Pumping Specification File holds information on the wells specified in the 
Preprocessor Well Data File. This includes which column of the Pumping Data File holds the 
pumping volumes for each well, and which land use type and subregion the water is supplied to. 
We will add one row for the new well.  

i. The first item in each row is the well ID number from the Preprocessor Well Data File. 
ii. The second item is the column of the Pumping Data File associated with each well. We will 

place the pumping rates for the three new pumps in three new data columns in the Pumping 
Data File. The original Pumping Data File has 42 columns of data, so we will use columns 43, 
44, and 45 for the new pumps. The ICOLWL values are 43, 44 and 45 for the three wells, 
respectively. 

iii. The third item specifies the land use type the water is delivered to. This is specified by listing 
the appropriate column of the Irrigation Fraction data file. In the Irrigation Fraction Data File 
CVIrFr.dat, column 22 is to deliver 100% to urban use, and column 23 is to deliver 100% to 
agricultural use. The water from the three new pumps will all go to agricultural use, so the 
ICFIRIWGL value is 23 for all three wells.  

iv. The fourth item specifies the percentage of the pumping value to be extracted from this well. 
We will specify a data column for each well, so FRACWL is 1 (or 100%) for each of the three 
wells. 

v. The fifth item specifies the subregion the water will be delivered to. The water from each of 
these wells will be used within the subregion the well is in, so we can set IRGWL to ‘-1’. 

vi. The last three items specify whether the pumping rates from the three wells will be 
automatically adjusted at run-time. We do not want to adjust the pumping rates from these 
wells, so we set ICADJWL to zero for all three wells. We also have to specify values for the 
last two items (which will be ignored by the program if ICADJWL is zero). We will copy values 
from the second and fourth columns. We set the data column containing the maximum 
pumping rate (ICWLMAX) to the data column containing the specified pumping rate 
(ICOLWL) and the fraction (FWLMAX) to the specified pumping fraction (FWLMAX). 

3) Save and close the file CVPuSp_GWP.dat 
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The final values to be entered in the file CVPuSp_GWP.dat are: 

ID ICOLWL ICFIRIWGL FRACWL IRGWL ICADJWL ICWLMAX FWLMAX 
134 43 23 1 -1 0 43 1 
135 44 23 1 -1 0 44 1 
136 45 23 1 -1 0 45 1 

 

And the file will look like this: 

 
 

 

Modify the Pumping Data File 
We need to modify the Pumping Data File by adding one data column for each of the three new pumps. 

We will add the new pumping rates to the Pumping Data File in three steps. First, we will copy the pumping 
values from the Pumping Data File to Excel. The pumping data is tab-delimited, and will be automatically 
parsed to columns in the worksheet. Next, we will add three new data columns corresponding to the three 
new wells. Finally, we will copy the modified pumping rates from Excel and paste them into the Pumping Data 
File, replacing the old data. The data from Excel is pasted as tab-delimited text. 

1) Rename the Pumping Data File CVpump.dat to CVpump_GWP.dat 
2) Open the file CVpump_GWP.dat with TextPad 

a) Add a comment line describing the project 
b) Change the value of NCOLPUMP by 3 from 42 to 45 

3) Place your cursor in the left-most position of the row with ‘C Column’ (near row 102). 
4) Select everything from here to the end of the file (You can hold down the <Shift> and <Ctrl> keys 

together and press the <End> key) 
5) Cut this text <Ctrl-X> 
6) Open a new Excel workbook 
7) In Excel: 

a) Put the cursor in cell A1 of the first worksheet ‘Sheet1’ and paste the pumping data <Ctrl-V> 
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b) Put the cursor in cell B4 and freeze panes with date and header showing 
c) Locate worksheet columns AR-AT (data columns 43-45) and color yellow 
d) Add scenario pumping rates for water year 1922 in cells AR4 through AR15. We use negative 

rates to represent groundwater withdrawals from the aquifer. 
i. Type ‘0’ in the rows for October-May (AR4-AR11) 
ii. Type ‘-2’ in the rows for June-August (AR12-AR14) 
iii. Type ‘0’ in the row for September (AR15) 

e) Copy cells AR4-AR15 to AS4-AS15 and AT4-AT15 so these values are applied to all three wells 
f) Place the cursor in cell AR16 and type the formula ‘=AR4’ then hit <Return> 
g) Copy this cell to all cells in the block between AR16 and AT1059. This will copy the pumping 

rates for each month of water year 1922 to the same month of each water year from 1923 to 
2009. 

h) Copy everything from Excel by placing the cursor in cell A1, then holding down both the 
<Shift>and <Ctrl> keys as you press <Down arrow> and then <Right arrow> to select all of the 
data, then <Ctrl-C> 

i) Switch to CVpump_GWP.dat in TextPad. Your cursor should still be at line 102. 
j) Paste all of the pumping data with <Ctrl-V> 

8) Save and close the file CVpump_GWP.dat 

 

Modify the Print Specification File 
The Print Specification File lists the locations of the hydrographs that are printed when the model runs. We will 
add three groundwater hydrographs and three surface water hydrographs to this file. 

1) Rename the Print Specification File from CVprint.dat to CVprint_GWP.dat 
2) Open CVprint_GWP.dat with TextPad 
3) Add a comment line describing the project 
4) Add three new groundwater hydrographs at the same locations as the three new pumping wells 

a) Increase the value of NOUTH by 3 from 1387 to 1390 
b) Add the locations of the three new pumping wells, one row each. The first item in each row is 

IOUTHL, the model layer for the hydrograph, the second item is the X coordinate and the third 
item is the Y coordinate. We will use the X and Y coordinate from CVWells_GWP.dat.(You can 
optionally add an ID and the element number as comments.)  
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5) Add three new surface water hydrographs at river nodes 300, 284 and 202, which we determined 
(above) are the closest to the three new wells. 
a) Increase the value of NOUTR by 3 from 34 to 37 
b) Add the locations of the three new hydrographs, one row each. The only required item is the river 

node number IOUTHR. You can optionally add a ID and a comment.  
6) Save and close the file CVprint_GWP.dat 

 

 

 

Make changes to file CVsim_GWP.in 
Change the input file names in the Simulation Control File CVsim_GWP.in to match the modified file names 
above. 

1) Change the name of the Pumping Specification File from CVPuSp.dat to CVPuSp_GWP.dat 
2) Change the name of the Pumping Data File from CVpump.dat to CVpump_GWP.dat 
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3) Change the name of the Print Specification File from CVprint.dat to CVprint_GWP.dat 

Modify the surface water and groundwater hydrograph file names in the Simulation Control File 
CVsim_GWP.in by adding ‘_GWP’ to the root name.  

4) Change CVSWhyd.out  to CVSWhyd_GWP.out  
5) Change CVGWhyd.out  to CVGWhyd_GWP.out 

In the example below, the comment ‘/** GWP’ has been added to the right of the modified file names in the 
Simulation Control File. 

 

Turn the pumping adjustment off. 

6) Near the end of the Simulation Control File, set the value of KOPTDV to ‘00’ 
7) Save and close the file. 
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Modify the Simulation Batch File 
The command to run the Simulation program is “Simulation3_02.exe CVSim_GWP.in”. We have to change the 
name of the Simulation Control File in the batch file before we can use the batch file. 

1) Open the file Run_Sim.bat in TextPad 
2) Change the Simulation Control File name in Run_Sim.bat to CVSim_GWP.in 
3) Save and close the file  

 

 

Run the  S im ulat ion Program for  the Scenar io  

Now we can run the Simulation program: 

1) Double-click on the file Run_Sim.bat 

The Simulation program should run to completion in a few minutes. It creates two files in the Simulation 
folder, SimulationMessages.out and CVfinallist.out. It also creates a number of files in the Results 
folder, including several files with the .bin extension and several files with the .out extension. The .bin files 
are read by two post-processors, the Budget and Z-Budget programs. The .out files are text files that can be 
opened with TextPad. 

Open the file SimulationMessages.out in TextPad and review it. The first section has the title section from 
the CVSim_GWP.in file, followed by a list of the files that were used in the simulation. This is followed by a 
line stating what components were adjusted in this simulation (surface water diversions and groundwater 
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pumping); nothing should be adjusted in this simulation. The remainder of the file lists the solver convergence 
iterations for each time step. The last entry states the model run time. 

Trouble-shooting the Simulation program 
If the Simulation program does not run to completion, there is probably a typo in one of the modified input 
files. First, see if the program prints out an error message that points to the error. For example,  

1) the file name in CVSim_GWP.in may not be the same as the actual file name,  
2) there may be an extra blank line in one of the modified files, or  
3) there may be missing or extra characters in one of the modified files.  

Check your work and see if you can find and fix the error.  

If you can’t find the reason the program won’t run, you can use the ‘Compare files’ tool in TextPad to compare 
each of your modified files to the corresponding files in the folder 
GWP_Example_Complete\GWP_Case\Simulation. Once you find and fix the error, the Simulation program will 
run to completion. 

 

Run the  Budget  Program  

Switch to the GWP_Case_Study\GWP_Case\Budget folder.  

Open the Budget Control File CVBudget.in file with TextPad. There is a list of binary files with the .bin 
extension starting near line 70. The Budget program reads each of these binary files, and produces a text file 
with the same root name and the .BUD  extension. For example, the Budget program reads the 
..\Results\CVlandwater.bin file and produces the ..\Results\CVlandwater.BUD file. 

 

 1)  Double-click on the file Run_Budget.bat 

The Budget program should run to completion in less than a minute.  

Switch to the GWP_Case_Study\GWP_Case\Results folder. You should see eight files with the .BUD extension.  
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Create Budget  Workbooks w ith Excel 

Open Excel 2007 or Excel 2012 to a new, blank worksheet. On the “IWFMTools” menu, use the drop-down 
menu next to “IWFM Version” to select ‘3.02’. 

 

A window with the label ‘Budget to Excel (3.02)’ will open. Use the ‘Browse’ button to go to the 
GWP_Case_Study\GWP_Case\Budget directory and select the CVBudget.in file. The available budget files 
will be listed under ‘Choose Budget Table’ in the same order they are listed in the CVBudget.in file.  

 

 

Land and Water Use Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the lower pane of the ‘Budget to Excel (3.02)’ window, select ‘Land and water use budget’, near the bottom 
of the list, and then click the ‘Transfer to Excel’ button. This will add 22 worksheets to the workbook, one for 
each of the 21 model subregions, and one (labeled ‘Subregion 22’) for the entire model area. 

Save the workbook to the GWP_Case_Study directory as GWP_Land_and_Water_Budget.xlsx.  

 

Root Zone Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the ‘Budget to Excel (3.02)’ window, select ‘Root zone budget’ and then click the ‘Transfer to Excel’ button. 
This will add 22 worksheets to the workbook, one for each of the 21 model subregions, and one (labeled 
‘Subregion 22’) for the entire model area. 
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Save the workbook to the GWP_Case_Study directory as GWP_Root_Zone_Budget.xlsx.  

 

Stream Reach Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the ‘Budget to Excel (3.02)’ window, select ‘Stream reach budget’, near the bottom of the list, and then 
click the ‘Transfer to Excel’ button. This will add 75 worksheets to the workbook, one for each of the 75 
C2VSim river reaches. 

Save the workbook to the GWP_Case_Study directory as GWP_Stream_Reach_Budget.xlsx.  

 

Groundwater Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the ‘Budget to Excel (3.02)’ window, select ‘Groundwater budget’ and then click the ‘Transfer to Excel’ 
button. This will add 22 worksheets to the workbook, one for each of the 21 model subregions, and one 
(labeled ‘Subregion 22’) for the entire model area. 

Save the workbook to the GWP_Case_Study directory as GWP_Groundwater_Budget.xlsx.  

 

Modify the Base Case files 

The easiest way to see the results of the changes in the case study is to compare the scenario results to the 
unchanged base case. We can replace the Print Specification File CVprint.dat in the base case with our 
modified Print Specification File CVprint_GWP.dat. When the Simulation program is run with this Print 
Specification File, groundwater and surface water hydrographs will be created for the new locations specified 
in this file.  Make the following modifications to the files in the folder 
GWP_Case_Study\Base_Case\Simulation. 

Modify  the C2VSim  S imulat ion Files 

We can replace the Print Specification File CVprint.dat in the base case with our modified Print Specification 
File CVprint_GWP.dat. When the Simulation program is run with this Print Specification File, groundwater 
and surface water hydrographs will be created for the new locations specified in this file.  Make the following 
modifications to the files in the folder GWP_Case_Study\Base_Case\Simulation. 

Copy the Print Specification File CVprint_GWP.dat 
Copy the modified Print Specification File CVprint_GWP.dat in the folder 
GWP_Case_Study\GWP_Case\Simulation and paste it into the folder GWP_Case_Study\Base_Case\Simulation.  
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Make changes to the Simulation Control File 
Make the following changes to the Simulation Control File in the folder 
GWP_Case_Study\Base_Case\Simulation: 

1) Rename the Simulation Control File CVsim.in to CVsim_base.in  
2) Open CVsim_base.in with TextPad 
3) Change the Print Specification File name to CVprint_GWP.dat 

 

 

Turn the pumping adjustment off. 

4) Near the end of the Simulation Control File, set the value of KOPTDV to ‘00’ 
5) Save and close the file CVsim_base.in. 
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Modify the Simulation Batch File 
The command to run the Simulation program is “Simulation3_02.exe CVSim_GWP.in”. We have to change the 
name of the Simulation Control File in the batch file before we can use the batch file. 

1) Open the file Run_Sim.bat with TextPad 
2) Change the Simulation Control File name in Run_Sim.bat to CVSim_base.in 
3) Save and close the file  

 

 

Run the  S im ulat ion Program for  the Base  Case  

Now we can run the Simulation program: 

1) Double-click on the file Run_Sim.bat 

The Simulation program should run to completion in a few minutes.  

 

Create Budget  Workbooks w ith Excel 

Open Excel 2007 or Excel 2012 to a new, blank worksheet. On the “IWFMTools” menu, use the drop-down 
menu next to “IWFM Version” to select ‘3.02’. 
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A window with the label ‘Budget to Excel (3.02)’ will open. Use the ‘Browse’ button to go to the 
GWP_Case_Study\Base_Case\Budget directory and select the CVBudget.in file. The available budget files 
will be listed under ‘Choose Budget Table’ in the same order they are listed in the CVBudget.in file.  

 

 

Land and Water Use Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the ‘Budget to Excel (3.02)’ window, select ‘Land and water use budget’, near the bottom of the list, and 
then click the ‘Transfer to Excel’ button. This will add 22 worksheets to the workbook, one for each of the 21 
model subregions, and one (labeled ‘Subregion 22’) for the entire model area. 

Save the workbook to the GWP_Case_Study directory as Base_Land_and_Water_Budget.xlsx.  

 

Root Zone Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the ‘Budget to Excel (3.02)’ window, select ‘Root zone budget’ and then click the ‘Transfer to Excel’ button. 
This will add 22 worksheets to the workbook, one for each of the 21 model subregions, and one (labeled 
‘Subregion 22’) for the entire model area. 

Save the workbook to the GWP_Case_Study directory as Base_Root_Zone_Budget.xlsx.  

 

Stream Reach Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the ‘Budget to Excel (3.02)’ window, select ‘Stream reach budget’, near the bottom of the list, and then 
click the ‘Transfer to Excel’ button. This will add 75 worksheets to the workbook, one for each of the 75 
C2VSim river reaches. 

Save the workbook to the GWP_Case_Study directory as Base_Stream_Reach_Budget.xlsx.  
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Groundwater Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the ‘Budget to Excel (3.02)’ window, select ‘Groundwater budget’ and then click the ‘Transfer to Excel’ 
button. This will add 22 worksheets to the workbook, one for each of the 21 model subregions, and one 
(labeled ‘Subregion 22’) for the entire model area. 

Save the workbook to the GWP_Case_Study directory as Base_Groundwater_Budget.xlsx.  

 

Review and Interpret Results 

This section shows how to import hydrograph files to Excel workbooks, and how to compare hydrographs 
between the GWP Case and the Base Case to see the impacts of the three new groundwater pumping wells.  

Create Hydrograph Workbooks w ith Excel 

First, we’ll bring the GWP Case groundwater and surface water hydrograph output into Excel. Then we’ll bring 
in the Base Case hydrographs. Next, we will create new hydrographs of the differences between the GWP 
Case and Base Case hydrographs. In the final step, we will graph these results. 

Start by creating the Excel workbook that will hold all of the results. Open a new Excel workbook, and save it 
in the directory GWP_Case_Study as GWP_Results.xlsx.  

 

GWP Case Groundwater Hydrographs 
First, we will import the groundwater hydrographs of the GWP Case to an Excel worksheet.  

1) Go to the GWP_Case_Study\GWP_Case\Results folder, and open the file CVGWhyd_GWP.out with 
TextPad.  

2) Select all <Ctrl-A> and copy <Ctrl-C> 
3) Switch to the Excel workbook 
4) Put the cursor in cell A1 of tab ‘Sheet1’ and paste <Ctrl-V> 
5) Next, we use ‘Text to Columns’ to put each hydrograph in a separate column 

a) Move the cursor to cell A5 and select all cells in the range A5-A451 by holding the <Ctrl> and 
<Shift> keys and pressing <Down arrow> 

b) With these cells highlighted, go to the ‘Data’ menu and select ‘Text to Columns’. This opens a 
window labeled ‘Convert Text to Columns Wizard – Step 1 of 3’ 

c) Select the radio button next to ‘Fixed Width’, click ‘Next’ and then click ‘Finish’. Now, dates are in 
column A and each groundwater hydrograph is in a separate column. 

6) Next, we can use ‘Find and Replace’ to convert the IWFM time-date code to something Excel can 
recognize.  
a) Use <Ctrl-H> to open the ‘Find and Replace’ panel.  
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b) Next to ‘Find what’, enter ‘_24:00’. 
c) Leave the ‘Replace with’ field blank. 
d) Click ‘Replace All’.  
e) Excel should open an alert showing the number of replacements, and column A should contain 

dates. Close the alert and the ‘Find and Replace’ panel. 
7) Rename the worksheet by double-clicking the tab label ‘Sheet1’ and replacing it with 

‘GWhyd_GWP_Case’ 
8) Put the cursor in cell B8 and go to the ‘View’ menu, select ‘Freeze Panes’, and choose the top item on 

the drop-down menu ‘Freeze Panes’.  
9) Scroll to the right to columns BAK through BAM to see the three new groundwater hydrographs we 

added in the Print Specification File. 
10) Save the Excel workbook. 

 

 

GWP Case Surface Water Hydrographs  
Next, we will create an Excel worksheet with the surface water hydrographs of the GWP case.  

1) Go to the GWP_Case_Study\GWP_Case\Results folder, and open the file CVSWhyd_GWP.out with 
TextPad.  

2) Select all <Ctrl-A> and copy <Ctrl-C> 
3) Switch to the Excel workbook 
4) Put the cursor in cell A1 of tab ‘Sheet2’ and paste <Ctrl-V> (If there is no blank worksheet, crate one 

by clicking in the small area to the right of the worksheet tabs that shows this symbol: ) 
5) Use ‘Text to Columns’ to put each hydrograph in a separate column 

a) Move the cursor to cell A6 and select all cells in the range A6-A450 by holding the <Ctrl> and 
<Shift> keys and pressing <Down arrow> 
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b) With these cells highlighted, go to the ‘Data’ menu and select ‘Text to Columns’. This opens a 
window labeled ‘Convert Text to Columns Wizard – Step 1 of 3’ 

c) Select the radio button next to ‘Fixed Width’, click ‘Next’ and then click ‘Finish’. Now, dates are in 
column A and each surface water hydrograph is in a separate column. 

6) Next, we can use ‘Find and Replace’ to convert the IWFM time-date code to something Excel can 
recognize.  
a) Use <Ctrl-H> to open the ‘Find and Replace’ panel.  
b) The ‘Find what’ box should still contain ‘_24:00’. If not, enter ‘_24:00’ in the box. 
c) Leave the ‘Replace with’ field blank. 
d) Click ‘Replace All’.  
e) Excel should open an alert showing the number of replacements, and column A should contain 

dates. Close the alert and the ‘Find and Replace’ panel. 
9) Rename the worksheet by double-clicking the tab label ‘Sheet2’ and replacing it with 

‘SWhyd_GWP_Case’ 
10) Put the cursor in cell B7 and go to the ‘View’ menu, select ‘Freeze Panes’, and choose the top item on 

the drop-down menu ‘Freeze Panes’.  
11) Scroll to the right to columns AJ through AL to see the three new surface water hydrographs we 

added in the Print Specification File. 
12) Save the Excel workbook. 

 

 

Base Case Groundwater Hydrographs 
Now we will add an Excel worksheet with the groundwater hydrographs of the base case.  

1) Go to the GWP_Case_Study\Base_Case\Results folder, and open the file CVGWhyd.out with 
TextPad. 

2) Select all <Ctrl-A> and copy <Ctrl-C> 
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3) Switch to Excel the workbook (and create a new worksheet ‘Sheet3’ if needed) 
4) Put the cursor in cell A1 of tab ‘Sheet3’ and paste <Ctrl-V> 
5) Next, we use ‘Text to Columns’ to put each hydrograph in a separate column 

a) Move the cursor to cell A5 and select all cells in the range A5-A451 by holding the <Ctrl> and 
<Shift> keys and pressing <Down arrow> 

b) With these cells highlighted, go to the ‘Data’ menu and select ‘Text to Columns’. This opens a 
window labeled ‘Convert Text to Columns Wizard – Step 1 of 3’ 

c) Select the radio button next to ‘Fixed Width’, click ‘Next’ and then click ‘Finish’. Now, dates are in 
column A and each groundwater hydrograph is in a separate column. 

6) Next, we can use ‘Find and Replace’ to convert the IWFM time-date code to something Excel can 
recognize.  
a) Use <Ctrl-H> to open the ‘Find and Replace’ panel.  
b) The ‘Find what’ box should still contain ‘_24:00’. If not, enter ‘_24:00’ in the box. 
c) Leave the ‘Replace with’ field blank. 
d) Click ‘Replace All’.  
e) Excel should open an alert showing the number of replacements, and column A should contain 

dates. Close the alert and the ‘Find and Replace’ panel. 
7) Rename the worksheet by double-clicking the tab label ‘Sheet3’ and replacing it with 

‘GWhyd_Base_Case’ 
8) Put the cursor in cell B8 and go to the ‘View’ menu, select ‘Freeze Panes’, and choose the top item on 

the drop-down menu ‘Freeze Panes’.  
9) Scroll to the right to columns BAK through BAM to see the three new groundwater hydrographs we 

added in the Print Specification File. 
10) Save the Excel workbook. 
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Base Case Surface Water Hydrographs  
We can also create an Excel worksheet with the surface water hydrographs of the base case.  

1) Go to the GWP_Case_Study\GWP_Case\Results folder, and open the file CVSWhyd_GWP.out with 
TextPad.  

2) Select all <Ctrl-A> and copy <Ctrl-C> 
3) Switch to the Excel workbook (and create a new worksheet ‘Sheet4’ if needed) 
4) Put the cursor in cell A1 of tab ‘Sheet4’ and paste <Ctrl-V> 
5) Use ‘Text to Columns’ to put each hydrograph in a separate column 

a) Move the cursor to cell A6 and select all cells in the range A6-A450 by holding the <Ctrl> and 
<Shift> keys and pressing <Down arrow> 

b) With these cells highlighted, go to the ‘Data’ menu and select ‘Text to Columns’. This opens a 
window labeled ‘Convert Text to Columns Wizard – Step 1 of 3’ 

c) Select the radio button next to ‘Fixed Width’, click ‘Next’ and then click ‘Finish’. Now, dates are in 
column A and each surface water hydrograph is in a separate column. 

6) Next, we can use ‘Find and Replace’ to convert the IWFM time-date code to something Excel can 
recognize.  
a) Use <Ctrl-H> to open the ‘Find and Replace’ panel.  
b) The ‘Find what’ box should still contain ‘_24:00’. If not, enter ‘_24:00’ in the box. 
c) Leave the ‘Replace with’ field blank. 
d) Click ‘Replace All’.  
e) Excel should open an alert showing the number of replacements, and column A should contain 

dates. Close the alert and the ‘Find and Replace’ panel. 
7) Rename the worksheet by double-clicking the tab label ‘Sheet4’ and replacing it with 

‘SWhyd_Base_Case’ 
8) Put the cursor in cell B7 and go to the ‘View’ menu, select ‘Freeze Panes’, and choose the top item on 

the drop-down menu ‘Freeze Panes’.  
9) Scroll to the right to columns AJ through AL to see the three new surface water hydrographs we 

added in the Print Specification File. 
10) Save the Excel workbook. 
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Compare  Hydrographs w ith Excel 

We now have an Excel workbook that contains four worksheets. Each worksheet contains one of the 
hydrograph output files from a C2VSim run. The easiest way to see the difference between the Base Case and 
GWP Case is to take the difference between the groundwater hydrographs of the two runs, and the difference 
between the surface water hydrographs of the two runs.  

 

Show Groundwater Head Differences 
We will add a new Excel worksheet, and then use a formula to subtract each GWP Base Case groundwater 
hydrograph from the corresponding GWP Case groundwater hydrograph.  

1) In the GWP_Results.xlsx workbook, create a new worksheet and name it ‘GWHyd_Difference’.  
2) Switch to worksheet ‘GWHyd_GWP_Case’, select all <Ctrl-A> and copy <Ctrl-C> 
3) Switch to worksheet ‘GWHyd_Difference’, place the cursor in cell A1, and paste <Ctrl-V>. This copies 

the structure and values of the ‘GWHyd_GWP_Case’ worksheet. We will keep the structure and 
replace the values with formulas. 

4) We will use an Excel formula to calculate the difference between hydrograph values for each time 
step  
a) Place the cursor in cell B8 of worksheet ‘GWHyd_Difference’. 
b) Enter the ‘=’ sign, and (without hitting any key) select the tab for the ‘GWHyd_GWP_Case’ 

worksheet and place the cursor in cell B8. 
c)  Enter the ‘-’ sign, and (again without hitting any key) select the tab for the ‘GWHyd_Base_Case’ 

worksheet and place the cursor in cell B8. 
d) Hit <Return> 
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e) You should have the formula =GWHyd_GWP_Case!B8-GWHyd_Base_Case!B8 in cell B8 of 
the ‘GWHyd_Difference’ worksheet. The cell value should be ‘0’ 

5) Copy the formula through the rest of the ‘GWHyd_Difference’ worksheet 
a) Select cell B8, and copy with <Ctrl-C>. 
b) Select all of the hydrograph cells by holding down the <Shift> key and pressing <Right arrow>, 

the holding sown the <Shift> key and pressing <Down arrow> 
c) Paste the formula with <Ctrl-V> 

 

6) Create a graph of the difference between the GWP Case and Base Case for the groundwater 
hydrograph at Well A, in column BAK of the ‘GWHyd_Difference’ worksheet.  
a) Place the cursor in cell BAK8 and use <Shift><Down> to select the cells BAK8 through BAK451 
b) Under the ‘Insert’ menu, select ‘Scatter’ and then ‘Scatter with Straight Lines’. This will place a 

graph in the worksheet. 
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c) Right-click inside the new graph and select ‘Move Chart…’ to open the ‘Move Chart’ window, 
then select ‘New Sheet’ and name it ‘GWHyd’ 

 

The graph shows that the difference in groundwater heads between the GWP and Base cases fluctuates 
monthly, with a general pattern that is repeated over 30 times. The range of the cycle is approximately 0.5 ft. 
There is also an initial period of approximately five cycles followed by a period in which the cycle repeats each 
year. To better understand this cycle, we need to modify the x-axis to display dates. We need to add more 
information to the graph, including adding dates and setting the ranges of the x-axis. 

d) First, we will add dates to the x-axis and a title to the graph. 
i. Use the left mouse button to select the line inside the graph, then use the right mouse button 

to select ‘Select Data…’ 
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ii. Click on the ‘Edit…’ button 
iii. Under ‘Series name:’, click the square button on the right, with the red arrow, navigate to the 

‘GWHyd_Difference’ workbook, and select cell BAK6 
iv. Under ‘Series X Values:’, click the square button on the right, with the red arrow, navigate to 

the ‘GWHyd_Difference’ workbook, and select cells A8 through A451 
v. Click on the ‘OK’ button, then click the ‘OK’ button of the ‘Select Data Source’ window 

e) Format the x-axis to be more readable 
i. Right-click on the x-axis and choose ‘Format axis…’ 
ii. We want to set the minimum x-axis value to 10/31/1972 and the maximum value to 

09/30/2009.  
iii. Under ‘Axis Options’, for ‘Minimum’, click the radio button next to ‘Fixed’ and enter the 

numerical value of 10/31/1972, which is ‘26603’ 
iv. For ‘Maximum’, click the radio button next to ‘Fixed’ and enter the numerical value of 

09/30/2009, which is ‘40086’ 
v. For ‘Major Unit’, click the radio button next to ‘Fixed’ and enter ‘365.25’ 
vi. In the left panel, choose ‘Number’, then uncheck the box next to ‘Linked to source’ 
vii. Change the ‘Format Code’ from ‘m/d/yyyy’ to ‘mm/yy’ and then click the ‘Add’ button 
viii. In the left panel, choose ‘Alignment’, and use the drop-down menu next to ‘Text direction’ to 

choose ‘Rotate all text 900’ 

 

f) Add titles to the axes 
i. Select the ‘Layout’ menu, then ‘Axis Titles’, then ‘Primary Horizontal Axis Title’, then ‘Title 

Below Axis’ 
ii. Type ‘Month’ and hit <Return> 
iii. Select the ‘Layout’ menu, then ‘Axis Titles’, then ‘Primary Vertical Axis Title’, then ‘Rotated 

Title’ 
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iv. Type ‘Head Difference (ft)’ and hit <Return> 

 

Here we have the graph of the difference in groundwater heads at Well A, with annual dates on the x axis. 
This hydrograph shows that the water table altitude falls in the GWP Case (relative to the Base Case) in 
response to the additional pumping. The groundwater head difference changes for several years, then 
becomes relatively stable after around five to seven years. 

To better see the monthly differences between the two cases, we need to ‘zoom in’ on several months. We can 
copy the graph and then modify the x-axis range in the copy. 

g) We can make a copy of this graph, and use it to focus on several years 
i. Right-click on the tab ‘GWHyd’ and select ‘Move or Copy…’ to open the ‘Move or Copy’ 

window 
ii. Check the box next to ‘Create a copy’ in the lower left, then highlight ‘GWHyd’ in the 

window ‘Before sheet’ and click ‘OK’. This creates a copy called ‘GWHyd (2)’. 
iii. Right-click on the x-axis and choose ‘Format axis…’ 
iv. We want to look at a three-year period, so we will set the minimum x-axis value to 

10/31/1972 and the maximum value to 09/30/1975.  
v. Under ‘Axis Options’, for ‘Minimum’, we will keep the numerical value of 10/31/1972, which 

is ‘26603’ 
vi. For ‘Maximum’, we will enter the numerical value of 09/30/1975 is ‘27698’ 
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vii. For ‘Major Unit’, click the radio button next to ‘Fixed’ and enter ‘30’ 
viii. Place the cursor over the line, right-click, and select ‘Format data series…’ to open the 

Format Data Series window. 
ix. Select the second item in the left panel, ‘Marker Options’, select the button next to 

‘Automatic’, and then click ‘Close’ in the lower left corner. 

 

With this graph, we can get a better view of the monthly difference in groundwater heads between the GWP 
and Base cases for each month for the first three years. This graph shows us several things. 

• The groundwater head of the GWP Case declines each of the three months that the pumps are on, 
then recovers in the following nine months. This pattern is repeated each year. 

• The groundwater head does not fully recover after the first year, and is approximately 0.07 ft lower 
than the Base Case head in May 1974.  

• The May head is lower each year, falling approximately 0.07 ft between the first and second years, 
and an additional 0.03 ft between the second and third years.  

You can repeat this process for each of the other two groundwater hydrograph locations, at Well B and Well 
C. Example graphs for Well B (labeled with the element number, 296) and Well C (element 184) are below. 
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The groundwater head differences between the GWP and Base cases at wells B and C are significantly 
different from the head difference at Well A. In the first decade, the groundwater hydrographs for wells B and 
C do not recover significantly during the months that the pumps are turned off. This results in a steady 
increase in the groundwater head difference between the GWP and Base cases. In addition, the groundwater 
head difference does not stabilize, but continues to decline steadily over the 37 years of the simulation. 

 

Show Surface Water Flow Differences 
We can also use a similar process to create an Excel worksheet and graph to show the difference between 
each GWP Case surface water hydrograph and the corresponding Base Case surface water hydrograph.  

1) In the GWP_Results.xlsx workbook, create a new worksheet and name it ‘SWHyd_Difference’.  
2) Switch to the worksheet ‘SWHyd_GWP_Case’, select all <Ctrl-A> and copy <Ctrl-C> 
3) Switch to the worksheet ‘SWHyd_Difference’, place the cursor in cell A1, and paste <Ctrl-V>. This 

copies the structure and values of the ‘SWHyd_GWP_Case’ worksheet. We will keep the structure and 
replace the values with formulas. 

4) We will use an Excel formula to calculate the difference between hydrograph values for each time 
step  
a) Place the cursor in cell B7 of worksheet ‘SWHyd_Difference’. 
b) Enter the ‘=’ sign, and (without hitting any key) select the tab for the ‘SWHyd_GWP_Case’ 

worksheet and place the cursor in cell B8. 
c)  Enter the ‘-’ sign, and (again without hitting any key) select the tab for the ‘SWHyd_Base_Case’ 

worksheet and place the cursor in cell B8. 
d) Hit <Return> 
e) You should have the formula =SWhyd_GWP_Case!B7-SWhyd_Base_Case!B7 in cell B8 of 

the ‘GWHyd_Difference’ worksheet. The cell value should be ‘0’ 
3) Copy the formula through the rest of the ‘SWHyd_Difference’ worksheet 

a) Select cell B7, and copy with <Ctrl-C>. 
b) Select all of the hydrograph cells by holding down the <Shift> key and pressing <Right arrow>, 

the holding sown the <Shift> key and pressing <Down arrow> 
c) Paste the formula with <Ctrl-V> 
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4) Create a graph of the difference between the GWP Case and Base Case for the surface water 
hydrograph at river node 300, near Well A, in column AJ of the ‘SWHyd_Difference’ worksheet.  
a) Place the cursor in cell AJ7 and use <Shift><Down> to select the cells AJ7 through AJ450 
b) Under the ‘Insert’ menu, select ‘Scatter’ and then ‘Scatter with Straight Lines’. This will place a 

graph in the worksheet. 

c) Right-click inside the new graph and select ‘Move Chart…’ to open the ‘Move Chart’ window, 
then select ‘New Sheet’ and name it ‘SWHyd’ 

 

The graph shows that the difference in surface water flows between the GWP and Base cases also fluctuates 
monthly, with a general pattern that is repeated over 30 times. The y-axis units are acre-feet/month. The 
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range of the cycle is approximately 1,500 AF/month. To better understand this cycle, we need to modify the x-
axis to add titles, display dates on the x-axis and set the x-axis bounds. 

d) First, we will add dates to the x-axis and a title to the graph. 
i. Use the left mouse button to select the line inside the graph, then use the right mouse button 

to select ‘Select Data…’ 
ii. Click on the ‘Edit…’ button 
iii. Under ‘Series name:’, click the square button on the right, with the red arrow, navigate to the 

‘GWHyd_Difference’ workbook, and select cell AJ6 
iv. Under ‘Series X Values:’, click the square button on the right, with the red arrow, navigate to 

the ‘GWHyd_Difference’ workbook, and select cells A7 through A450 
v. Click on the ‘OK’ button, then click the ‘OK’ button of the ‘Select Data Source’ window 

e) Format the x-axis to be more readable 
i. Right-click on the x-axis and choose ‘Format axis…’ 
ii. We want to set the minimum x-axis value to 10/31/1972 and the maximum value to 

09/30/2009.  
iii. Under ‘Axis Options’, for ‘Minimum’, click the radio button next to ‘Fixed’ and enter the 

numerical value of 10/31/1972, which is ‘26603’ 
iv. For ‘Maximum’, click the radio button next to ‘Fixed’ and enter the numerical value of 

09/30/2009, which is ‘40086’ 
v. For ‘Major Unit’, click the radio button next to ‘Fixed’ and enter ‘365.25’ 
vi. In the left panel, choose ‘Number’, then uncheck the box next to ‘Linked to source’ 
vii. Change the ‘Format Code’ from ‘m/d/yyyy’ to ‘mm/yy’ and then click the ‘Add’ button 
viii. In the left panel, choose ‘Alignment’, and use the drop-down menu next to ‘Text direction’ to 

choose ‘Rotate all text 900’ 
f) Add titles to the axes 

i. Select the ‘Layout’ menu, then ‘Axis Titles’, then ‘Primary Horizontal Axis Title’, then ‘Title 
Below Axis’ 

ii. Type ‘Month’ and hit <Return> 
iii. Select the ‘Layout’ menu, then ‘Axis Titles’, then ‘Primary Vertical Axis Title’, then ‘Rotated 

Title’ 
iv. Type ‘Flow Difference (AF/mo)’ and hit <Return> 
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This surface water hydrograph shows the difference in flows between the GWP and Base cases at river node 
300, near pumping well A. This graph shows that the GWP Case flow rate drops sharply below the Base Case 
flow rate for a short period each year, then the GWP Case flow rate rises above the Base Case flow rate for a 
longer period. The cycle appears to repeat each year. For approximately the first 20 cycles, GWP Case flows 
are greater than Base Case flows during the recovery period, and after this the GWP Case flows are always 
lower than the Base Case flows. This probably reflects the cumulative impacts of the additional groundwater 
pumping, and the expansion of the groundwater pumping depression around the pumping well to intersect 
the river nodes. 

To better see the monthly differences between the two cases, we can focus on a period of several years. We 
can do this by creating a copy of the graph and then modifying the x-axis range in the copy. 

g) We can make a copy of this graph, and use it to focus on several years, as we did with the 
groundwater hydrograph 

i. Right-click on the tab ‘SWHyd’ and select ‘Move or Copy…’ to open the ‘Move or Copy’ 
window 

ii. Check the box next to ‘Create a copy’ in the lower left, then highlight ‘SWHyd’ in the window 
‘Before sheet’ and click ‘OK’. This creates a copy called ‘SWHyd (2)’. 

iii. Right-click on the x-axis and choose ‘Format axis…’ 
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iv. We want to look at a three-year period, so we will set the minimum x-axis value to 
10/31/1972 and the maximum value to 09/30/1975.  

v. Under ‘Axis Options’, for ‘Minimum’, we will keep the numerical value of 10/31/1972, which 
is ‘26603’ 

vi. For ‘Maximum’, we will enter the numerical value of 09/30/1975 is ‘27698’ 
vii. For ‘Major Unit’, click the radio button next to ‘Fixed’ and enter ‘30’ 
viii. Place the cursor over the line, right-click, and select ‘Format data series…’ to open the 

Format Data Series window. 
ix. Select the second item in the left panel, ‘Marker Options’, select the button next to 

‘Automatic’, and then click ‘Close’ in the lower left corner. 

 

Here we can see the monthly difference in surface water flows between the GWP and Base cases at river node 
300, near pump A, for the first three years of the simulation. GWP Case stream flow is lower for the months 
June through August when the pumps are on, and then is greater than Base Case river flows for several 
months, and approaches Base Case flows in May, just before the pumps are turned on again. River node 300 
is near Well A and is also downstream from well C, so this flow difference includes the effects of Well C on 
river flow.  

You can repeat this process for each of the other two surface water hydrograph locations, at river node 350 
near Well B and river node 278 near Well C. Example graphs for these two river nodes are below. 
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These two surface water hydrographs are more complex than the hydrograph at river node 300 above. Well A 
is located near the Sacramento River, and the surface water hydrograph at river node 300 shows a strong 
response to the pumping. Wells B and C are located some distance from the river. The surface water 
hydrograph at river node 350 shows a flow increase when the pump is operating, most likely due to increased 
return flows. Surface water flows are always greater than the Base Case except during drought periods, when 
there are significant declines.  

The surface water hydrograph at river node 278 also shows that the GWP Case flows are greater than the 
Base Case flows when the pumps are on. However, surface water flows in the GWP Case show a long-term 
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decline as the cone of depression at Well C expands to intersect the river and reduce groundwater discharges 
to the river.  

We can also graph the difference in surface water flow at a reference surface water flow gage, such as 
Sacramento River at Freeport (river node 384, column L of the surface water hydrographs worksheets). 

 

The graph of the difference in surface water flows for the Sacramento River at Freeport shows that river flows 
are increased during the months the pumps are operated. Although the pumping rates are constant each year, 
the flow increase at Freeport varies each year. This includes flow changes due to several factors, including 
increased return flows (as the crop water supply has been increased by 6,000 AF/month) and reduced 
groundwater discharges. Flows are higher all year for the first eight years, and then are lower during a portion 
of the year for the remainder of the simulation time period. The minimum flow value also declines over time. 

 

 

Compare  Budget  Tab les 

Graphs of project impacts on groundwater heads and stream flows can help us identify the broad impacts of 
the project. We can then use the detailed Budget tables to compare differences in individual flow terms to 

-1000 

-500 

0 

500 

1000 

1500 

2000 

2500 

3000 

10/72 
10/73 
10/74 
10/75 
10/76 
10/77 
10/78 
10/79 
10/80 
10/81 
10/82 
10/83 
10/84 
10/85 
10/86 
10/87 
10/88 
10/89 
10/90 
10/91 
10/92 
10/93 
10/94 
10/95 
10/96 
10/97 
10/98 
10/99 
10/00 
10/01 
10/02 
10/03 
10/04 
10/05 
10/06 
10/07 
10/08 

Fl
ow

 D
iff

er
en

ce
 (A

F/
m

o)
 

Month 

384 

384 



 C2VSim Hands-On Tutorial  

93 
 

gain a better understanding of project impacts. In this section, we will compare GWP Case and Base Case 
Budget tables for the Land and Water Use, Root Zone, Groundwater, and Stream Reach Budgets. 

This case study involves adding three new groundwater pumps located in model subregions 3, 4 and 5. For the 
analysis below, we will focus on subregion 5. These steps can also be repeated for the other subregions. 

 

Compare Land and Water Use Budgets for Subregion 5 
We can see the impact of one or more pumps by comparing the Land and Water Use Budget tables for one or 
more subregions between the GWP Case and Base Case. Pump B is located in model subregion 5, and we will 
compare the Land and Water Use Budget tables for this subregion. 

1) Open the two Excel workbooks Base_Land_and_Water_Budget.xlsx and 
GWP_Land_and_Water_Budget.xlsx.  

2) Create a new Excel workbook GWP_Land_and_Water_Compare.xlsx and save it in 
GWP_Case_Study. 

3) Rename the worksheet ‘Sheet1’ to ‘Land Water SR5’. 
4) We want to copy the format (dates, column titles, etc) of the Land and Water Use Budget tables to 

the worksheet of the new workbook. Go to tab ‘Subregion 5 (DSA 69)’ of 
GWP_Land_and_Water_Budget.xlsx. Click in the box in the upper left, above row label ‘1’ and 
to the left of column label ‘A’. This will select the entire worksheet. Use <Ctrl-C> to copy the column. 

5) Go to tab ‘Land Water SR5’ of GWP_Land_and_Water_Compare.xlsx and put the cursor in cell 
A1. Use <Ctrl-V> to paste the contents of worksheet ‘Subregion 5 (DSA 69)’. 

6) Format the column headers 
a) Click on the box with ‘5’ on the left side of the workbook to select the row 
b) Use <Ctrl-1> to open the ‘Format Cells’ panel 
c) Select the ‘Alignment’ tab 
d) Use the drop-down menu under ‘Horizontal’ to select ‘Center’ 
e) Use the drop-down menu under ‘Vertical’ to select ‘Center’ 
f) Check the box next to ‘Wrap text’ 
g) Click ‘OK’ to close the panel 
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7) Next we want to replace the values in this worksheet with formulas to calculate the difference 
between the GWP Case and Base Case for subregion 5.  
a) Place the cursor in cell B6 (to the right of date 10/31/1972) and press ‘=’ to start a new formula.  
b) Without hitting return or touching anything else with the cursor, select the ‘View’ menu and use 

the ‘Switch Windows’ button to choose the GWP_Land_and_Water_Budget.xlsx workbook.  
c) Go to the tab labeled ‘Subregion 5 (DSA 69)’.  
d) Place the cursor in cell B6, then hit the <F4> key three times to remove the ‘$’ signs in the 

formula.  
e) Type the minus sign ‘-‘.  
f) Again, without hitting return or touching anything else with the cursor, select the ‘View’ menu 

and use the ‘Switch Windows’ button to choose the Base_Land_and_Water_Budget.xlsx 
workbook.  

g) Go to the tab labeled ‘Subregion 5 (DSA 69)’.  
h) Place the cursor in cell B6, then hit the <F4> key three times to remove the ‘$’ signs in the 

formula.  
i) Hit the <Return> key 

The cell formula should be ='[GWP_Land_and_Water_Budget .x lsx]Subregion 5 (DSA 69)’!B6-
'[Base_Land_and_Water_Budget.xlsx]Subregion 5 (DSA 69)’!B6. The cell value should be close to 
zero. 

8) Next, we will copy this formula to all the cells in the budget table.  
a) Place the cursor in cell B6 and then move the cursor over the small black square that appears in 

the lower right corner of the cell so the cursor changes to a black plus sign. Double-click on the 
black square to copy the formulas down column B to the end of the column.  

b) Then use <Ctrl-C> to copy the formulas in this column, <Ctrl><Shift><Right> to select the other 
cells in the budget table, and <Ctrl-V> to paste the formula. 
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Review the Differences 
The Land and Water Use Budget reports the monthly balance between water demand and water supply. We 
can visually see the major difference between the Base and GWP cases: The values in column E, which is 
labeled ‘Ag. Pumping (+)’, are ‘0.00’ for the months of October through May, and ‘2000.01’ for the months of 
June through August. These values are than repeated each year through 2009. These pumping rates are 
reflected in the large negative values in column G, ‘Ag. Shortage’; negative values indicate a surplus. Pumping 
adjustment was turned off in the Simulation Control File (KOPTDV is set to ‘00’), so the additional 
groundwater pumping means the water supply is greater than the water demand. (The difference between the 
Base Case and GWP Case agricultural water demand, the ‘Potential CUAW’ in column C, is zero.) 

The values in column F, ‘Ag. Diversions (+)’, are also greater than zero in some months. This indicates 
differences in surface water diversions between the Base Case and GWP Case. This is most likely occurring 
because changes in return flows and stream-aquifer flows in the GWP case have resulted in increases in 
stream flows at surface water diversion points where flows were insufficient to satisfy the entire diversion 
under the Base Case. The increased return flows therefore lead to increases in surface water diversions. 

 

 

Compare Root Zone Budgets for Subregion 5 
The Root Zone Budget provides details of the monthly water inflows and outflow of the land surface process. 
It shows how changes in water availability affect root-zone water storage, return flows and deep percolation. 
We will compare the Base Case and GWP Case Root Zone Budget tables for subregion 5. 

1) Open the two Excel workbooks Base_Root_Zone_Budget.xlsx and 
GWP_Root_Zone_Budget.xlsx.  

2) Create a new Excel workbook GWP_Root_Zone_Compare.xlsx and save it in GWP_Case_Study.  
3) Rename the worksheet ‘Sheet1’ to ‘Root Zone SR5’. 
4) We want to copy the format (dates, column titles, etc) of the Groundwater Budget tables to the 

worksheet of the new workbook. Go to (for example) tab ‘Subregion 5 (DSA 69)’ of 
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GWP_Root_Zone_Budget.xlsx. Click in the box in the upper left, above row label ‘1’ and to the 
left of column label ‘A’. This will select the entire worksheet. Use <Ctrl-C> to copy the column. 

5) Go to tab ‘Root Zone SR5’ of GWP_Root_Zone_Compare.xlsx and put the cursor in cell A1. Use 
<Ctrl-V> to paste the contents of worksheet ‘Subregion 5 (DSA 69)’. 

6) Format the column headers 
a) Click on the box with ‘5’ on the left side of the workbook to select the row 
b) Use <Ctrl-1> to open the ‘Format Cells’ panel 
c) Select the ‘Alignment’ tab 
d) Use the drop-down menu under ‘Horizontal’ to select ‘Center’ 
e) Use the drop-down menu under ‘Vertical’ to select ‘Center’ 
f) Check the box next to ‘Wrap text’ 
g) Click ‘OK’ to close the panel 

7) Next we want to calculate the difference between the GWP Case and Base Case for subregion 5.  
a) Place the cursor in cell B5 (to the right of date 10/31/1972) and press ‘=’ to start a new formula.  
b) Without hitting return or touching anything else with the cursor, select the ‘View’ menu and use 

the ‘Switch Windows’ button to choose the GWP_Root_Zone_Budget.xlsx workbook.  
c) Go to the tab labeled ‘Subregion 5 (DSA 69)’.  
d) Place the cursor in cell B6, then hit the <F4> key three times to remove the ‘$’ signs in the 

formula.  
e) Type the minus sign ‘-‘.  
f) Again, without hitting return or touching anything else with the cursor, select the ‘View’ menu 

and use the ‘Switch Windows’ button to choose the Base_Root_Zone_Budget.xlsx 
workbook.  

g) Go to the tab labeled ‘Subregion 5 (DSA 69)’.  
h) Place the cursor in cell B6, then hit the <F4> key three times to remove the ‘$’ signs in the 

formula.  
i) Hit the return key.  

The cell formula should be ='[GWP_Root_Zone_Budget .x lsx]Subregion 5 (DSA 69)’!B6-
'[Base_Root_Zone_Budget .x lsx]Subregion 5 (DSA 69)’!B6. The cell value should be close to zero. 

8) Next, we will copy this formula to all the cells in the budget table.  
a) Place the cursor in cell B6 and then move the cursor over the small black square that appears in 

the lower right corner of the cell so the cursor changes to a black plus sign. Double-click on the 
black square to copy the formulas down column B to the end of the column.  

b) Then use <Ctrl-C> to copy the formulas in this column, <Ctrl><Shift><Right> to select the other 
cells in the budget table, and <Ctrl-V> to paste the formula. 

Review the Differences 
Again, we can visually see the major difference between the Base and GWP cases: The values in column E, 
labeled ‘Ag. Prime Applied Water’, are ‘0.00’ for October 1972 through May 1973, ‘2000.01’ for June and July 
1973, ‘2190.21’ for August 1973, and ’41.29’ for September 1973. The ‘Ag. Prime Applied Water’ value is 
equal to the sum of the ‘Ag. Pumping’ and ‘Ag. Diversion’ values from the Land and Water Use Budget. (The 
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values in your worksheet may be slightly different, owing to slight differences in the numerical solver solutions 
for different computer architectures.)  

 

Column B of the Root Zone Budget lists the agricultural area in acres; this changes every October when the 
model reads the land use and crop acreages for the next water year. The difference between the two cases 
should always be zero.  

Columns C through H provide the water balance above the soil surface for the agricultural area, including 
inflows from precipitation and supplies (surface water and groundwater) and outflows to runoff (of 
precipitation) and return flow (of applied water).  

Columns I through N provide the water balance below the soil surface for the agricultural area. This includes 
beginning and ending soil moisture, gains from infiltration (of precipitation and applied water), and losses to 
evapotranspiration and deep percolation.  

Looking at row 14 of the workbook, we see that in June 1973, an additional 2,000 AF of prime applied water 
led to an increase of 1,732 AF in return flows and 267 AF in infiltration. The increase of 267 AF in infiltration 
led to an increase of 267 AF in deep percolation, and no change in ending root-zone water storage. The 
increase in prime applied water is exactly equal to the sum of return flows and deep percolation.  
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Compare Groundwater Budgets for Subregion 5 
We can see the impact of the increased pumping on the groundwater aquifer by comparing the Groundwater 
Budget tables for one or more subregions between the GWP Case and Base Case. Pump B is located in model 
subregion 5, and we can compare the Groundwater Budget tables for the two cases for this subregion. 

1) Open the two Excel workbooks Base_Groundwater_Budget.xlsx and 
GWP_Groundwater_Budget.xlsx.  

2) Create a new Excel workbook GWP_Groundwater_Compare.xlsx and save it in 
GWP_Case_Study.  

3) Rename the worksheet ‘Sheet1’ to ‘Groundwater SR5’. 
4) We want to copy the format (dates, column titles, etc) of the Groundwater Budget tables to the 

worksheet of the new workbook. Go to (for example) tab ‘Subregion 5 (DSA 69)’ of 
GWP_Groundwater_Budget.xlsx. Click in the box in the upper left, above row label ‘1’ and to 
the left of column label ‘A’. This will select the entire worksheet. Use <Ctrl-C> to copy the column. 

5) Go to tab ‘Groundwater SR5’ of GWP_Groundwater_Compare.xlsx and put the cursor in cell A1. 
Use <Ctrl-V> to paste the contents of worksheet ‘Subregion 5 (DSA 69)’. 

6) Format the column headers 
a) Click on the box with ‘5’ on the left side of the workbook to select the row 
b) Use <Ctrl-1> to open the ‘Format Cells’ panel 
c) Select the ‘Alignment’ tab 
d) Use the drop-down menu under ‘Horizontal’ to select ‘Center’ 
e) Use the drop-down menu under ‘Vertical’ to select ‘Center’ 
f) Check the box next to ‘Wrap text’ 
g) Click ‘OK’ to close the panel 

7) Next we want to calculate the difference between the GWP Case and Base Case for subregion 5.  
a) Place the cursor in cell B5 (to the right of date 10/31/1972) and press ‘=’ to start a new formula.  
b) Without hitting return or touching anything else with the cursor, select the ‘View’ menu and use 

the ‘Switch Windows’ button to choose the Base_Groundwater_Budget.xlsx workbook.  
c) Go to the tab labeled ‘Subregion 5 (DSA 69)’.  
d) Place the cursor in cell B6, then hit the <F4> key three times to remove the ‘$’ signs in the 

formula.  
e) Type the minus sign ‘-‘.  
f) Again, without hitting return or touching anything else with the cursor, select the ‘View’ menu 

and use the ‘Switch Windows’ button to choose the GWP_Groundwater_Budget.xlsx 
workbook.  

g) Go to the tab labeled ‘Subregion 5 (DSA 69)’.  
h) Place the cursor in cell B6, then hit the <F4> key three times to remove the ‘$’ signs in the 

formula.  
i) Hit the return key.  

The cell formula should be ='[GWP_Groundwater_Budget .xlsx]Subregion 5 (DSA 69)’!B6-
'[Base_Groundwater_Budget .xlsx]Subregion 5 (DSA 69)’!B6. The cell value should be close to zero. 

8) Next, we will copy this formula to all the cells in the budget table.  
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a) Place the cursor in cell B6 and then move the cursor over the small black square that appears in 
the lower right corner of the cell so the cursor changes to a black plus sign. Double-click on the 
black square to copy the formulas down column B to the end of the column.  

b) Then use <Ctrl-C> to copy the formulas in this column, <Ctrl><Shift><Right> to select the other 
cells in the budget table, and <Ctrl-V> to paste the formula. 

Review the Differences 
We can visually see the major difference between the Base and GWP cases in this Groundwater Budget table: 
The values in the column labeled ‘Pumping (-)’ are ‘0.00’ for October 1972 through May 1973, ‘2000.01’ for 
June through August 1973, and ‘0.00’ for September 1973. These values are than repeated each year through 
2009. This difference in groundwater pumping rates reflects the 2,000 AF/month pumped from Well B. 

We can also trace the impacts of the change in deep percolation noted in the Root Zone Budget comparison 
for Subregion 5 above. Water that flows from the root zone to the unsaturated zone is listed in Column B as 
‘Deep Percolation’, and is equal to the value in the Root Zone Budget. Water that flows from the unsaturated 
zone into the saturated zone is listed in Column E as ‘Net Deep Percolation (+)’.  

 

When 2,000 AF is removed from the groundwater flow system over a month via pumps, it must be offset by an 
equal amount of water inflows or reduced overflows. A small portion of this 2,000 AF is offset by increased 
net deep percolation. The rest is offset by changes in stream-aquifer flows, removal of additional water from 
groundwater storage, and changes in boundary flows between subregion 5 and adjacent model subregions. 
The removal of water from storage also causes a slight increase in land-surface subsidence. 

Create a Water Year Summary 
We can use the ‘WY-Month’ tool on the ‘IWFM Tools’ menu to see the differences between the GWP Case and 
the Base Case for each flow term. We will demonstrate this by looking at the changes in stream-aquifer flows, 
labeled ‘Gain from Stream (+)’, in column F. 
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Under the ‘IWFM Tools’ menu, select ‘WY-Month’ to open the ‘WY-Month’ panel.  

1) Place the cursor in the ‘Date Range’ area and select the dates from column A, cells A6 to A449.  
2) Place the cursor in the ‘Time Series Data Range’ area and select the data values from column F, cells 

F6 to F449.  
3) Put the cursor in the ‘Output range’ area and select cell S5.  
4) In the ‘Unit Conversion’ section, click next to ‘AF’ under ‘Time Series Data’ and ‘AF’ under ‘Table’. 
5) At the bottom of the WY-Month panel, click the boxes next to ‘Use 1000 Separator’ and the graphs 

for monthly averages and annual totals, and click ‘OK’.  

 

This will produce a table with the monthly difference in stream-aquifer flows between the two cases for 
subregion 5, with the total annual difference in the right-most column. Average, minimum and maximum 
values are listed at the bottom of this table.  

Two graphs are also produced, to the right of the Water Year-Month table. The top graph shows the average 
monthly difference in stream-aquifer flows between the two scenarios. This shows the greatest difference in 
the months of June to August when the pumps are operating. Well B is located some distance from the rivers, 
and this is reflected in the impact on stream-aquifer flow difference in the months the pump is operating. The 
change in stream-aquifer flow averages 500 AF in June and falls to slightly more than 400 AF in August, less 
than a quarter of the pumping volume at Well B. Stream-aquifer flows are changed for every month, with the 
lowest impact in November.   
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The lower graph shows the annual difference in stream-aquifer flows between the two cases. The flow 
difference starts around 500 AF/year in the first year, increases rapidly for 14 years, and then increases at a 
slower pace through 2009. The greatest difference occurs in 2007, suggesting that the stream-aquifer flow 
difference never reaches equilibrium, and continues to increase even after 37 years.  

 

The average annual difference in stream-aquifer flows is 2,562 AF, less than half of the annual pumping 
volume of 6,000 AF. However, in the last ten years, the average stream-aquifer flow difference is 
approximately 3,700 AF/year, or 60% of the amount pumped. 
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Compare Stream Reach Budgets for Reaches 32 to 67 
The three pumps we have added are all in the Sacramento River Basin north of the City of Sacramento. We can 
see the cumulative impact of the three pumps by comparing the flows of all stream reaches in the Sacramento 
Valley upstream of the confluence of the Cosumnes and Sacramento rivers. We can use either the C2VSim 
ArcGIS GUI or the Preprocessor CVrivers.dat file to determine the river reaches in the Sacramento River 
Basin. The most upstream river reach in the Sacramento River Basin is reach 32, and the Sacramento River 
reach upstream of the confluence with the Cosumnes River is reach 67. We will use Excel to sum the Stream 
Reach Budget tables for reaches 32 through 67. 

1) Open the two Excel workbooks Base_Stream_Reach_Budget.xlsx and 
GWP_Stream_Reach_Budget.xlsx.  

2) Create a new Excel workbook GWP_Stream_Reach_Compare.xlsx and save it in directory 
GWP_Case_Study.  

3) Rename the worksheet ‘Sheet1’ to ‘Sac Valley Stream Reaches’. 
4) We want to copy the format (dates, column titles, etc) of the Stream Reach Budget tables to the 

worksheet of the new workbook. Go to tab ‘Stream reach 75’ of 
GWP_Stream_Reach_Budget.xlsx. Click in the box in the upper left, above row label ‘1’ and to 
the left of column label ‘A’. This will select the entire worksheet. Use <Ctrl-C> to copy the column. 

 

5) Go to tab ‘Sac Valley Stream Reaches’ of GWP_Stream_Reach_Compare.xlsx and put the cursor 
in cell A1. Use <Ctrl-V> to paste the contents of worksheet ‘Stream reach 75’. 

6) In cell A2, change the title to ‘STREAM FLOW BUDGET IN AC. FT. FOR REACHES 32-67’ 
7) Format the column headers 

a) Click on the box with ‘4’ on the left side of the workbook to select the row 
b) Use <Ctrl-1> to open the ‘Format Cells’ panel 
c) Select the ‘Alignment’ tab 
d) Use the drop-down menu under ‘Horizontal’ to select ‘Center’ 
e) Use the drop-down menu under ‘Vertical’ to select ‘Center’ 
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f) Check the box next to ‘Wrap text’ 
g) Click ‘OK’ to close the panel 

8) Next we want to calculate the difference between the GWP Case and Base Case for all of the river 
reaches from 32 to 67 inclusive.  
a) Place the cursor in cell B5 (to the right of date 10/31/1972) and press ‘=sum(’ to start the new 

formula.  
b) Without hitting return or touching anything else with the cursor, select the ‘View’ menu and use 

the ‘Switch Windows’ button to choose the GWP_Stream_Reach_Budget.xlsx workbook.  
c) Use the arrow keys in the lower left corner of the Excel window to navigate to the tab labeled 

‘Stream reach 32’ and select this tab.  
d) Place the cursor in cell B5.  
e) Use arrow keys in the lower left corner of the Excel window  to navigate to the tab 

labeled ‘Stream reach 67’ and hold down the <Shift> key as you select this tab.  
f) Hit the <F4> key three times to remove the ‘$’ signs in the formula 
g) Type the close parenthesis, the minus sign, and the start of the SUM formula: ‘)-sum(‘.  
h) Again, without hitting return or touching anything else with the cursor, select the ‘View’ menu 

and use the ‘Switch Windows’ button to choose the Base_Stream_Reach_Budget.xlsx 
workbook.  

i) Use the arrow keys in the lower left corner of the Excel window to navigate to the tab labeled 
‘Stream reach 32’ and select this tab.  

j) Place the cursor in cell B5.  
k) Use arrow keys in the lower left corner of the Excel window to navigate to the tab labeled 

‘Stream reach 67’ and hold down the <Shift> key as you select this tab. 
l) Hit the <F4> key three times to remove the ‘$’ signs in the formula 
m) Type the close parenthesis ‘)’ 
n) Hit the <Return> key.  

The cell formula should be =SUM('[GWP_Stream_Reach_Budget .xlsx]Stream reach 32:Stream 
reach 67'!B5)-SUM('[Base_Stream_Reach_Budget .x lsx]Stream reach 32:Stream reach 67'!B5’). 
The cell value should be close to zero. 

9) Next, we will copy this formula to all the cells in the budget table.  
a) Place the cursor in cell B5 and then move the cursor over the small black square that appears in 

the lower right corner of the cell so the cursor changes to a black plus sign. Double-click on the 
black square to copy the formulas down column B to the end of the column.  

b) Then use <Ctrl-C> to copy the formulas in this column, <Ctrl><Shift><Right> to select the other 
cells in the budget table, and <Ctrl-V> to paste the formula. 
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The cell values should be zeroes for the first few months. They will change to non-zero numbers in June 1973 
once the two scenarios are different. (Ignore the columns ‘Upstream Inflow (+)’ and ‘Downstream Outflow (-)’, 
as these sum differences in inflows to all of the individual river reaches and some values are counted multiple 
times.) 

Review the Differences 
We can use the ‘WY-Month’ tool on the ‘IWFM Tools’ menu to see the differences between the groundwater 
pumping case and the base case.  

Under the ‘IWFM Tools’ menu, select ‘WY-Month’ to open the ‘WY-Month’ panel.  

1) Place the cursor in the ‘Date Range’ area and select the dates from column A, cells A5 to A448.  
2) Place the cursor in the ‘Time Series Data Range’ area and select the data values from column H, cells 

H5 to H448.  
3) Put the cursor in the ‘Output range’ area and select cell P5.  
4) In the ‘Unit Conversion’ section, click next to ‘AF’ under ‘Time Series Data’ and ‘TAF’ under ‘Table’. 
5) At the bottom of the WY-Month panel, click the boxes next to the graphs for monthly averages and 

annual totals, and click ‘OK’.  
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This will produce a table with the total monthly difference in gain from groundwater between the two cases 
for all of the river reaches in the Sacramento River Basin resulting from operation of the three new 
groundwater pumps.  

 

 

Two graphs are also produced, to the right of the Water Year-Month table.  
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The top graph shows the average monthly difference in stream gain from groundwater between the two 
scenarios. The y-axis is in units of thousand acre-feet per month. Positive values indicate increases in 
groundwater flows to streams versus the base case, and negative values indicate reductions in groundwater 
flows to streams versus the base case. We can see large reductions in groundwater discharges to streams in 
the three months June-August, when the pumps are operating. We also see small increases in groundwater 
discharges to streams in September through January, and small decreases in groundwater discharges to 
streams in February through May.  

The three pumps have a total pumping rate of 6,000 AF/mo for each month from June through August. From 
this graph, we can see that the reduction in groundwater discharge to streams is approximately 2,000 AF/mo, 
or approximately 33% of the pumping rate. 
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The lower graph shows the annual differences in groundwater discharges to streams in the Sacramento River 
Basin between the GWP and Base cases. The y-axis is in units of thousand acre-feet per year. Groundwater 
discharges to steams are reduced in all years. Over the 37 years of this project, we see a long-term and fairly 
steady reduction in groundwater discharges to streams. By the third decade, the annual reduction in 
groundwater discharges to streams is approximately 7,000 AF/year, or over one third of the 18,000 AF/year 
extracted by the three pumps.  

 

Summary 

This scenario demonstrates how we can use the C2VSim model to investigate the complex hydrologic 
interactions within the integrated land surface, groundwater and surface water flow system of the Central 
Valley. In this scenario, three new wells were added, each pumping 2,000 AF/m for three months, or 6,000 
AF/yr. The additional pumping impacts the groundwater aquifer, resulting in changes in groundwater storage 
and groundwater discharges to streams. In this simplified example, we did not reduce surface water 
diversions, so the increased pumping causes agricultural water supplies to exceed demands. This excess water 
ripples through the hydrologic system, affecting return flows, root-zone soil moisture, deep percolation, and 
stream flows. 

Each of the pumps has some impact on river flows. The pumps are located varying distances from rivers, and 
we can see from the surface water hydrographs that the impact of each pump on river flows is affected by the 
distance from the river. Operation of pump A, screened in the unconfined aquifer less than a mile from the 
Sacramento River, significantly reduces river flows. Operation of pump B, located some distance from the Yuba 
River, increases river flows in wet years through increased return flows, and reduces river flows in dry years. 
The use of pump C, located in the western Sacramento Valley a significant distance from the Sacramento 
River, provides net increases in river flows during summer months, and long-term net decreases in winter 
flows.   
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These pumps extract a very small water volume, and yet have a noticeable impact on the hydrologic system. 
This basic scenario can be modified to investigate the impacts of more realistic operations. For example, the 
pumping rates could be increased to 10,000 AF/mo or even 20,000 AF/mo to more closely model the pumping 
rates of typical irrigation district operations. The pumps could also be operated only in selected years, for 
example only in historically dry hears, to better simulate the effects of groundwater recovery over multiple 
years. 
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Scenar io 2 - ASR: Aquifer  Storage and Recovery  Example  

Description: This is a fictional case study of an aquifer storage and recovery project. A surface water diversion 
from the Sacramento River will be increased by 1,000 AF/mo for the six months November through April each 
year and the water will be recharged through a recharge basin. For the three months June-August, the surface 
water diversion will be decreased by 2,000 AF/mo and a new pump adjacent to the recharge basin will pump 
2,000 AF/mo.  

This example will show how to modify the Diversion Specification File and Diversion Data File to add a surface 
water diversion; how to modify the Well Specification File, Pumping Specification File and Pumping Data File 
to add a new well; and how to analyze simulation results. We will modify diversion #27 at River Node 282 on 
the Sacramento River north of Colusa, which delivers water to Subregion 3 for agricultural use. An additional 
1,000 AF/mo will be diverted each month from November through April (6 months = 6,000 AF) and will be 
recharged in element #206, west of the Sacramento River. The diversion volume will be reduced by 2,000 
AF/mo for June through August, so the annual diversion volume will remain constant. We will assume the 
winter diversion has evaporative losses of 5% and that 95% of the diverted water is recharged in the recharge 
basin. A pump will be placed near the recharge basin, and 2,000 AF/mo will be pumped for agricultural use in 
the months June through August.  

 

Initial Steps 

The first steps are to set up the project folders, and identify the coordinates of the new pumping wells and 
nearby river nodes. 

Set  up the project  fo lders 

The first step is to create folders for the aquifer storage and recovery scenario and the unmodified base case.  

1) Create a folder in a convenient place (such as the top directory of the D: drive) called 
ASR_Case_Study. This folder will hold subfolders with two versions of the model – one for the case 
study and one for the unmodified base case. 

2) Copy the folder C2VSim_CG_1972IC_R369 into the folder ASR_Case_Study and rename it 
ASR_Case. The C2VSim files in this folder will be modified to represent the scenario. 

3) Copy the folder C2VSim_CG_1972IC_R369 into the folder ASR_Case_Study again, and rename it 
Base_Case. Only the C2VSim ‘CVprint.dat’ file in this folder will be modified. 
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Find the  locat ion of  the recharge basin and pumping well using ArcMap 

Next, we will use the feature classes in a C2VSim geodatabase to locate the recharge basin and pumping well. 
We know the recharge basin will be in element 206, and the well will be inside the same model element. We 
can use ArcMap to find element 206, and then find the latitude and longitude of the well within this element. 

Double-click on the ArcMap project file C2VSim_CG_1972IC_R369.mxd to open it, if it is not already open.  

Right-click on ‘Element’ in the ‘Table of Contents’ pane and select ‘Open Attribute Table’.  

Use the ‘Element_ID’ column to find the row that contains element 206 and left-click in the gray box on the 
left end of the row to select the row.  

 

Right-click in the gray box with the black triangle on the left end of the row, and select ‘Zoom to selected’. 
ArcMap will center the window on element 206.  
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The figure above shows the ArcMap window with one possible location for the ASR well, labeled ‘ASR’. The 
cursor (which does not appear in the figure) is over this well, and the latitude and longitude are visible in the 
lower right. Note the subregion number in red, element boundaries and numbers in grey, river nodes and river 
node numbers in dark blue, and river reaches and river reach numbers in light blue. 

Use the mouse to find the latitude and longitude of a well located near the center of the element. The latitude 
and longitude of the pointer appear in the lower right-hand corner of the ArcMap window. Write the latitude 
and longitude in the table. 

Well Latitude Longitude 

    

When you are finished, your table should be similar to this: 

Well Latitude Longitude 
ASR 39.37 -122.06 

 

Find the  well coordinates in UTM zone 10 

We need to enter the well coordinates into the C2VSim model using the UTM zone 10N coordinate system. 
However, the feature classes in this map document are not projected; that is, they are described in decimal 
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degrees of latitude and longitude. We need to convert the latitude-longitude coordinates to UTM zone 10N 
northing and easting coordinates.  

The file Tools.zip contains an Excel workbook utmconversions.xls, developed by Steve Dutch at the 
University of Wisconsin at Green Bay. This workbook is also available at 
http://www.uwgb.edu/dutchs/usefuldata/utmconversions1.xls. With this workbook, we can convert the well 
coordinates to the format required by the C2VSim model.  

Open the utmconversions.xls workbook and choose the tab ‘Main Page’. The top section, in red and pink, 
will convert latitude and longitude to UTM coordinates. The middle section, in yellow, will convert UTM 
coordinates to latitude and longitude. 

Use this workbook to determine the UTM 10N coordinates of your well. Compare these to the coordinates of 
the ASR well.  

Well Latitude Longitude Easting Northing 

     ASR 39.37 -122.06 580971 4358258 
 

 

Modify C2VSim for the Case Study 

This section shows how to change the C2VSim input files to model the case study. First, the Preprocessor files 
will be modified, and the Preprocessor program will be run. Next, the Simulation files will be modified and the 
Simulation program will be run. Finally, groundwater and surface water hydrographs and Budget output tables 
will be imported to Excel workbooks and analyzed. 

Modify  the C2VSim  Preprocessor  Files 

We need to add the coordinates and screen interval of the new well to the Preprocessor Well Data File. Make 
the following modifications to the files in the folder ASR_Case_Study\ASR_Case\Preprocessor: 

Modify the main Preprocessor Control File 
1) Rename the Preprocessor Control File CVpreproc.in to CVpreproc_ASR.in 
2) Open the file CVpreproc_ASR.in in TextPad 

a) Add a comment line describing the project 
b) Change the title line to describe the project 

Leave this file open in TextPad while we work on the Preprocessor Well Data File.  

http://www.uwgb.edu/dutchs/usefuldata/utmconversions1.xls�
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Add the new pumping well to the Preprocessor Well Data File 
We need to add the well to the Preprocessor Well Data File. We will use the Easting value calculated above as 
the X value and the Northing value as the Y value. PERFTOP and PERFBOT are the altitude in feet of the top 
and bottom of the screened interval. When you add a real well to the model, you will usually use well logs to 
determine the screen interval. For this exercise we are using a fictitious well, so the screen interval is 
arbitrarily chosen. The well radius has no significant impact on the simulation results for this model because 
the element width is much larger than the well radius, so RWELL is set to 1.  

1) Rename the Well Data File CVWells.dat to CVWells_ASR.dat 
2) Open CVWells_ASR.dat in TextPad 

a) Add a comment line describing the project 
b) Increase the value of NWELL by 1 from 133 to 134 
c) Add one line at the bottom of the file with the well descriptions: 

WellID X Y RWELL PERFTOP PERFBOT Comment 
134 580971 4358258 1 -250 -350 / ASR Extraction Well 

 
3) Save and close the file  
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Make changes to file CVpreproc_ASR.in 
Once the CVWells_ASR.dat file has been changed, the names of the input and output files in the 
Preprocessor Control File have to be changed. 

1) Change file name CVWells.dat to CVWells_ASR.dat 
2) Change file name Cvpreout.bin to CVpreout_ASR.bin 
3) Change file name Cvpreproc.in to CVpreproc_ASR.in 
4) Save and close the file  
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Modify the Preprocessor Batch File 
The command to run the Preprocessor program is “PreProcessor3_02.exe CVpreproc_ASR.in”. We generally 
recommend using a batch file to run the IWFM programs. A batch file is provided, but we have to change the 
name of the Preprocessor Control File before we can use it. 

1) Open the file Run_Preprocessor.bat in TextPad 
2) Change the Preprocessor Control File name in Run_Preprocessor.bat to CVpreproc_ASR.in 
3) Save and close the file  

 

 

Run the  C2VSim Preprocessor  Program  

Now we can run the Preprocessor: 

1) Double-click on the file Run_Preprocessor.bat 

The Preprocessor program should run to completion in a few seconds. It creates two files, 
PreprocessorMessages.out and CVpreout_ASR.bin.  

Review the Preprocessor results 
Open the file PreprocessorMessages.out in TextPad and review it. The new well appears in the last two 
tables, the ‘Well Inventory’ and the list of ‘Adjustment Coefficients for Partial Well Penetration’.  

The ‘Well Inventory’ table repeats the X and Y coordinates from the Well Data File. It is generally good 
practice to review this information to assure it is correct. This table also lists the element and subregion each 
well is in. Compare these to the element and subregion we determined using ArcMap. The numbers to the 
right in parentheses indicate how the pumping volume will be apportioned between the nodes of each 
element. 

The ‘Adjustment Coefficients for Partial Well Penetration’ table lists the element and how the pumping volume 
will be apportioned to model layers. These numbers generally do not add up to 1.0, and can be adjusted by 
changing the well perforation interval. 
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Trouble-shooting the Preprocessor program 
If the Preprocessor program does not run to completion, there is probably a typo in one of the modified input 
files. First, see if the program prints out an error message that points to the error. For example, (a) the file 
name in CVpreproc_ASR.in may not be the same as the actual file name, (b) there may be an extra blank 
line in one of the modified files, or (c) there may be missing or extra characters in one of the modified files. 
Check your work and see if you can find and fix the error.  

If you can’t find the reason the program fails, you can use the ‘Compare files’ tool in TextPad to compare each 
of your modified files to the files in the folder ASR_Example_Complete\ASR_Case\Preprocessor. Once you find 
and fix the error, the Preprocessor program will run to completion.  
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Modify  the C2VSim  S imulat ion Files 

Next, we will change the Simulation program input files to incorporate the new pump, a new surface water 
diversion, and changes to an existing surface water diversion. This will involve changing the Simulation 
Control File, Pumping Specification File, Pumping Data File, Diversion Specification File, Diversion Data File 
and Print Specification File. 

Make the following modifications to the files in the folder ASR_Case_Study\ASR_Case\Simulation: 

Modify the Simulation Control File 
1) Rename the Simulation Control File CVsim.in to CVsim_ASR.in 
2) Open the CVsim_ASR.in with TextPad 

a) Add a comment line describing the project 
b) Change the title line to describe the project 
c) Change the name of the Preprocessor output file to CVpreout_ASR.bin, the file created above 

with the Preprocessor. 

 

 

Modify the Pumping Specification File 
One new well was added in the Preprocessor Well Data File. We use the Pumping Specification File to say how 
this well will be used.  

1) Rename the Pumping Specification File from CVPuSp.dat to CVPuSp_ASR.dat 
2) Open CVPuSp_ASR.dat with TextPad 

a) Add a comment line describing the project 
b) Add the new pump to the Pumping Specification File 

The top section of the Pumping Specification File holds information on the wells specified in the 
Preprocessor Well Data File. This includes which column of the Pumping Data File holds the 
pumping volumes for each well, and which land use type and subregion the water is supplied to. 
We will add one row for the new well.  
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i. The first item in each row is the well ID number from the Preprocessor Well Data File. 
ii. The second item is the column of the Pumping Data File associated with each well. We will 

place the pumping rate for the new pump in a new data column in the Pumping Data File. 
The original Pumping Data File has 42 columns of data, so we will use column 43 for the new 
pump. The ICOLWL value is 43 for the new well. 

iii. The third item specifies the land use type the water is delivered to. This is specified by listing 
the appropriate column of the Irrigation Fraction Data File. In the Irrigation Fraction data file 
CVIrFr.dat, column 22 is to deliver 100% to urban use, and column 23 is to deliver 100% to 
agricultural use. The water from the new pump will all go to agricultural use, so the 
ICFIRIWGL value is 23.  

iv. The fourth item specifies the percentage of the pumping value to be extracted from this well. 
FRACWL is 1 (or 100%). 

v. The fifth item specifies the subregion the water will be delivered to. The water will be used 
within the subregion the well is in, so we can set IRGWL to ‘-1’. 

vi. The last three items specify whether the pumping rates will be automatically adjusted at run-
time. We do not want to adjust the pumping rates, so we set ICADJWL to zero. We also have 
to specify values for the last two items (which will be ignored by the program if ICADJWL is 
zero). We will copy values from the second and fourth columns. We set the data column 
containing the maximum pumping rate (ICWLMAX) to the data column containing the 
specified pumping rate (ICOLWL) and the fraction (FWLMAX) to the specified pumping 
fraction (FWLMAX). 

3) Save and close the file CVPuSp_ASR.dat 

The final values are: 

ID ICOLWL ICFIRIWGL FRACWL IRGWL ICADJWL ICWLMAX FWLMAX 
134 43 23 1 -1 0 43 1 

 

And when this is entered in the file it looks like this: 
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Modify the Pumping Data File 
We need to modify the Pumping Data File by adding a data column for the new pump. 

We will add the new pumping rates to the Pumping Data File in three steps. First, we will copy the pumping 
rates from the Pumping Data File to Excel. The pumping data is tab-delimited, and will be automatically 
parsed to columns in the worksheet. Next, we will add three new data columns corresponding to the three 
new wells. Finally, we will copy the modified pumping values from Excel and paste them into the Pumping 
Data File, replacing the old rates. The data from Excel is pasted as tab-delimited text. 

1) Rename the Pumping Data File CVpump.dat to CVpump_ASR.dat 
2) Open the file CVpump_ASR.dat with TextPad 

a) Add a comment line describing the project 
b) Increase the value of NCOLPUMP by one from 42 to 43 

3) Place your cursor in the left-most position of the row with ‘C Column’ (near row 102). 
4) Select everything from here to the end of the file (You can hold down the <Shift> and <Ctrl> keys 

together and press the <End> key) 
5) Cut this text <Ctrl-X> 
6) Open a new Excel workbook 
7) In Excel: 

a) Put the cursor in cell A1 of the first worksheet ‘Sheet1’ and paste the pumping data <Ctrl-V> 
b) Put the cursor in cell B4 and freeze panes with date and header showing 
c) Locate worksheet column AR (data column 43) and color yellow 
d) Add scenario pumping rates for water year 1922 in cells AR4 through AR15. We use negative 

rates to represent groundwater withdrawals from the aquifer. 
i. Type ‘0’ in the rows for October-May (AR4-AR11) 
ii. Type ‘-2’ in the rows for June-August (AR12-AR14)  
iii. Type ‘0’ in the row for September (AR15) 

e) Place the cursor in cell AR16 and type the formula ‘=AR4’ then hit <Return> 
f) Copy this cell to all cells in the block between AR16 and AR1059. This will copy the pumping 

rates for each month of water year 1922 to the same month of each water year from 1923 to 
2009  

g) Copy everything from Excel by placing the cursor in cell A1, then holding down both the 
<Shift>and <Ctrl> keys as you press <Right arrow> and then <Down arrow> to select all of the 
data, then <Ctrl-C> 

h) Switch to CVpump_ASR.dat in TextPad. Your cursor should still be at line 102. 
i) Paste all of the pumping data with <Ctrl-V> 

8) Save and close the file CVpump_ASR.dat 

 

Modify the Diversion Data File 
The Diversion Data File CVDiversions.dat has 265 data columns. Columns 1-246 hold diversion rates for 
diversion 1-246, columns 247-250 are not used (all data is zeroes), columns 251-262 hold bypass rates for 
bypasses 1-12, columns 263-264 are not used (all data zeroes), and column 265 holds a flag ‘-99.0’ that is 
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read when surface water rates are automatically adjusted. We can place the modified diversion rates in the 
unused data columns 247 and 248. 

We will modify the diversion rates for the existing diversion #27, and split it into two new diversion data 
columns #247 and #248. Column #247 will hold the diversion rates for the new aquifer storage area, 1,000 
AF/mo for November-April. Column #248 will hold the old diversion rates, reduced by 2,000 AF/mo for the 
months June-August.  

1) Rename the Diversion Data File from CVDiversions.dat to CVDiversions_ASR.dat 
2) Open CVDiversions_ASR.dat with TextPad 
3) Place the cursor in the left-most position of the row that begins ‘C Diversion No.’ (near row 375) 
4) Select everything from here to the end of the file (You can hold down the <Shift> and <Ctrl> keys 

together and press the <End> key) 
5) Cut this text <Ctrl-X> 
6) Open a new Excel workbook 
7) In Excel: 

a) Put the cursor in cell A1 and paste the diversion rates <Ctrl-V> 
b) Put the cursor in cell B4 and freeze panes with date and header showing 
c) Locate worksheet columns IN and IO (data columns 247 and 248) and color yellow 
d) Add the ASR diversions for water year 1922 to worksheet column IN 

i. Type ‘0’ in the cell for October (IN4) 
ii. Type ‘1’ in the cells for November-April (IN5-IN10) 
iii. Type ‘0’ in the cells for May-September (IN11-IN15) 
iv. Type the formula ‘=IN4’ in cell IN16, then hit <Return> 
v. Copy this cell to the bottom of column IN. This will copy the diversion rates for each month 

of water year 1922 to the same month of each water year from 1923 to 2009. 
e) Place the modified diversion 27 values in worksheet column IO. These values will the original 

diversion less 2,000 AF for June through August, and the original diversion for all other months. 
We can use a complex Excel equation to do this. 

i. The data for diversion 27 is in column AB. Place the cursor in cell IO4, type the formula 
‘=IF(AND(MONTH(A4)>5,MONTH(A4)<9),MAX(AB12-2,0),AB12)’, and press <Return> 
• The function ‘MONTH(A4)’ returns an integer value for the month of the date in cell A4. 

For example, if the value in cell A4 is ‘10/31/1921’, then the formula returns the value 
‘10’ 

• The function AND(MONTH(A4)>5,MONTH(A4)<9) returns ‘1’ if the month is 6, 7 or 8 
(June – August) 

• The IF function uses the equation MAX(AB12-2,0) if the AND returns ‘1’, otherwise it 
uses ‘AB12’. In other words, it returns the original diversion minus 2,000 AF in June – 
August, and the original diversion in all other months. (The rates are in thousand acre-
feet, so ‘2’ represents 2,000 AF. We use the ‘maximum’ formula so we do not divert at a 
negative rate if the original diversion rate is less than 2,000 AF/mo.) 

ii. Copy this cell to the bottom of column IO. 
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f) Copy everything from Excel. Select all the data in the worksheet by placing the cursor in cell A1, 
then holding down the <Shift>and <Ctrl> keys while you press the <Right arrow> key and then 
the <Down arrow> key, then press <Ctrl-C> 

g) Switch to CVDiversions_ASR.dat in TextPad.. 
h) Paste all of the diversion data <Ctrl-V> 

8) Save and close the file CVDiversions_ASR.dat 

 

Modify the Diversion Specification File 
We will modify the specification for diversion #27 to link it to the modified diversion data in column #247 of 
the Diversion Data File. We will also add a new surface water surface water diversion that links the data in 
column #248 of the Diversion Data File to deliveries to a recharge basin. To accomplish this we will make 
some changes to the Diversion Specification File. 

The first change will be to add a new diversion #247. The second change will be to change the diversion data 
column of diversion #27 to point to the new data column in the Diversion Data File that holds the modified 
rates for diversion #27. The third change will be to add the recharge zone for the new diversion. 

1) Rename the Diversion Specification File from CVDivSpec.dat to CVDivSpec_ASR.dat 
2) Open CVDivSpec_ASR.dat with TextPad 

a) Add a comment line describing the project 
b) We will add one diversion, so increase the value of NRDV from 246 to 247 
c) Add the new aquifer storage diversion #247, pointing to diversion data column 247  

i. Find diversion number 27, near row 237 
ii. Copy the four lines of diversion 27, including the comment lines 
iii. Scroll down to diversion number 246, near row 1334.  
iv. Place the cursor below the last line of diversion 246 and paste 
v. Change the comment to describe the ASR diversion 
vi. Change the diversion ID from ‘27’ to ‘247’ 
vii. Change ICOLRL from ‘27’ to ‘247’ and FRACRL to ‘0.95’. This means the recoverable loss 

(ASR recharge) will be 95% of the value in column 247 of the Diversion Data File. 
viii. Change ICOLNL from ‘27’ to ‘247’ and FRACNL to ‘0.05’. This means the non-recoverable 

loss (evaporation loss) will be 5% of the value in column 247 of the Diversion Data File. 
ix. Change ICOLDL from ‘27’ to ‘247’ and FRACDL to ‘0.00’. This means the water delivery will 

be 0% of the value in column 247 of the Diversion Data File, or no water will be delivered. 
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d) Modify diversion #27 to point to column 248 of the Diversion Data File 
i. Find diversion number 27, near row 237 
ii. Copy the line and paste the copy below the existing line 
iii. Put an asterisk ‘*’ in the first character of the top copy to comment it out. This allows us to 

keep a copy of the original diversion specification in the file for future reference. 
iv. In the bottom copy, change the value of each of the items ICOLRL, ICOLNL and ICOLDL from 

‘27’ to ‘248’. This makes the recoverable loss rate, non-recoverable loss rate and diversion 
rate all come from column 248 of the Diversion Data File. 

 

e) Add the recharge zone for new aquifer storage diversion #247  
i. Find the lines that hold the recharge zone definition for diversion #246 (near line 3802 of this 

file) 
ii. Copy the four lines of the diversion #246 recharge zone definition, and paste them below the 

diversion #246 definition 
iii. Modify the definition to represent the recharge zone of ASR diversion #247 

 Change the comment field to describe the ASR diversion 
 Change the diversion ID to ‘247’ 
 Specify 1 element (NRELS = ‘1’), element number 206 (IERELS = ‘206’), and this element 

receives all of the recharge (any number is OK, but it is clearest to use FERELS = ‘1’) 
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f) Save the file CVdivspec_ASR.dat 

 

 

 

Modify the Print Specification File 
The Print Specification File lists the locations of the hydrographs that are printed when the model runs. We will 
add one groundwater hydrograph and one surface water hydrograph to this file. 

1) Rename the Print Specification File CVprint.dat to CVprint_ASR.dat 
2) Open CVprint_ASR.dat with TextPad 
3) Add a comment line describing the project 
4) Add one new groundwater hydrograph at the same location as the new pumping well 

a) Increase the value of NOUTH by 1 from 1387 to 1388 
b) Add the location of the new well in a new row. The first item in each row is IOUTHL, the model 

layer for the hydrograph (1 for the water table), the second item is the X coordinate and the third 
item is the Y coordinate. (You can optionally add an ID and the element number as comments.)  
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5) Add one new surface water hydrograph below the diversion point. Using ArcMap, we see river node 
282 (where the diversion occurs) is co-located with river node 293, and river node 294 is the next 
downstream node. We will print a hydrograph for river node 294. 
a) Increase the value of NOUTR by one from 34 to 35 
b) Add the location of the new hydrograph in a new row. The only required item is the river node 

number IOUTHR. You can optionally add a tag and a comment.  
6) Save and close the file CVprint_ASR.dat 

 

 

 

 

Make changes to file CVsim_ASR.in 
Change the input file names in the Simulation Control File CVsim_ASR.in to match the modified file names 
above. 

1) Change the name of the Pumping Specification File to CVPuSp_ASR.dat 
2) Change the name of the Pumping Data File to CVpump_ASR.dat 
3) Change the name of the Diversion Specification File to CVDivSpec_ASR.dat 
4) Change the name of the Diversion Data File to CVdiversions_ASR.dat 
5) Change the name of the Print Specification File to CVprint_ASR.dat 

Modify the surface water and groundwater hydrograph output file names in the Simulation Control File 
CVsim_ASR.in by adding ‘_ASR’ to the root name.  

6) Change CVSWhyd.out  to CVSWhyd_ASR.out  
7) Change CVGWhyd.out  to CVGWhyd_ASR.out 

In the example below, the comment ‘/** ASR’ has been added to the right of the modified file names in the 
Simulation Control File. 
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Turn the pumping adjustment off. 

8) Near the end of the Simulation Control File, set the value of KOPTDV to ‘00’ 
9) Save and close the file. 

 

 

Modify the Simulation Batch File 
The command to run the Simulation program is “Simulation3_02.exe CVSim_ASR.in”. We have to change the 
name of the Simulation Control File in the batch file before we can use the batch file. 
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1) Open the file Run_Sim.bat in TextPad 
2) Change the Simulation Control File name in Run_Sim.bat to CVSim_ASR.in 
3) Save and close the file  

 

 

Run the  S im ulat ion Program for  the Scenar io  

Now we can run the Simulation program: 

1) Double-click on the file Run_Sim.bat 

The Simulation program should run to completion in a few minutes. It creates two files in the Simulation 
folder, SimulationMessages.out and CVfinallist.out. It also creates a number of files in the Results 
folder, including several files with the .bin extension and several files with the .out extension. The .bin files 
are read by two post-processors, the Budget and Z-Budget programs. The .out files are text files that can be 
opened with TextPad. 

Open the file SimulationMessages.out in TextPad and review it. The first section has the title section from 
the CVSim_ASR.in file, followed by a list of the files that were used in the simulation. This is followed by a 
line stating what components were adjusted in this simulation (surface water diversions and groundwater 
pumping); nothing should be adjusted in this simulation. The remainder of the file lists the solver convergence 
iterations for each time step. The last entry states the model run time. 

Trouble-shooting the Simulation program 
If the Simulation program does not run to completion, there is probably a typo in one of the modified input 
files. First, see if the program prints out an error message that points to the error. For example,  

a) the file name in CVSim_ASR.in may not be the same as the actual file name,  
b) there may be an extra blank line in one of the modified files, or  
c) there may be missing or extra characters in one of the modified files.  

Check your work and see if you can find and fix the error.  

If you can’t find the reason the program won’t run, you can use the ‘Compare files’ tool in TextPad to compare 
each of your modified files to the corresponding files in the folder 
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ASR_Example_Complete\ASR_Case\Simulation. Once you find and fix the error, the Simulation program will 
run to completion. 

 

Run the  Budget  Program  

Switch to the ASR_Case_Study\ASR_Case\Budget folder.  

Open the Budget Control File CVBudget.in file with TextPad. There is a list of binary files with the .bin 
extension starting near line 70. The Budget program reads each of these binary files, and produces a text file 
with the same root name and the .BUD  extension. For example, the Budget program reads the 
..\Results\CVlandwater.bin file and produces the ..\Results\CVlandwater.BUD file. 

 

1) Double-click on the file Run_Budget.bat 

The Budget program should run to completion in less than a minute.  

Switch to the ASR_Case_Study\ASR_Case\Results folder. You should see eight new files with the .BUD 
extension.  

 

Create Budget  Workbooks w ith Excel 

Open Excel 2007 or Excel 2012 to a new, blank worksheet. On the “IWFMTools” menu, use the drop-down 
menu next to “IWFM Version” to select ‘3.02’. 
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A window with the label ‘Budget to Excel (3.02)’ will open. Use the ‘Browse’ button to go to the 
ASR_Case_Study\ASR_Case\Budget directory and select the CVBudget.in file. The available budget files will 
be listed under ‘Choose Budget Table’ in the same order they are listed in the CVBudget.in file.  

 

 

Land and Water Use Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the lower pane of the ‘Budget to Excel (3.02)’ window, select ‘Land and water use budget’, near the bottom 
of the list, and then click the ‘Transfer to Excel’ button. This will add 22 worksheets to the workbook, one for 
each of the 21 model subregions, and one (labeled ‘Subregion 22’) for the entire model area. 

Save the workbook to the ASR_Case_Study directory as ASR_Land_and_Water_Budget.xlsx.  

 

Root Zone Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the ‘Budget to Excel (3.02)’ window, select ‘Root zone budget’ and then click the ‘Transfer to Excel’ button. 
This will add 22 worksheets to the workbook, one for each of the 21 model subregions, and one (labeled 
‘Subregion 22’) for the entire model area. 

Save the workbook to the ASR_Case_Study directory as ASR_Root_Zone_Budget.xlsx.  

 



 C2VSim Hands-On Tutorial  

129 
 

Stream Reach Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the ‘Budget to Excel (3.02)’ window, select ‘Stream reach budget’, near the bottom of the list, and then 
click the ‘Transfer to Excel’ button. This will add 75 worksheets to the workbook, one for each of the 75 
C2VSim river reaches. 

Save the workbook to the ASR_Case_Study directory as ASR_Stream_Reach_Budget.xlsx.  

 

Groundwater Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the ‘Budget to Excel (3.02)’ window, select ‘Groundwater budget’ and then click the ‘Transfer to Excel’ 
button. This will add 22 worksheets to the workbook, one for each of the 21 model subregions, and one 
(labeled ‘Subregion 22’) for the entire model area. 

Save the workbook to the ASR_Case_Study directory as ASR_Groundwater_Budget.xlsx.  

 

Modify the Base Case files 

The easiest way to see the results of the changes in the case study is to compare the scenario results to the 
unchanged base case. We can replace the Print Specification File CVprint.dat in the base case with our 
modified Print Specification File CVprint_ASR.dat. When the Simulation program is run with this Print 
Specification File, groundwater and surface water hydrographs will be created for the new locations specified 
in this file.  Make the following modifications to the files in the folder ASR_Case_Study\Base_Case\Simulation. 

Copy the Print Specification File CVprint_ASR.dat 
Copy the modified Print Specification File CVprint_ASR.dat in the folder 
ASR_Case_Study\ASR_Case\Simulation and paste it into the folder ASR_Case_Study\Base_Case\Simulation.  

Make changes to the Simulation Control File 
Make the following changes to the Simulation Control File in the folder 
ASR_Case_Study\Base_Case\Simulation: 

1) Rename the Simulation Control File CVsim.in to CVsim_base.in 
2) Open CVsim_base.in with TextPad 
3) Change the Print Specification File name to CVprint_ASR.dat 
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Turn the pumping adjustment off. 

4) Near the end of the Simulation Control File, set the value of KOPTDV to ‘00’ 
5) Save and close the file. 

 

 

 

Modify the Simulation Batch File 
The command to run the Simulation program is “Simulation3_02.exe CVSim_ASR.in”. We have to change the 
name of the Simulation Control File in the batch file before we can use the batch file. 

1) Open the file Run_Sim.bat with TextPad 
2) Change the Simulation Control File name in Run_Sim.bat to CVSim_base.in 
3) Save and close the file  
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Run the  S im ulat ion Program for  the Base  Case  

Now we can run the Simulation program: 

1) Double-click on the file Run_Sim.bat 

The Simulation program should run to completion in a few minutes.  

 

Create Budget  Workbooks w ith Excel 

Open Excel 2007 or Excel 2012 to a new, blank worksheet. On the “IWFMTools” menu, use the drop-down 
menu next to “IWFM Version” to select ‘3.02’. 

 

A window with the label ‘Budget to Excel (3.02)’ will open. Use the ‘Browse’ button to go to the 
ASR_Case_Study\Base_Case\Budget directory and select the CVBudget.in file. The available budget files will 
be listed under ‘Choose Budget Table’ in the same order they are listed in the CVBudget.in file.  
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Land and Water Use Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the ‘Budget to Excel (3.02)’ window, select ‘Land and water use budget’, near the bottom of the list, and 
then click the ‘Transfer to Excel’ button. This will add 22 worksheets to the workbook, one for each of the 21 
model subregions, and one (labeled ‘Subregion 22’) for the entire model area. 

Save the workbook to the ASR_Case_Study directory as Base_Land_and_Water_Budget.xlsx.  

 

Root Zone Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the ‘Budget to Excel (3.02)’ window, select ‘Root zone budget’ and then click the ‘Transfer to Excel’ button. 
This will add 22 worksheets to the workbook, one for each of the 21 model subregions, and one (labeled 
‘Subregion 22’) for the entire model area. 

Save the workbook to the ASR_Case_Study directory as Base_Root_Zone_Budget.xlsx.  

 

Stream Reach Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the ‘Budget to Excel (3.02)’ window, select ‘Stream reach budget’, near the bottom of the list, and then 
click the ‘Transfer to Excel’ button. This will add 75 worksheets to the workbook, one for each of the 75 
C2VSim river reaches. 

Save the workbook to the ASR_Case_Study directory as Base_Stream_Reach_Budget.xlsx.  

 

Groundwater Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  
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In the ‘Budget to Excel (3.02)’ window, select ‘Groundwater budget’ and then click the ‘Transfer to Excel’ 
button. This will add 22 worksheets to the workbook, one for each of the 21 model subregions, and one 
(labeled ‘Subregion 22’) for the entire model area. 

Save the workbook to the ASR_Case_Study directory as Base_Groundwater_Budget.xlsx.  

 

Review and Interpret Results 

This section shows how to import hydrograph files to Excel workbooks, and how to compare hydrographs 
between the ASR Case and the Base Case to see the impacts of the three new groundwater pumping wells.  

Create Hydrograph Workbooks w ith Excel 

First, we’ll bring the ASR Case groundwater and surface water hydrograph output into Excel. Then we’ll bring 
in the Base Case hydrographs. Next, we will create new hydrographs of the differences between the ASR Case 
and Base Case hydrographs. In the final step, we will graph these results. 

Start by creating the Excel workbook that will hold all of the results. Open a new Excel workbook, and save it 
in the directory ASR_Case_Study as ASR_Results.xlsx.  

 

ASR Case Groundwater Hydrographs 
First, we will import the groundwater hydrographs of the ASR Case to an Excel worksheet.  

1) Go to the ASR_Case_Study\ASR_Case\Results folder, and open the file CVGWhyd_ASR.out with 
TextPad.  

2) Select all <Ctrl-A> and copy <Ctrl-C> 
3) Switch to the Excel workbook 
4) Put the cursor in cell A1 of tab ‘Sheet1’ and paste <Ctrl-V> 
5) Next, we use ‘Text to Columns’ to put each hydrograph in a separate column 

a) Move the cursor to cell A5 and select all cells in the range A5-A451 by holding the <Ctrl> and 
<Shift> keys and pressing <Down arrow> 

b) With these cells highlighted, go to the ‘Data’ menu and select ‘Text to Columns’. This opens a 
window labeled ‘Convert Text to Columns Wizard – Step 1 of 3’ 

c) Select the radio button next to ‘Fixed Width’, click ‘Next’ and then click ‘Finish’. Now, dates are in 
column A and each groundwater hydrograph is in a separate column. 

6) Next, we can use ‘Find and Replace’ to convert the IWFM time-date code to something Excel can 
recognize.  
a) Use <Ctrl-H> to open the ‘Find and Replace’ panel.  
b) Next to ‘Find what’, enter ‘_24:00’. 
c) Leave the ‘Replace with’ field blank. 
d) Click ‘Replace All’.  
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e) Excel should open an alert showing the number of replacements, and column A should contain 
dates. Close the alert and the ‘Find and Replace’ panel. 

7) Rename the worksheet by double-clicking the tab label ‘Sheet1’ and replacing it with 
‘GWhyd_ASR_Case’ 

8) Put the cursor in cell B8 and go to the ‘View’ menu, select ‘Freeze Panes’, and choose the top item on 
the drop-down menu ‘Freeze Panes’.  

9) Scroll to the right to column BAK to see the three new groundwater hydrograph we added in the Print 
Specification File. 

10) Save the Excel workbook. 

 

 

ASR Case Surface Water Hydrographs  
Next, we will create an Excel worksheet with the surface water hydrographs of the ASR case.  

1) Go to the ASR_Case_Study\ASR_Case\Results folder, and open the file CVSWhyd_ASR.out with 
TextPad.  

2) Select all <Ctrl-A> and copy <Ctrl-C> 
3) Switch to the Excel workbook 
4) Put the cursor in cell A1 of tab ‘Sheet2’ and paste <Ctrl-V> (If there is no blank worksheet, crate one 

by clicking in the small area to the right of the worksheet tabs that shows this symbol: ) 
5) Use ‘Text to Columns’ to put each hydrograph in a separate column 

a) Move the cursor to cell A6 and select all cells in the range A6-A450 by holding the <Ctrl> and 
<Shift> keys and pressing <Down arrow> 

b) With these cells highlighted, go to the ‘Data’ menu and select ‘Text to Columns’. This opens a 
window labeled ‘Convert Text to Columns Wizard – Step 1 of 3’ 

c) Select the radio button next to ‘Fixed Width’, click ‘Next’ and then click ‘Finish’. Now, dates are in 
column A and each surface water hydrograph is in a separate column. 
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6) Next, we can use ‘Find and Replace’ to convert the IWFM time-date code to something Excel can 
recognize.  
a) Use <Ctrl-H> to open the ‘Find and Replace’ panel.  
b) The ‘Find what’ box should still contain ‘_24:00’. If not, enter ‘_24:00’ in the box. 
c) Leave the ‘Replace with’ field blank. 
d) Click ‘Replace All’.  
e) Excel should open an alert showing the number of replacements, and column A should contain 

dates. Close the alert and the ‘Find and Replace’ panel. 
7) Rename the worksheet by double-clicking the tab label ‘Sheet2’ and replacing it with 

‘SWhyd_ASR_Case’ 
8) Put the cursor in cell B7 and go to the ‘View’ menu, select ‘Freeze Panes’, and choose the top item on 

the drop-down menu ‘Freeze Panes’.  
9) Scroll to the right to column AJ to see the new surface water hydrograph we added in the Print 

Specification File. 
10) Save the Excel workbook. 

 

 

Base Case Groundwater Hydrographs 
Now we will add an Excel worksheet with the groundwater hydrographs of the base case.  

1) Go to the ASR_Case_Study\Base_Case\Results folder, and open the file CVGWhyd.out with 
TextPad. 

2) Select all <Ctrl-A> and copy <Ctrl-C> 
3) Switch to the Excel workbook (and create a new worksheet ‘Sheet3’ if needed) 
4) Put the cursor in cell A1 of tab ‘Sheet3’ and paste <Ctrl-V> 
5) Next, we use ‘Text to Columns’ to put each hydrograph in a separate column 
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a) Move the cursor to cell A5 and select all cells in the range A5-A451 by holding the <Ctrl> and 
<Shift> keys and pressing <Down arrow> 

b) With these cells highlighted, go to the ‘Data’ menu and select ‘Text to Columns’. This opens a 
window labeled ‘Convert Text to Columns Wizard – Step 1 of 3’ 

c) Select the radio button next to ‘Fixed Width’, click ‘Next’ and then click ‘Finish’. Now, dates are in 
column A and each groundwater hydrograph is in a separate column. 

6) Next, we can use ‘Find and Replace’ to convert the IWFM time-date code to something Excel can 
recognize.  
a) Use <Ctrl-H> to open the ‘Find and Replace’ panel.  
b) The ‘Find what’ box should still contain ‘_24:00’. If not, enter ‘_24:00’ in the box. 
c) Leave the ‘Replace with’ field blank. 
d) Click ‘Replace All’.  
e) Excel should open an alert showing the number of replacements, and column A should contain 

dates. Close the alert and the ‘Find and Replace’ panel. 
7) Rename the worksheet by double-clicking the tab label ‘Sheet3’ and replacing it with 

‘GWhyd_Base_Case’ 
8) Put the cursor in cell B8 and go to the ‘View’ menu, select ‘Freeze Panes’, and choose the top item on 

the drop-down menu ‘Freeze Panes’.  
9) Scroll to the right to column BAK to see the new groundwater hydrograph we added in the Print 

Specification File. 
10) Save the Excel workbook. 

 

 

Base Case Surface Water Hydrographs  
We can also create an Excel worksheet with the surface water hydrographs of the base case.  
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1) Go to the ASR_Case_Study\ASR_Case\Results folder, and open the file CVSWhyd_ASR.out with 
TextPad.  

2) Select all <Ctrl-A> and copy <Ctrl-C> 
3) Switch to the Excel workbook (and create a new worksheet ‘Sheet4’ if needed) 
4) Put the cursor in cell A1 of tab ‘Sheet4’ and paste <Ctrl-V> 
5) Use ‘Text to Columns’ to put each hydrograph in a separate column 

a) Move the cursor to cell A6 and select all cells in the range A6-A450 by holding the <Ctrl> and 
<Shift> keys and pressing <Down arrow> 

b) With these cells highlighted, go to the ‘Data’ menu and select ‘Text to Columns’. This opens a 
window labeled ‘Convert Text to Columns Wizard – Step 1 of 3’ 

c) Select the radio button next to ‘Fixed Width’, click ‘Next’ and then click ‘Finish’. Now, dates are in 
column A and each surface water hydrograph is in a separate column. 

6) Next, we can use ‘Find and Replace’ to convert the IWFM time-date code to something Excel can 
recognize.  
a) Use <Ctrl-H> to open the ‘Find and Replace’ panel.  
b) The ‘Find what’ box should still contain ‘_24:00’. If not, enter ‘_24:00’ in the box. 
c) Leave the ‘Replace with’ field blank. 
d) Click ‘Replace All’.  
e) Excel should open an alert showing the number of replacements, and column A should contain 

dates. Close the alert and the ‘Find and Replace’ panel. 
7) Rename the worksheet by double-clicking the tab label ‘Sheet4’ and replacing it with 

‘SWhyd_Base_Case’ 
8) Put the cursor in cell B7 and go to the ‘View’ menu, select ‘Freeze Panes’, and choose the top item on 

the drop-down menu ‘Freeze Panes’.  
9) Scroll to the right to columns AJ through AL to see the three new surface water hydrographs we 

added in the Print Specification File. 
10) Save the Excel workbook. 
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Compare  Hydrographs w ith Excel 

We now have an Excel workbook that contains four worksheets. Each worksheet contains one of the 
hydrograph output files from a C2VSim run. The easiest way to see the difference between the Base Case and 
GWP Case is to take the difference between the groundwater hydrographs of the two runs, and the difference 
between the surface water hydrographs of the two runs.  

 

Show Groundwater Head Differences 
We will add a new Excel worksheet, and then use a formula to subtract each ASR Base Case groundwater 
hydrograph from the corresponding ASR Case groundwater hydrograph.  

1) In the ASR_Results.xlsx workbook, create a new worksheet and name it ‘GWHyd_Difference’.  
2) Switch to worksheet ‘GWHyd_ASR_Case’, select all <Ctrl-A> and copy <Ctrl-C> 
3) Switch to worksheet ‘GWHyd_Difference’, place the cursor in cell A1, and paste <Ctrl-V>. This copies 

the structure and values of the ‘GWHyd_ASR_Case’ worksheet. We will keep the structure and 
replace the values with formulas. 

4) We will use an Excel formula to calculate the difference between hydrograph values for each time 
step  
a) Place the cursor in cell B8 of worksheet ‘GWHyd_Difference’. 
b) Enter the ‘=’ sign, and (without hitting any key) select the tab for the ‘GWHyd_ASR_Case’ 

worksheet and place the cursor in cell B8. 
c)  Enter the ‘-’ sign, and (again without hitting any key) select the tab for the ‘GWHyd_Base_Case’ 

worksheet and place the cursor in cell B8. 
d) Hit <Return> 
e) You should have the formula =GWHyd_ASR_Case!B8-GWHyd_Base_Case!B8 in cell B8 of 

the ‘GWHyd_Difference’ worksheet. The cell value should be ‘0’ 
5) Copy the formula through the rest of the ‘GWHyd_Difference’ worksheet 

a) Select cell B8, and copy with <Ctrl-C>. 
b) Select all of the hydrograph cells by holding down the <Shift> key and pressing <Right arrow>, 

the holding sown the <Shift> key and pressing <Down arrow> 
c) Paste the formula with <Ctrl-V> 



 C2VSim Hands-On Tutorial  

139 
 

 

6) Create a graph of the difference between the ASR Case and Base Case for the groundwater 
hydrograph at Well A, in column BAK of the ‘GWHyd_Difference’ worksheet.  
a) Place the cursor in cell BAK8 and use <Shift><Down> to select the cells BAK8 through BAK451 
b) Under the ‘Insert’ menu, select ‘Scatter’ and then ‘Scatter with Straight Lines’. This will place a 

graph in the worksheet. 

 

c) Right-click inside the new graph and select ‘Move Chart…’ to open the ‘Move Chart’ window, 
then select ‘New Sheet’ and name it ‘GWHyd’ 
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The graph shows that the head difference between the ASR Case and Base Case fluctuates between a 
maximum of around 0.6 ft and a minimum of around -0.2 ft. We need to add more information to the graph. 

d) First, we will add dates to the x-axis and a title to the graph. 
i. Use the left mouse button to select the line inside the graph, then use the right mouse button 

to select ‘Select Data…’ 
ii. Click on the ‘Edit…’ button 
iii. Under ‘Series name:’, click the square button on the right, with the red arrow, navigate to the 

‘GWHyd_Difference’ workbook, and select cell BAK6 
iv. Under ‘Series X Values:’, click the square button on the right, with the red arrow, navigate to 

the ‘GWHyd_Difference’ workbook, and select cells A8 through A451 
v. Click on the ‘OK’ button, then click the ‘OK’ button of the ‘Select Data Source’ window 

e. Format the x-axis to be more readable 
i. Right-click on the x-axis and choose ‘Format axis…’ 
ii. We want to set the minimum x-axis value to 10/31/1972 and the maximum value to 

09/30/2009.  
iii. Under ‘Axis Options’, for ‘Minimum’, click the radio button next to ‘Fixed’ and enter the 

numerical value of 10/31/1972, which is ‘26603’ 
iv. For ‘Maximum’, click the radio button next to ‘Fixed’ and enter the numerical value of 

09/30/2009, which is ‘40086’ 
v. For ‘Major Unit’, click the radio button next to ‘Fixed’ and enter ‘365.25’ 
vi. In the left panel, choose ‘Number’, then uncheck the box next to ‘Linked to source’ 
vii. Change the ‘Format Code’ from ‘m/d/yyyy’ to ‘mm/yy’ and then click the ‘Add’ button 
viii. In the left panel, choose ‘Alignment’, and use the drop-down menu next to ‘Text direction’ to 

choose ‘Rotate all text 900’ 
f. Add titles to the axes 

i. Select the ‘Layout’ menu, then ‘Axis Titles’, then ‘Primary Horizontal Axis Title’, then ‘Title 
Below Axis’ 
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ii. Type ‘Month’ and hit <Return> 
iii. Select the ‘Layout’ menu, then ‘Axis Titles’, then ‘Primary Vertical Axis Title’, then ‘Rotated 

Title’ 
iv. Type ‘Head Difference (ft)’ and hit <Return> 

 

 

This groundwater hydrograph is located in the top model layer, directly above the ASR well, which is located 
in the middle model layer. This graph shows that the water table altitude of the ASR Case rises (relative to the 
Base Case) when water is recharged and then falls when groundwater is pumped. In the initial 13 years, the 
ASR Case’s lowest water table altitude each year is slightly higher than the Base Case. However, over the 37-
year simulation, the lowest ASR water table altitude drops below the Base Case water table each year. 

g) We can make a copy of this graph, and use it to focus on several years 
i. Right-click on the tab ‘GWHyd’ and select ‘Move or Copy…’ to open the ‘Move or Copy’ 

window 
ii. Check the box next to ‘Create a copy’ in the lower left, then highlight ‘GWHyd’ in the 

window ‘Before sheet’ and click ‘OK’. This creates a copy called ‘GWHyd (2)’. 
iii. Right-click on the x-axis and choose ‘Format axis…’ 
iv. We want to look at a three-year period, so we will set the minimum x-axis value to 

10/31/1972 and the maximum value to 09/30/1975.  

-0.1 

0 

0.1 

0.2 

0.3 

0.4 

0.5 

0.6 

10/72 
10/73 
10/74 
10/75 
10/76 
10/77 
10/78 
10/79 
10/80 
10/81 
10/82 
10/83 
10/84 
10/85 
10/86 
10/87 
10/88 
10/89 
10/90 
10/91 
10/92 
10/93 
10/94 
10/95 
10/96 
10/97 
10/98 
10/99 
10/00 
10/01 
10/02 
10/03 
10/04 
10/05 
10/06 
10/07 
10/08 

He
ad

 D
iff

er
en

ce
 (f

t)
 

Month 

206 

206 



 C2VSim Hands-On Tutorial  

142 
 

v. Under ‘Axis Options’, for ‘Minimum’, we will keep the numerical value of 10/31/1972, which 
is ‘26603’ 

vi. For ‘Maximum’, we will enter the numerical value of 09/30/1975 is ‘27698’ 
vii. For ‘Major Unit’, click the radio button next to ‘Fixed’ and enter ‘30’ 
viii. Place the cursor over the line, right-click, and select ‘Format data series…’ to open the 

Format Data Series window. 
ix. Select the second item in the left panel, ‘Marker Options’, select the button next to 

‘Automatic’, and then click ‘Close’ in the lower left corner. 

 

Here we can see the monthly difference in groundwater heads between the ASR Case and Base Case for the 
first three years of the simulation. The groundwater head of the ASR Case rises as water is recharged, and 
then falls when the pumps are turned on. This pattern is repeated each year.  

 

Show Surface Water Flow Differences 
We can also use a similar process to create an Excel worksheet and graph to show the difference between 
each ASR Case surface water hydrograph and the corresponding Base Case surface water hydrograph.  

1) In the ASR_Results.xlsx workbook, create a new worksheet and name it ‘SWHyd_Difference’.  
2) Switch to the worksheet ‘SWHyd_ASR_Case’, select all <Ctrl-A> and copy <Ctrl-C> 
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3) Switch to the worksheet ‘SWHyd_Difference’, place the cursor in cell A1, and paste <Ctrl-V>. This 
copies the structure and values of the ‘SWHyd_ASR_Case’ worksheet. We will keep the structure and 
replace the values with formulas. 

4) We will use an Excel formula to calculate the difference between hydrograph values for each time 
step  
a) Place the cursor in cell B7 of worksheet ‘SWHyd_Difference’. 
b) Enter the ‘=’ sign, and (without hitting any key) select the tab for the ‘SWHyd_ASR_Case’ 

worksheet and place the cursor in cell B8. 
c)  Enter the ‘-’ sign, and (again without hitting any key) select the tab for the ‘SWHyd_Base_Case’ 

worksheet and place the cursor in cell B8. 
d) Hit <Return> 
e) You should have the formula =SWhyd_ASR_Case!B7-SWhyd_Base_Case!B7 in cell B8 of 

the ‘GWHyd_Difference’ worksheet. The cell value should be ‘0’ 
5) Copy the formula through the rest of the ‘SWHyd_Difference’ worksheet 

a) Select cell B7, and copy with <Ctrl-C>. 
b) Select all of the hydrograph cells by holding down the <Shift> key and pressing <Right arrow>, 

the holding sown the <Shift> key and pressing <Down arrow> 
c) Paste the formula with <Ctrl-V> 

 

6) Create a graph of the difference between the ASR Case and Base Case for the surface water 
hydrograph at river node 300, near Well A, in column AJ of the ‘SWHyd_Difference’ worksheet.  
a) Place the cursor in cell AJ7 and use <Shift><Down> to select the cells AJ7 through AJ450 
b) Under the ‘Insert’ menu, select ‘Scatter’ and then ‘Scatter with Straight Lines’. This will place a 

graph in the worksheet. 

c) Right-click inside the new graph and select ‘Move Chart…’ to open the ‘Move Chart’ window, 
then select ‘New Sheet’ and name it ‘SWHyd’ 
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The graph shows that ASR Case surface water flows at river node 294 fall and rise in a repeating cycle. We 
need to add more information to the graph and set the range of the x axis. 

d) First, we will add dates to the x-axis and a title to the graph. 
i. Use the left mouse button to select the line inside the graph, then use the right mouse button 

to select ‘Select Data…’ 
ii. Click on the ‘Edit…’ button 
iii. Under ‘Series name:’, click the square button on the right, with the red arrow, navigate to the 

‘GWHyd_Difference’ workbook, and select cell AJ6 
iv. Under ‘Series X Values:’, click the square button on the right, with the red arrow, navigate to 

the ‘GWHyd_Difference’ workbook, and select cells A7 through A450 
v. Click on the ‘OK’ button, then click the ‘OK’ button of the ‘Select Data Source’ window 

e. Format the x-axis to be more readable 
i. Right-click on the x-axis and choose ‘Format axis…’ 
ii. We want to set the minimum x-axis value to 10/31/1972 and the maximum value to 

09/30/2009.  
iii. Under ‘Axis Options’, for ‘Minimum’, click the radio button next to ‘Fixed’ and enter the 

numerical value of 10/31/1972, which is ‘26603’ 
iv. For ‘Maximum’, click the radio button next to ‘Fixed’ and enter the numerical value of 

09/30/2009, which is ‘40086’ 
v. For ‘Major Unit’, click the radio button next to ‘Fixed’ and enter ‘365.25’ 
vi. In the left panel, choose ‘Number’, then uncheck the box next to ‘Linked to source’ 
vii. Change the ‘Format Code’ from ‘m/d/yyyy’ to ‘mm/yy’ and then click the ‘Add’ button 
viii. In the left panel, choose ‘Alignment’, and use the drop-down menu next to ‘Text direction’ to 

choose ‘Rotate all text 900’ 
f. Add titles to the axes 

i. Select the ‘Layout’ menu, then ‘Axis Titles’, then ‘Primary Horizontal Axis Title’, then ‘Title 
Below Axis’ 
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ii. Type ‘Month’ and hit <Return> 
iii. Select the ‘Layout’ menu, then ‘Axis Titles’, then ‘Primary Vertical Axis Title’, then ‘Rotated 

Title’ 
iv. Type ‘Flow Difference (AF/mo)’ and hit <Return> 

 

 

This surface water hydrograph at river node 294, downstream from the ASR well and diversion, shows that 
river flow under the ASR Case fluctuates in a fairly regular cycle that repeats each year of the simulation. The 
ASR Case river flow is approximately 700-800 AF/mo lower than Base Case river flow for several months, then 
rises to 1,600-1,700 AF/mo greater than Base Case flows for several months. The cycle repeats each year, and 
appears to be very stable, suggesting it is insensitive to wet and dry periods. 

g. We can make a copy of this graph, and use it to focus on several years, as we did with the 
groundwater hydrograph 

i. Right-click on the tab ‘Chart2’ and select ‘Move or Copy…’ to open the ‘Move or Copy’ 
window 

ii. Check the box next to ‘Create a copy’ in the lower left, then highlight ‘SWHyd’ in the window 
‘Before sheet’ and click ‘OK’. This creates a copy called ‘SWHyd (2)’. 

iii. Right-click on the x-axis and choose ‘Format axis…’ 
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iv. We want to look at a three-year period, so we will set the minimum x-axis value to 
10/31/1972 and the maximum value to 09/30/1975.  

v. Under ‘Axis Options’, for ‘Minimum’, we will keep the numerical value of 10/31/1972, which 
is ‘26603’ 

vi. For ‘Maximum’, we will enter the numerical value of 09/30/1975 is ‘27698’ 
vii. For ‘Major Unit’, click the radio button next to ‘Fixed’ and enter ‘30’ 
viii. Place the cursor over the line, right-click, and select ‘Format data series…’ to open the 

Format Data Series window. 
ix. Select the second item in the left panel, ‘Marker Options’, select the button next to 

‘Automatic’, and then click ‘Close’ in the lower left corner. 

 

This graph shows the monthly river flow differences between the ASR Case and Base Case for the first three 
years of the simulation. Although 1,000 AF/mo is diverted from the river at river node 280 each month from 
November through April, the river flow drops by only about 700-800 AF/mo. We might guess that the 
recharged groundwater raises the local groundwater heads adjacent to the river, which in turn increases 
groundwater discharges to the river by 200-300 AF/mo, somewhat offsetting the diversion. In the next section, 
we will use the Groundwater Budget to see if this is true.  

The graph also shows that ASR Case river flows are significantly higher than Base Case flows during the three 
months that the groundwater pumps are operating. This is an important finding if our goal was to increase 

-1000 

-500 

0 

500 

1000 

1500 

2000 

10/31/72 
11/30/72 
12/30/72 
1/29/73 
2/28/73 
3/30/73 
4/29/73 
5/29/73 
6/28/73 
7/28/73 
8/27/73 
9/26/73 
10/26/73 
11/25/73 
12/25/73 
1/24/74 
2/23/74 
3/25/74 
4/24/74 
5/24/74 
6/23/74 
7/23/74 
8/22/74 
9/21/74 
10/21/74 
11/20/74 
12/20/74 
1/19/75 
2/18/75 
3/20/75 
4/19/75 
5/19/75 
6/18/75 
7/18/75 
8/17/75 
9/16/75 
10/16/75 

294 

294 



 C2VSim Hands-On Tutorial  

147 
 

summer flows by implementing the ASR program. However, we can see that reducing summer diversions by 
2,000 AF/mo only resulted in flow increases of 1,500-1,700 AF/mo, or 75-85%.  

We can also plot the difference in river flows in the Sacramento River at Freeport (river node 384, in column L 
of the worksheet). 

 

This graph shows that project changes in Sacramento River discharges to the Sacramento-San Joaquin Delta 
closely mirror the changes in flows at river node 294. 

 

Compare  Budget  Tab les 

The graphs of project impacts on groundwater heads and stream flows above can help us identify the broad 
impacts of the project. We can then use the detailed Budget tables to compare differences in individual flow 
terms to gain a better understanding of project impacts. In this section, we will compare GWP Case and Base 
Case Budget tables for the Land and Water Use, Root Zone, Groundwater, and Stream Reach Budgets. 

This project simulated an aquifer storage and recovery project in Subregion 3, so we will review the Land and 
Water Use, Root Zone and Groundwater budgets for Subregion 3, and the Stream Reach budget for reach 51. 
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Compare Land and Water Use Budgets for Subregion 3 
The ASR Case replaces 2,000 AF/mo of surface water with groundwater for the months June through August. 
We can see the impact of this by comparing the Land and Water Use Budget tables for Subregion 3. 

1) Open the two Excel workbooks Base_Land_and_Water_Budget.xlsx and 
ASR_Land_and_Water_Budget.xlsx.  

2) Create a new Excel ASR_Land_and_Water_Compare.xlsx and save it in the folder 
ASR_Case_Study.  

3) Rename the worksheet ‘Sheet1’ to ‘Land Water SR3’. 
4) We want to copy the format (dates, column titles, etc) of the Groundwater Budget tables to the 

worksheet of the new workbook. Go to (for example) tab ‘Subregion 3 (DSA 12)’ of 
ASR_Land_and_Water_Budget.xlsx. Click in the box in the upper left, above row label ‘1’ and to 
the left of column label ‘A’. This will select the entire worksheet. Use <Ctrl-C> to copy the column. 

5) Go to tab ‘Land Water SR3’ of ASR_Land_and_Water_Compare.xlsx and put the cursor in cell 
A1. Use <Ctrl-V> to paste the contents of worksheet ‘Subregion 3 (DSA 12)’. 

6) Format the column headers 
a) Click on the box with ‘5’ on the left side of the workbook to select the row 
b) Use <Ctrl-1> to open the ‘Format Cells’ panel 
c) Select the ‘Alignment’ tab 
d) Use the drop-down menu under ‘Horizontal’ to select ‘Center’ 
e) Use the drop-down menu under ‘Vertical’ to select ‘Center’ 
f) Check the box next to ‘Wrap text’ 
g) Click ‘OK’ to close the panel 

 

7) Next we want to replace the values in this worksheet with formulas to calculate the difference 
between the ASR Case and Base Case for Subregion 3.  
a) Place the cursor in cell B6 (to the right of date 10/31/1972) and press ‘=’ to start a new formula.  
b) Without hitting return or touching anything else with the cursor, select the ‘View’ menu and use 

the ‘Switch Windows’ button to choose the Base_Land_and_Water_Budget.xlsx workbook.  
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c) Go to the tab labeled ‘Subregion 3 (DSA 12)’.  
d) Place the cursor in cell B6, then hit the <F4> key three times to remove the ‘$’ signs in the 

formula.  
e) Type the minus sign ‘-‘.  
f) Again, without hitting return or touching anything else with the cursor, select the ‘View’ menu 

and use the ‘Switch Windows’ button to choose the ASR_Land_and_Water_Budget.xlsx 
workbook.  

g) Go to the tab labeled ‘Subregion 3 (DSA 12)’.  
h) Place the cursor in cell B6, then hit the <F4> key three times to remove the ‘$’ signs in the 

formula.  
i) Hit the return key.  

The cell formula should be ='[ASR_Land_and_Water_Budget .x lsx]Subregion 3 (DSA 12)'!B6-
'[Base_Land_and_Water_Budget.xlsx]Subregion 3 (DSA 12)'!B6. The cell value should be close to 
zero. 

8) Next, we will copy this formula to all the cells in the budget table.  
a) Place the cursor in cell B6 and then move the cursor over the small black square that appears in 

the lower right corner of the cell so the cursor changes to a black plus sign. Double-click on the 
black square to copy the formulas down column B to the end of the column.  

b) Then use <Ctrl-C> to copy the formulas in this column, <Ctrl><Shift><Right> to select the other 
cells in the budget table, and <Ctrl-V> to paste the formula. 

 

Review the Differences 
The Land and Water Use Budget reports the monthly balance between water demand and water supply. We 
can visually see the major differences between the ASR Case and the Base Case. First, we can see the 
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increased pumping rates of the ASR Case in column E, which is labeled ‘Ag. Pumping (+)’. The difference in 
groundwater supply between the two cases is ‘0.00’ for October 1972 through May 1973, ‘2000.01’ for June 
through August 1973, and ‘0.00’ for September 1973. These values are than repeated each year through 2009.  

Next, the reduced surface water supply is in column F, labeled ‘Ag. Diversion (+)’. The difference in available 
surface water is ‘0.00’ for October 1972 through May 1973, ‘-1760.01’ for June, ‘-1674.88’ for July, ‘-1759.37’ 
for August, and ‘0.00’ for September. Similar values are than repeated each year through 2009. The values of -
1,675 to -1,760 AF/mo represent a 2,000 AF/mo reduction in the amount diverted from the river, after 
incorporating recoverable and non-recoverable losses associated with the delivery system. It also appears that 
July river flows may have been insufficient to supply the entire diversion amount under the Base Case.  

When we designed this case study, we expected to replace a 2,000 AF/mo surface water diversion with 2,000 
AF/mo of groundwater. However, owing to the delivery losses that accompany the surface water diversion, we 
are actually supplying additional water, a surplus of supply over demand, which shows up as negative values 
in column G ‘Ag. Shortage’. We will use the Root Zone Budget to see where this additional water goes. 

 

Compare Root Zone Budgets for Subregion 5 
The Root Zone Budget provides details of the monthly water inflows and outflow of the land surface process. 
It shows how changes in water availability affect root-zone water storage, return flows and deep percolation. 
We will compare the ASR Case and Base Case Root Zone Budget tables for Subregion 3. 

1) Open the two Excel workbooks Base_Root_Zone_Budget.xlsx and 
ASR_Root_Zone_Budget.xlsx.  

2) Create a new Excel workbook ASR_Root_Zone_Compare.xlsx and save it in the folder 
ASR_Case_Study.  

3) Rename the worksheet ‘Sheet1’ to ‘Root Zone SR3’. 
4) We want to copy the format (dates, column titles, etc) of the Groundwater Budget tables to the 

worksheet of the new workbook. Go to (for example) tab ‘Subregion 3 (DSA 12)’ of 
ASR_Root_Zone_Budget.xlsx. Click in the box in the upper left, above row label ‘1’ and to the 
left of column label ‘A’. This will select the entire worksheet. Use <Ctrl-C> to copy the column. 

5) Go to tab ‘Root Zone SR3’ of ASR_Root_Zone_Compare.xlsx and put the cursor in cell A1. Use 
<Ctrl-V> to paste the contents of worksheet ‘Subregion 3 (DSA 12)’. 

6) Format the column headers 
a) Click on the box with ‘5’ on the left side of the workbook to select the row 
b) Use <Ctrl-1> to open the ‘Format Cells’ panel 
c) Select the ‘Alignment’ tab 
d) Use the drop-down menu under ‘Horizontal’ to select ‘Center’ 
e) Use the drop-down menu under ‘Vertical’ to select ‘Center’ 
f) Check the box next to ‘Wrap text’ 
g) Click ‘OK’ to close the panel 

7) Next we want to calculate the difference between the ASR Case and Base Case for subregion 3.  
a) Place the cursor in cell B5 (to the right of date 10/31/1972) and press ‘=’ to start a new formula.  
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b) Without hitting return or touching anything else with the cursor, select the ‘View’ menu and use 
the ‘Switch Windows’ button to choose the Base_Root_Zone_Budget.xlsx workbook.  

c) Go to the tab labeled ‘Subregion 3 (DSA 12)’.  
d) Place the cursor in cell B6, then hit the <F4> key three times to remove the ‘$’ signs in the 

formula.  
e) Type the minus sign ‘-‘.  
f) Again, without hitting return or touching anything else with the cursor, select the ‘View’ menu 

and use the ‘Switch Windows’ button to choose the ASR_Root_Zone_Budget.xlsx workbook.  
g) Go to the tab labeled ‘Subregion 3 (DSA 12)’.  
h) Place the cursor in cell B6, then hit the <F4> key three times to remove the ‘$’ signs in the 

formula.  
i) Hit the return key.  

The cell formula should be ='[ASR_Root_Zone_Budget.x lsx]Subregion 3 (DSA 12)’!B6-
'[Base_Root_Zone_Budget .x lsx]Subregion 3 (DSA 12)’!B6. The cell value should be close to zero. 

8) Next, we will copy this formula to all the cells in the budget table.  
a) Place the cursor in cell B6 and then move the cursor over the small black square that appears in 

the lower right corner of the cell so the cursor changes to a black plus sign. Double-click on the 
black square to copy the formulas down column B to the end of the column.  

b) Then use <Ctrl-C> to copy the formulas in this column, <Ctrl><Shift><Right> to select the other 
cells in the budget table, and <Ctrl-V> to paste the formula. 
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Review the Differences 
The surplus supply from the Land and Water Use Budget shows up in column E, labeled ‘Ag. Prime Applied 
Water’. The values in this column are identical to the values in the ‘Ag. Shortage’ column of the Land and 
Water Use Budget, multiplied by -1. This represents the increase in available water for the ASR Case versus the 
Base Case.  

This additional water results in an increase in return flows to the river (column H, ‘Ag. Return Flow’) and 
infiltration (column K, ‘Ag. Infiltration’). The increase in return flow and infiltration equals the increase in 
prime applied water. The increased infiltration, in turn, results in an identical increase in deep percolation 
(column M). This increase in return flows is probably partly responsible for the increased river flows in the 
summer months, noted in the surface water hydrographs above. 

 

Compare Groundwater Budgets for Subregion 3 
The groundwater system for the ASR Case experiences two changes relative to the Base Case. First, 1,000 
AF/mo is directly recharged in the months of November through April, and second, an additional 2,000 AF/mo 
of groundwater is pumped in the months of June through August. We also guessed that changes in 
groundwater discharges to the rivers may be partly responsible for the fact that diverting an additional 1,000 
AF/mo from the river causes only a 700-800 AF/mo drop in flows.  

We can see the impact of the increased recharge and pumping on the groundwater aquifer by comparing the 
Groundwater Budget tables for one or more subregions between the ASR Case and Base Case. The ASR 
project is located in model subregion 3, so we will compare the Groundwater Budget tables for the two cases 
for this subregion. 

1) Open the two Excel workbooks Base_Groundwater_Budget.xlsx and 
ASR_Groundwater_Budget.xlsx.  

2) Create a new Excel workbook ASR_Groundwater_Compare.xlsx and save it in the folder 
ASR_Case_Study.  

3) Rename the worksheet ‘Sheet1’ to ‘Groundwater SR3’. 
4) We want to copy the format (dates, column titles, etc) of the Groundwater Budget tables to the 

worksheet of the new workbook. Go to (for example) tab ‘Subregion 3 (DSA 12)’ of 
ASR_Groundwater_Budget.xlsx. Click in the box in the upper left, above row label ‘1’ and to the 
left of column label ‘A’. This will select the entire worksheet. Use <Ctrl-C> to copy the column. 

5) Go to tab ‘Groundwater SR3’ of ASR_Groundwater_Compare.xlsx and put the cursor in cell A1. 
Use <Ctrl-V> to paste the contents of worksheet ‘Subregion 3 (DSA 12)’. 

6) Format the column headers 
a) Click on the box with ‘5’ on the left side of the workbook to select the row 
b) Use <Ctrl-1> to open the ‘Format Cells’ panel 
c) Select the ‘Alignment’ tab 
d) Use the drop-down menu under ‘Horizontal’ to select ‘Center’ 
e) Use the drop-down menu under ‘Vertical’ to select ‘Center’ 
f) Check the box next to ‘Wrap text’ 
g) Click ‘OK’ to close the panel 
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7) Next we want to calculate the difference between the ASR Case and Base Case for subregion 3.  
a) Place the cursor in cell B5 (to the right of date 10/31/1972) and press ‘=’ to start a new formula.  
b) Without hitting return or touching anything else with the cursor, select the ‘View’ menu and use 

the ‘Switch Windows’ button to choose the Base_Groundwater_Budget.xlsx workbook.  
c) Go to the tab labeled ‘Subregion 3 (DSA 12)’.  
d) Place the cursor in cell B6, then hit the <F4> key three times to remove the ‘$’ signs in the 

formula.  
e) Type the minus sign ‘-‘.  
f) Again, without hitting return or touching anything else with the cursor, select the ‘View’ menu 

and use the ‘Switch Windows’ button to choose the ASR_Groundwater_Budget.xlsx 
workbook.  

g) Go to the tab labeled ‘Subregion 3 (DSA 12)’.  
h) Place the cursor in cell B6, then hit the <F4> key three times to remove the ‘$’ signs in the 

formula.  
i) Hit the return key.  

The cell formula should be ='[ASR_Groundwater_Budget .xlsx]Subregion 3 (DSA 12)'!B6-
'[Base_Groundwater_Budget .xlsx]Subregion 3 (DSA 12)'!B6. The cell value should be close to zero. 

8) Next, we will copy this formula to all the cells in the budget table.  
a) Place the cursor in cell B6 and then move the cursor over the small black square that appears in 

the lower right corner of the cell so the cursor changes to a black plus sign. Double-click on the 
black square to copy the formulas down column B to the end of the column.  

b) Then use <Ctrl-C> to copy the formulas in this column, <Ctrl><Shift><Right> to select the other 
cells in the budget table, and <Ctrl-V> to paste the formula. 

 

Review the Differences 
The differences between the ASR Case and Base Case appear in the second month of the simulation, 
November 1972. In this month, an additional 1,000 AF are diverted from the river and applied to the recharge 
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basin. Column G, ‘Recharge (+)’, shows the additional ASR recharge of 950 AF (the 1,000 AF diverted minus 
50 AF of non-recoverable losses). This additional water is balanced by changes in column D ‘Ending Storage (-
)’, column F ‘Gain from Stream (+)’, column J ‘Subsidence (+)’, and column N ‘Net Subsurface Inflow (+)’. The 
rise in the water table altitude results in a flow of 585.55 AF into groundwater storage, and elastic recovery 
from subsidence results in the flow of an additional 0.33 AF into groundwater storage. Groundwater 
discharges to streams increase by 137.64 AF (this column holds flows from the stream to the groundwater; a 
negative value indicates the flow direction is from the groundwater to the stream). The remaining 246.49 AF 
flows to adjacent subregions (again, the negative sign indicates flow out of the subregion). Over the months 
of December through April 1973, the recharge basin receives 1,000 AF/mo, 950 AF/mo recharges, and this 
results in continued flows to streams and adjacent subregions and increased groundwater storage. The 
recharge basin does not operate in May 1973, and there is a small decrease in groundwater storage and a 
reduction in flows to streams and adjacent subregions. 

Groundwater pumping begins in June 1973, and the pumping rate appears in column M ‘Pumping (-)’. This is 
accompanied by a small reduction in recharge; the reduced surface water diversion is accompanied by a 
proportionate reduction in recoverable losses. The 2,000 AF pumped from the aquifer is offset by inflow from 
groundwater storage, and reductions in groundwater flows to streams and flows to adjacent subregions. This 
is repeated in July and August, as water is withdrawn from the aquifer. By the end of August 1973, the ASR 
project has reduced groundwater storage by 1,059 AF below the Base Case storage. 

Excel allows us to quickly sum the values in a block without writing a formula. Select cells F6 through F16 
(gain from stream from October 1972 through August 1973). The bar at the bottom of the Excel window 
shows several properties of the number in the highlighted block, including the sum, minimum, maximum, 
count and average. 

 

We can see that under the ASR Case, an additional 585.82 AF of water exited the aquifer and flowed into the 
river versus the Base Case. This represents nearly 10% of the water diverted from the river. Highlighting cells 
N6 through N16 shows a net flow of 366.90 AF from adjacent subregions. Highlighting cells E6 through E16 
shows that diverting 6,000 AF of surface water to the recharge basin results in a net increase in recharge of 
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5,105.10 AF. The remaining 895 AF is due to a combination of evaporative losses in the recharge operation 
and the removal of the summer diversion’s seepage losses. 

 

Create a Water Year Summary 
We can use the ‘WY-Month’ tool on the ‘IWFM Tools’ menu to see the differences between the ASR Case and 
the Base Case for each flow term. We will demonstrate this by looking at the changes in ending groundwater 
storage, labeled ‘Ending Storage (-)’, in column D. 

Under the ‘IWFM Tools’ menu, select ‘WY-Month’ to open the ‘WY-Month’ panel.  

1) Place the cursor in the ‘Date Range’ area and select the dates from column A, cells A6 to A449.  
2) Place the cursor in the ‘Time Series Data Range’ area and select the data values from column D, cells 

D6 to D449.  
3) Put the cursor in the ‘Output range’ area and select cell S5.  
4) In the ‘Unit Conversion’ section, click next to ‘AF’ under ‘Time Series Data’ and ‘TAF’ under ‘Table’. 
5) At the bottom of the WY-Month panel, click the boxes next to the graphs for monthly averages and 

annual totals 
6) Click ‘OK’ to create the table.  

 

This will produce a table with the monthly difference in ending groundwater storage between the two cases 
for subregion 3, with total annual difference in the right-most column. Average, minimum and maximum 
values are listed at the bottom of this table.  

Two graphs are also produced, to the right of the Water Year-Month table.  
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The top graph shows the average monthly difference in groundwater storage between the two scenarios over 
the entire simulation period. This graph shows that the ASR project results in the net removal of water from 
groundwater storage. As we showed above, the ASR project resulted in increases in groundwater flows to 
streams and in net subsurface flows to adjacent subregions. Thus when groundwater pumping commenced in 
the summer, some of the recharged water was not available for extraction. Over time, these increased 
discharges to rivers and horizontal flows result in a net loss of water from storage. The groundwater storage 
recovers during the winter months at a rate below the recharge rate of 1,000 AF/mo, and declines in June 
through August at a rate below the pumping rate of 2,000 AF/mo.  

 

 

The lower graph shows that the ASR project leads to a long-term, relatively steady but also very small decline 
in groundwater storage. The decline in groundwater storage does not level off, even after 37 years. The 
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annual rate of decline is probably insignificant, but this is a very small project and these losses could be 
important for a larger project.  

 

Compare Stream Reach Budgets for Reach 51 
We used the difference between the ASR and Base case stream flow hydrographs to show the change in 
stream flows at specific locations. We can use the Stream Reach Budget to show impacts on individual flow 
terms. The ASR project modified a diversion on reach 51, so we will investigate the impact of the ASR project 
on stream flow terms in this reach. 

1) Open the two Excel workbooks Base_Stream_Reach_Budget.xlsx and 
ASR_Stream_Reach_Budget.xlsx.  

2) Create a new Excel workbook and save it in directory ASR_Case_Study with the name 
ASR_Stream_Reach_Compare.xlsx.  

3) Rename the worksheet ‘Sheet1’ to ‘Stream reaches’. 
4) We want to copy the format (dates, column titles, etc) of the Stream Reach Budget tables to the 

worksheet of the new workbook. Go to the tab ‘Stream reach 51’ of 
ASR_Stream_Reach_Budget.xlsx. Click in the box in the upper left, above row label ‘1’ and to 
the left of column label ‘A’. This will select the entire worksheet. Use <Ctrl-C> to copy the column. 

5) Go to tab ‘Sheet1’ of ASR_Stream_Reach_Compare.xlsx and put the cursor in cell A1. Use <Ctrl-
V> to paste the contents of worksheet ‘Stream reaches’. 

6) Format the column headers 
a) Click on the box with ‘5’ on the left side of the workbook to select the row 
b) Use <Ctrl-1> to open the ‘Format Cells’ panel 
c) Select the ‘Alignment’ tab 
d) Use the drop-down menu under ‘Horizontal’ to select ‘Center’ 
e) Use the drop-down menu under ‘Vertical’ to select ‘Center’ 
f) Check the box next to ‘Wrap text’ 
g) Click ‘OK’ to close the panel 
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7) Next we want to calculate the difference between the ASR Case and Base Case for river reach 51.  
a) Place the cursor in cell B5 (to the right of date 10/31/1972) and type ‘=’  
b) Without hitting return or touching anything else with the cursor, select the ‘View’ menu and use 

the ‘Switch Windows’ button to choose the ASR_Stream_Reach_Budget.xlsx workbook.  
c) Go to the tab labeled ‘Stream reach 51’. Place the cursor in cell B5, then hit the <F4> key three 

times to remove the ‘$’ signs in the formula 
d) Type the minus sign ‘-‘  
e) Again, without hitting return or touching anything else with the cursor, select the ‘View’ menu 

and use the ‘Switch Windows’ button to choose the Base_Stream_Reach_Budget.xlsx 
workbook.  

f) Go to the tab labeled ‘Stream reach 51’. Place the cursor in cell B5, then hit the <F4> key three 
times to remove the ‘$’ signs in the formula 

g) Hit the return key.  

The cell formula should be ='[ASR_Stream_Reach_Budget .xlsx]Stream reach 51'!B5-
'[Base_Stream_Reach_Budget .xlsx]Stream reach 51'!B5. The cell value should be zero.  

8) Next, we will copy this formula to all the cells in the budget table.  
a) Place the cursor in cell B5 and then move the cursor over the small black square that appears in 

the lower right corner of the cell so the cursor changes to a black plus sign. Double-click on the 
black square to copy the formulas down column B to the end of the column.  

b) Then use <Ctrl-C> to copy the formulas in this column, <Ctrl><Shift><Right> to select the other 
cells in the budget table, and <Ctrl-V> to paste the formula. 
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The cell values should be zeroes for the first month. Some values should change to non-zero numbers in the 
second month when the two scenarios change.  

We can see several differences between the ASR Case and Base Case in the first year. First, note that the 
values in the column labeled ‘Diversion (-)’ are the values we expect to see: we increased the diversion rate by 
1,000 AF/mo for November through April, and decreased the diversion rate by 2,000 AF/mo for June through 
August. We also see that the groundwater discharge to the stream (‘Gain from Groundwater (+)’) mirrors the 
flow direction of the values from the Groundwater Budget. The rates are less than the totals in the other 
budget tables because the impacts are spread among multiple river reaches. 

Also, note the small positive changes for some months in ‘Upstream Inflow (+)’. This indicates the ASR Case 
has increased stream flow in upstream reaches versus the Base Case. These increased flows are probably due 
to some combination of increases in both groundwater discharges and return flows to these streams as a 
result of the ASR project.  

Review the Differences 
We can use the ‘WY-Month’ tool on the ‘IWFM Tools’ menu to see more closely analyze the differences 
between the ASR Case and the Base Case. We will use the change in downstream outflows (column C, 
‘Downstream Outflow (-)’) as an example. 

Under the ‘IWFM Tools’ menu, select ‘WY-Month’ to open the ‘WY-Month’ panel.  

1) Place the cursor in the ‘Date Range’ area and select the dates from column A, cells A5 to A448.  
2) Place the cursor in the ‘Time Series Data Range’ area and select the data values from column C, cells 

C5 to C448.  
3) Put the cursor in the ‘Output range’ area and select cell P5.  
4) In the ‘Unit Conversion’ section, click next to ‘AF’ under ‘Time Series Data’ and ‘TAF’ under ‘Table’. 
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5) At the bottom of the WY-Month panel, click the boxes next to the graphs for monthly averages and 
annual totals, and click ‘OK’.  

 

This will produce a table with the monthly difference in surface water diversions between the two cases for 
river reach 51. The total annual difference is in the right-most column, and the monthly average, minimum 
and maximum are in rows at the bottom of the table. 

 

Two graphs are also produced, to the right of the Water Year-Month table. The top graph shows the average 
monthly difference in downstream outflows between the two scenarios. Increasing surface water diversions 1 
TAF/mo for November through April results in reductions in downstream outflows of approximately 750-800 
AF/mo, and reducing surface water diversions 2 AF/mo for June through August increases downstream 
outflows by approximately 1.5-1.6 TAF/mo.  
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 The lower graph shows the difference in annual downstream outflows between the two cases. Annual 
outflows are greater in the first few years, but then decline through time, never appearing to reach a stable 
value. The total decline is only approximately 400 AF/yr after 37 years. 

 

 

Summary 

This scenario demonstrates how we can use the C2VSim model to explore the complex hydrologic interactions 
within the Central Valley’s integrated land surface, groundwater and surface water flow system. At first 
glance, the ASR Case appears to be a simple project, storing water in the ground during the winter and 
withdrawing it in the summer. However, this analysis shows that the recharged water does not sit still. It 
moves around, and it cannot simply be recaptured in the summer. The recharged water displaces water in the 
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aquifer, forcing it to flow laterally where it may discharge into a river or flow out of the reach of the project 
pumps. 

This scenario could be modified to gage the sensitivity of the hydrologic system to other project 
configurations. Screening the well in the confined portion of the aquifer (model layer 2) may lead to greater 
vertical groundwater flow, reducing discharges to streams. Locating the recharge basin a greater distance 
from the river may also reduce discharge to streams. One of the strengths of C2VSim is the ability to quickly 
model several potential project configurations to facilitate choosing the configuration that best meets overall 
program objectives. 
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Scenar io 3 − GST: Groundwater-Subst itut ion Water  Transfer  

Description:  This is a fictional case study of a groundwater-substitution water transfer project. A surface 
water diversion from the Sacramento River will be reduced by 2,000 AF/mo for the three months June through 
August. The project proponent wants to transfer this water to a buyer located south of the Sacramento-San 
Joaquin Delta. The project proponent will also pump groundwater to replace this surface water. A new well 
will be added to the C2VSim model that will run for the three months June through August. We want to use 
the C2VSim model to estimate how this project changes in-stream flows, and specifically how much of this 
2,000 AF/mo flows past the Sacramento River at Freeport gage and is available for transfer.  

This example will show how to modify the Diversion Specification File and Diversion Data File to add a surface 
water diversion; how to modify the Well Specification File, Pumping Specification File and Pumping Data File 
to add a new well; and how to analyze simulation results. This scenario will modify diversion #28 at River 
Node 331 on the Sacramento River south of the Colusa Basin Drain, which delivers water to Subregion 4 for 
agricultural use. The surface water diversion volume will be reduced by 2,000 AF/mo for June through August. 
A pump will be placed in Subregion 4, and water will be pumped for June through August for agricultural use. 

 

Initial Steps 

The first steps are to set up the project folders, and identify the coordinates of the new pumping wells and 
nearby river nodes. 

Set  up the project  fo lders 

The first step is to create folders for the groundwater-substitution water transfer scenario and the unmodified 
base case.  

1) Create a folder in a convenient place (such as the top directory of the D: drive) called 
GST_Case_Study. This folder will hold subfolders with two versions of the model – one for the case 
study and one for the unmodified base case. 

2) Copy the folder C2VSim_CG_1972IC_R369 into the folder GST_Case_Study and rename it GST_Case. 
The C2VSim files in this folder will be modified to represent the scenario. 

3) Copy the folder C2VSim_CG_1972IC_R369 into the folder GST_Case_Study again, and rename it 
Base_Case. Only the C2VSim ‘CVprint.dat’ file in this folder will be modified. 
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Find the  well locat ions using  ArcMap 

We will use the feature classes in a C2VSim geodatabase to locate the new well, determine what model 
subregion and element it is in, and what river reach and node it is closest to. For this exercise, we will use the 
arbitrarily selected well location in this table: 

Well Latitude Longitude 
A 38.86 -121.72 

 

Double-click on the ArcMap project file C2VSim_CG_1972IC_R369.mxd to open it, if it is not already open. 
Right-click on ‘Subregion’ in the ‘Table of Contents’ pane and select ‘Zoom to Layer’ to center the C2VSim 
model on the screen.  

When using ArcMap, the coordinates of the pointer appear in the lower right-hand corner. 

 

Use the ‘Zoom In’, ‘Pan’ and ‘Select Features by Rectangle’ tools to locate the well. Record the model element 
and subregion. Record the node number of the nearest river node and river reach number. You can use the 
river reach number and a table in the C2VSim User Manual to identify the river. 

Well Latitude Longitude Element Subregion River Node River reach 
A 38.86 -121.72 
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The figure above shows the ArcMap window with the location of Well A. The cursor does not appear in the 
screen-shot, but is located on the green dot labeled ‘A’ (well A from scenario 1). The latitude and longitude of 
the cursor (and therefore of the well) are displayed in the lower right. Note the subregion number in red, the 
element boundary and element number in light gray, the river node and river node number in dark blue, and 
the river reach and river reach number in lighter blue. 

 

When you are finished, your table should be similar to this: 

Well Latitude Longitude Element Subregion River Node River reach 
A 38.86 -121.72 315 4 300 53 (Sacramento River) 

 

Find the  well coordinates in UTM zone 10 

We need to enter the well coordinates into the C2VSim model using the UTM zone 10N coordinate system. 
However, the feature classes in this map document are not projected; that is, they are described in decimal 
degrees of latitude and longitude. We need to convert the latitude-longitude coordinates to UTM zone 10N 
northing and easting coordinates.  

The file Tools.zip contains an Excel workbook utmconversions.xls, developed by Steve Dutch at the 
University of Wisconsin at Green Bay. This workbook is also available at 
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http://www.uwgb.edu/dutchs/usefuldata/utmconversions1.xls. With this workbook, we can convert the well 
coordinates to the format required by the C2VSim model.  

Open the utmconversions.xls workbook and choose the tab ‘Main Page’. The top section, in red and pink, 
will convert latitude and longitude to UTM coordinates. The middle section, in yellow, will convert UTM 
coordinates to latitude and longitude. 

Use this workbook to determine the UTM 10N coordinates of each well. Compare these to the coordinates of 
the GST well. 

Well Latitude Longitude Easting Northing 

     GST 38.86 -121.72 611,057 4,302,019 
 

 

Modify C2VSim for the Case Study 

This section shows how to change the C2VSim input files to model the case study. First, the Preprocessor 
Control Files will be modified, and the Preprocessor program will be run. Next, the Simulation Control Files 
will be modified and the Simulation program will be run. Finally, groundwater and surface water hydrographs 
and Budget output tables will be imported to Excel workbooks and analyzed. 

Modify  the C2VSim  Preprocessor  Files 

Make the following modifications to the files in the folder GST_Case_Study\GST_Case\Preprocessor: 

Modify the main Preprocessor Control File 
1) Rename the Preprocessor Control File CVpreproc.in to CVpreproc_GST.in 
2) Open file CVpreproc_GST.in in TextPad 

a) Add a comment line describing the project 
b) Change the title line to describe the project 

Leave this file open in TextPad while we work on the Preprocessor Well Data File.  

http://www.uwgb.edu/dutchs/usefuldata/utmconversions1.xls�
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Add the new pumping wells to the Preprocessor Well Data File 
We need to add one well to the Preprocessor Well Data File. We will use the Easting value calculated above as 
the X value and the Northing value as the Y value. PERFTOP and PERFBOT are the altitude in feet of the top 
and bottom of the screened interval. If you add a real well to the model, you will use the well driller’s log to 
determine the screen interval. For this exercise we are using fictitious wells, so the screen intervals were 
arbitrarily chosen. The well radius has no significant impact on the simulation results for this model because 
the element width is much larger than the well radius, so RWELL is set to 1.  

1) Rename the Well Data File CVWells.dat to CVWells_GST.dat 
2) Open CVWells_GST.dat in TextPad 

a) Add a comment line describing the project 
b) Increase the value of NWELL by 1 from 133 to 134 
c) Add three lines at the bottom of the file with the well descriptions: 

WellID X Y RWELL PERFTOP PERFBOT Comment 
134 611057 4302019 1 -50 -100 / GST Well 

 
3) Save and close the file  
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Make changes to file CVpreproc_GST.in 
Once the Well Data File has been changed, the file names in the Preprocessor Control File have to be changed. 

1) Change file name CVWells.dat to CVWells_GST.dat 
2) Change file name Cvpreout.bin to CVpreout_GST.bin 
3) Change file name Cvpreproc.in to CVpreproc_GST.in 
4) Save and close the file  

 

 

Modify the Preprocessor Batch File 
The command to run the Preprocessor program is “PreProcessor3_02.exe CVpreproc_GST.in”. We generally 
recommend using a batch file to run the IWFM programs. A batch file is provided, but we have to change the 
name of the Preprocessor Control File before we can use it. 

1) Open the file Run_Preprocessor.bat in TextPad 
2) Change the Preprocessor Control File name in Run_Preprocessor.bat to CVpreproc_GST.in 
3) Save and close the file  
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Run the  C2VSim Preprocessor  Program  

Now we can run the Preprocessor: 

1) Double-click on the file Run_Preprocessor.bat 

The Preprocessor program should run to completion in a few seconds. It creates two files, 
PreprocessorMessages.out and CVpreout_GST.bin.  

Review the Preprocessor results 
Open the file PreprocessorMessages.out in TextPad and review it. The new well appears in the last two 
tables, the ‘Well Inventory’ and the list of ‘Adjustment Coefficients for Partial Well Penetration’.  

The ‘Well Inventory’ table repeats the X and Y coordinates from the Well Data File. It is generally good 
practice to review this information to assure it is correct. This table also lists the element and subregion each 
well is in. Compare these to the element and subregion we determined using ArcMap. The numbers to the 
right in parentheses indicate how the pumping volume will be apportioned between the nodes of each 
element. 

The ‘Adjustment Coefficients for Partial Well Penetration’ table lists the element and how the pumping volume 
will be apportioned to model layers. These numbers generally do not add up to 1.0, and can be adjusted by 
changing the well perforation interval. 
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Trouble-shooting the Preprocessor program 
If the Preprocessor program does not run to completion, there is probably a typo in one of the modified input 
files. First, see if the program prints out an error message that points to the error. For example, (a) the file 
name in CVpreproc_GST.in may not be the same as the actual file name, (b) there may be an extra blank 
line in one of the modified files, or (c) there may be missing or extra characters in one of the modified files. 
Check your work and see if you can find and fix the error.  

If you can’t find the reason the program fails, you can use the ‘Compare files’ tool in TextPad to compare each 
of your modified files to the files in the folder GST_Example_Complete\GST_Case\Preprocessor. Once you find 
and fix the error, the Preprocessor program will run to completion. 

 

Modify  the C2VSim  S imulat ion Files 

Next, we will change the Simulation program input files to incorporate the new pump and a modified surface 
water diversion. This will involve changing the Simulation Control File, Pumping Specification File, Pumping 
Data File, Diversion Specification File, Diversion Data File and Print Specification File. 

Make the following modifications to the files in the folder GST_Case_Study\GST_Case\Simulation: 

Modify the Simulation Control File 
1) Rename the Simulation Control File CVsim.in to CVsim_GST.in 
2) Open the file CVsim_GST.in with TextPad 

a) Add a comment line describing the project 
b) Change the title line to describe the project 
c) Change the name of the Preprocessor output file to CVpreout_GST.bin, the file created above 

with the Preprocessor. 
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Modify the Diversion Data File 
The Diversion Data File CVDiversions.dat has 265 data columns. Columns 1-246 hold diversion rates for 
diversion 1-246, columns 247-250 are not used (all data is zeroes), columns 251-262 hold bypass rates for 
bypasses 1-12, columns 263-264 are not used (all data zeroes), and column 265 holds a flag ‘-99.0’ that is 
read when surface water rates are automatically adjusted. We can leave the original diversion rates for 
diversion #28 in column 28, and place the new diversion rates for diversion #28 in the unused data column 
247. 

We will use Excel to calculate the modified diversion rates and place them in column 247. To accomplish this, 
we will copy the original rates to Excel and use a formula to reduce the June-August values by 2,000 AF/mo. 
Then we will copy the resulting table and paste it into the Diversion Data File. 

1) Rename the Diversion Data File CVDiversions.dat to CVDiversions_GST.dat 
2) Open CVDiversions_GST.dat with TextPad 
3) Place the cursor in the left-most position of the row that begins ‘C Diversion No.’ (near row 375) 
4) Select everything from here to the end of the file (You can hold down the <Shift> and <Ctrl> keys 

together and press the <End> key) 
5) Cut this text <Ctrl-X> 
6) Open a new Excel workbook 
7) In Excel: 

a) Put the cursor in cell A1 and paste the diversion rates <Ctrl-V> 
b) Put the cursor in cell B4 and freeze panes with date and header showing 
c) Locate worksheet column IN (data column 247) and color yellow 
d) We want to create an Excel formula that uses the integer month (i.e. January = 1) as input. We 

will put the integer months in an unused column to the right. 
i. Place the cursor on cell JH4, two cells to the right of column 265 
ii. Type the number ‘10’, for the month in cell A4 
iii. Repeat this for cells JH5 through JH15, months 11 and 12 of 1921, and 1 through 9 of 1922 
iv. Enter the formula ‘=JH4’ in cell JH16. The results should be the number 10 
v. Place the cursor in cell JH16 and copy the formula with <Ctrl-C> 
vi. Select all the cells in the range JH16 through JH1059, and paste the formula with <Ctrl-V> 



 C2VSim Hands-On Tutorial  

172 
 

 

e) Place the modified diversion 28 values in worksheet column IN. These values will the original 
diversion less 2,000 AF for June through August, and the original diversion for all other months. 
We can use a complex Excel equation to do this. 

i. The data for diversion 28 is in column AC of the Excel workbook. Place the cursor in cell IN4, 
type the formula ‘=IF(AND(JH4>5,JH4<9),MAX(AC12-2,0),AC12)’, and press <Return> 
• The function AND(JH4>5,JH4<9) returns ‘1’ if the integer value for the month is 6, 7 or 

8 (June – August) 
• The IF function uses the equation MAX(AC12-2,0) if the AND returns ‘1’, otherwise it 

uses ‘AC12’. In other words, it returns the original diversion minus 2,000 AF in June – 
August, and the original diversion in all other months. (The rates are in thousand acre-
feet, so ‘2’ represents 2,000 AF. We use the ‘maximum’ formula so we do not divert at a 
negative rate if the original diversion rate is less than 2,000 AF/mo.) 

ii. Copy this cell to all cells in the range IN4 to IN1059 
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f) Copy the dates and data columns from Excel. Select all the data in the worksheet by placing the 
cursor in cell A1, then holding down the <Shift>and <Ctrl> keys while you press the <Right 
arrow> key and then the <Down arrow> key, then press <Ctrl-C> 

g) Switch to CVDiversions_GST.dat in TextPad. 
8) Paste all of the diversion data <Ctrl-V> 
9) Save and close the file CVDiversions_GST.dat 

 

Modify the Diversion Specification File 
To modify the diversion rates for diversion #28, we will make one small change to the Diversion Specification 
File, to point diversion #28 to the new data column in the Diversion Data File. 

1) Rename the Diversion Specification File CVDivSpec.dat to CVDivSpec_GST.dat 
2) Open CVDivSpec_GST.dat with TextPad 

a) Add a comment line describing the project 
b) Modify diversion #28 to point to diversion data column 247  

i. Find diversion number 28, near row 241. 
ii. Copy the line and paste the copy below the existing line 
iii. Put an asterisk ‘*’ in the first character of the top copy to comment it out 
iv. In the bottom copy, change the value of each of the items ICOLRL, ICOLNL and ICOLDL from 

‘28’ to ‘247’. This directs the Simulation program to read the recoverable loss rate, non-
recoverable loss rate and diversion rate from column 247 of the Diversion Data File 

3) Save and close the file CVDivSpec_GST.dat 
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Note that diversion #28 has a recoverable loss of 10% and a non-recoverable loss of 2%. FRACDL, the fraction 
delivered, is only 88% of the amount diverted from the river. We will take this into account when we 
determine the amount of water we need to pump. 

 

Modify the Pumping Specification File 
One new well was added in the Preprocessor Well Data File. We use the Pumping Specification File to say how 
this well will be used.  

1) Rename the Pumping Specification File CVPuSp.dat to CVPuSp_GST.dat 
2) Open CVPuSp_GST.dat with TextPad 

a) Add a comment line describing the project 
b) Add the new pump to the Pumping Specification File 

The top section of the Pumping Specification File holds information on the wells specified in the 
Preprocessor Well Data File. This includes which column of the Pumping Data File holds the 
pumping volumes for each well, and which land use type and subregion the water is supplied to. 
We will add one row for the new well.  

i. The first item in each row is the well ID number from the Preprocessor Well Data File. 
ii. The second item is the column of the Pumping Data File associated with each well. We will 

place the pumping rate for the new pump in a new data column in the Pumping Data File. 
The original Pumping Data File has 42 columns of data, so we will use column 43 for the new 
pump. The ICOLWL value is 43 for the new well. 

iii. The third item specifies the land use type the water is delivered to. This is specified by listing 
the appropriate column of the Irrigation Fraction Data File. In the Irrigation Fraction data file 
CVIrFr.dat, column 22 is to deliver 100% to urban use, and column 23 is to deliver 100% to 
agricultural use. The water from the new pump will all go to agricultural use, so the 
ICFIRIWGL value is 23.  

iv. The fourth item specifies the percentage of the pumping value to be extracted from this well. 
FRACWL is 1 (or 100%). 
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v. The fifth item specifies the subregion the water will be delivered to. The water will be used 
within the subregion the well is in, so we can set IRGWL to ‘-1’. 

vi. The last three items specify whether the pumping rates will be automatically adjusted at run-
time. We do not want to adjust the pumping rates, so we set ICADJWL to zero. We also have 
to specify values for the last two items (which will be ignored by the program if ICADJWL is 
zero). We will copy values from the second and fourth columns. We set the data column 
containing the maximum pumping rate (ICWLMAX) to the data column containing the 
specified pumping rate (ICOLWL) and the fraction (FWLMAX) to the specified pumping 
fraction (FWLMAX). 

3) Save and close the file CVPuSp_GST.dat 

The final values are: 

ID ICOLWL ICFIRIWGL FRACWL IRGWL ICADJWL ICWLMAX FWLMAX 
134 43 23 1 -1 0 43 1 

 

When this are entered in the file, it looks like this: 

 

Modify the Pumping Data File 
We need to modify the Pumping Data File by adding a data column for the new pump. 

We will add the new pumping rates to the Pumping Data File in three steps. First, we will copy the pumping 
rates from the Pumping Data File to Excel. The pumping data is tab-delimited, and will be automatically 
parsed to columns in the worksheet. Next, we will add three new data columns corresponding to the new 
well. Finally, we will copy the modified pumping rates from Excel and paste them into the Pumping Data File, 
replacing the old data. The data from Excel is pasted as tab-delimited text. 

As we noted above, the surface water diversion has a recoverable loss of 10% and a non-recoverable loss of 
2%. When 2,000 AF/mo is diverted from the river, only 88%, or 1,760 AF/mo, is available to meet agricultural 
water demands. Thus when the surface water diversion is reduced by 2,000 AF/mo, the amount of water 
delivered is only reduced by 1,760 AF/mo. To replace this, we need to pump an additional 1,760 AF/mo for the 
months of June through August. 

1) Rename the Pumping Data File CVpump.dat to CVpump_GST.dat 
2) Open the file CVpump_GST.dat with TextPad 
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a) Add a comment line describing the project 
b) Change the value of NCOLPUMP by one from 42 to 43 

3) Place your cursor in the left-most position of the row with ‘C Column’ (near row 102). 
4) Select everything from here to the end of the file (You can hold down the <Shift> and <Ctrl> keys 

together and press the <End> key) 
5) Cut this text <Ctrl-X> 
6) Open a new Excel workbook 
7) Put the cursor in cell A1 and paste the pumping data <Ctrl-V> 

a) Put the cursor in cell A1 of the first worksheet ‘Sheet1’ and paste the pumping data <Ctrl-V> 
b) Put the cursor in cell B4 and freeze panes with date and header showing 
c) Locate worksheet column AR (data column 43) and color yellow 
d) Add scenario pumping rates for water year 1922 in cells AR4 through AR15. We use negative 

rates to represent groundwater withdrawals from the aquifer. 
i. Type ‘0’ in the rows for October-May (AR4-AR11) 
ii. Type ‘-1.76’ in the rows for June-August (AR12-AR14) 
iii. Type ‘0’ in the row for September (AR15) 

e) Place the cursor in cell AR16 and type the formula ‘=AR4’ then hit <Return> 
f) Copy this cell to all cells in the block between AR16 and AR1059. This will copy the pumping 

rates for each month of water year 1922 to the same month of each water year from 1923 to 
2009  

g) Copy everything from Excel by placing the cursor in cell A1, then holding down both the 
<Shift>and <Ctrl> keys as you press <Right arrow> and then <Down arrow> to select all of the 
data, then <Ctrl-C> 

h) Switch to CVpump_GST.dat in TextPad. Your cursor should still be at line 102. 
i) Paste all of the pumping data with <Ctrl-V> 

8) Save the CVpump_GST.dat file 

 

Modify the Print Specification File 
The Print Specification File lists the locations of the hydrographs that are printed when the model runs. We will 
add one groundwater hydrograph and one surface water hydrograph to this file. 

1) Rename the Print Specification File CVprint.dat to CVprint_GST.dat 
2) Open CVprint_GST.dat with TextPad 
3) Add a comment line describing the project 
4) Add the new groundwater hydrograph at the same location as the new pumping well 

a) Increase the value of NOUTH by one from 1387 to 1388 
b) Add the location of the new well in a new row. The first item in each row is IOUTHL, the model 

layer for the hydrograph (1 for the water table), the second item is the X coordinate and the third 
item is the Y coordinate. (You can optionally add an ID and the element number as comments.)  
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5) Add one new surface water hydrographs below the modified diversion point.  
a) Increase the value of NOUTR by one from 34 to 35 
b) Add the location of the new hydrograph at river node 332, one node downstream from diversion 

#28. The only required item is the river node number IOUTHR. You can optionally add a tag and 
a comment.  

6) Save and close the file CVprint_GST.dat 

 

 

 

Make changes to file CVsim_GST.in 
Change the input file names in the Simulation Control File CVsim_GST.in to match the modified file names 
above. 

1) Change the name of the Pumping Specification File to CVPuSp_GST.dat 
2) Change the name of the Pumping Data File to CVpump_GST.dat 
3) Change the name of the Diversion Specification File to CVDivSpec_GST.dat 
4) Change the name of the Diversion Data File to CVdiversions_GST.dat 
5) Change the name of the Print Specification File to CVprint_GST.dat 
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Modify the surface water and groundwater hydrograph output file names in the Simulation Control File 
CVsim_GST.in by adding ‘_GST’ to the root name.  

6) Change CVSWhyd.out  to CVSWhyd_GST.out  
7) Change CVGWhyd.out  to CVGWhyd_GST.out 

In the example below, the comment ‘/** GST’ has been added to the right of the modified file names in the 
Simulation Control File. 

 

Turn the pumping adjustment off. 

8) Near the end of the Simulation Control File, set the value of KOPTDV to ‘00’ 
9) Save and close the file. 
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Modify the Simulation Batch File 
The command to run the Simulation program is “Simulation3_02.exe CVSim_GST.in”. We have to change the 
name of the Simulation Control File in the batch file before we can use the batch file. 

1) Open the file Run_Sim.bat in TextPad 
2) Change the Simulation Control File name in Run_Sim.bat to CVSim_GST.in 
3) Save and close the file  

 

 

Run the  S im ulat ion Program for  the Scenar io  

Now we can run the Simulation program: 

1) Double-click on the file Run_Sim.bat 

The Simulation program should run to completion in a few minutes. It creates two files in the Simulation 
folder, SimulationMessages.out and CVfinallist.out. It also creates a number of files in the Results 
folder, including several files with the .bin extension and several files with the .out extension. The .bin files 
are read by two post-processors, the Budget and Z-Budget programs. The .out files are text files that can be 
opened with TextPad. 
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Open the file SimulationMessages.out in TextPad and review it. The first section has the title section from 
the CVSim_GST.in file, followed by a list of the files that were used in the simulation. This is followed by a 
line stating what components were adjusted in this simulation (surface water diversions and groundwater 
pumping); nothing should be adjusted in this simulation. The remainder of the file lists the solver convergence 
iterations for each time step. The last entry states the model run time. 

Trouble-shooting the Simulation program 
If the Simulation program does not run to completion, there is probably a typo in one of the modified input 
files. First, see if the program prints out an error message that points to the error. For example,  

a) the file name in CVSim_GST.in may not be the same as the actual file name,  
b) there may be an extra blank line in one of the modified files, or  
c) there may be missing or extra characters in one of the modified files.  

Check your work and see if you can find and fix the error.  

If you can’t find the reason the program won’t run, you can use the ‘Compare files’ tool in TextPad to compare 
each of your modified files to the corresponding files in the folder 
GST_Example_Complete\GST_Case\Simulation. Once you find and fix the error, the Simulation program will 
run to completion. 

 

Run the  Budget  Program  

Switch to the GST_Case_Study\GST_Case\Budget folder.  

Open the Budget Control File CVBudget.in file with TextPad. There is a list of binary files with the .bin 
extension starting near line 70. The Budget program reads each of these binary files, and produces a text file 
with the same root name and the .BUD  extension. For example, the Budget program reads the 
..\Results\CVlandwater.bin file and produces the ..\Results\CVlandwater.BUD file. 

 

 1)  Double-click on the file Run_Budget.bat 



 C2VSim Hands-On Tutorial  

181 
 

The Budget program should run to completion in less than a minute.  

Switch to the GST_Case_Study\GST_Case\Results folder. You should see eight new files with the .BUD 
extension.  

 

Create Budget  Workbooks w ith Excel 

Open Excel 2007 or Excel 2012 to a new, blank worksheet. On the “IWFMTools” menu, use the drop-down 
menu next to “IWFM Version” to select ‘3.02’. 

 

A window with the label ‘Budget to Excel (3.02)’ will open. Use the ‘Browse’ button to go to the 
GST_Case_Study\GST_Case\Budget directory and select the CVBudget.in file. The available budget files will 
be listed under ‘Choose Budget Table’ in the same order they are listed in the CVBudget.in file.  

 

 

Land and Water Use Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the lower pane of the ‘Budget to Excel (3.02)’ window, select elect ‘Land and water use budget’, near the 
bottom of the list, and then click the ‘Transfer to Excel’ button. This will add 22 worksheets to the workbook, 
one for each of the 21 model subregions, and one (labeled ‘Subregion 22’) for the entire model area. 

Save the workbook to the GST_Case_Study directory as GST_Land_and_Water_Budget.xlsx.  
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Root Zone Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the ‘Budget to Excel (3.02)’ window, select ‘Root zone budget’ and then click the ‘Transfer to Excel’ button. 
This will add 22 worksheets to the workbook, one for each of the 21 model subregions, and one (labeled 
‘Subregion 22’) for the entire model area. 

Save the workbook to the GST_Case_Study directory as GST_Root_Zone_Budget.xlsx.  

 

Stream Reach Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the ‘Budget to Excel (3.02)’ window, select ‘Stream reach budget’, near the bottom of the list, and then 
click the ‘Transfer to Excel’ button. This will add 75 worksheets to the workbook, one for each of the 75 
C2VSim river reaches. 

Save the workbook to the GST_Case_Study directory as GST_Stream_Reach_Budget.xlsx.  

 

Groundwater Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the ‘Budget to Excel (3.02)’ window, select ‘Groundwater budget’ and then click the ‘Transfer to Excel’ 
button. This will add 22 worksheets to the workbook, one for each of the 21 model subregions, and one 
(labeled ‘Subregion 22’) for the entire model area. 

Save the workbook to the GST_Case_Study directory as GST_Groundwater_Budget.xlsx.  

 

Modify the Base Case files 

The easiest way to see the results of the changes in the case study is to compare the scenario results to the 
unchanged base case. We can replace the Print Specification File CVprint.dat in the base case with our 
modified Print Specification File CVprint_GST.dat. When the Simulation program is run with this Print 
Specification File, groundwater and surface water hydrographs will be created for the new locations specified 
in this file.  Make the following modifications to the files in the folder GST_Case_Study\Base_Case\Simulation. 

Copy the Print Specification File CVprint_GST.dat 
Copy the modified Print Specification File CVprint_GST.dat in the folder 
GST_Case_Study\GST_Case\Simulation and paste it into the folder GST_Case_Study\Base_Case\Simulation.  
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Make changes to the Simulation Control File 
Make the following changes to the Simulation Control File in the folder 
GST_Case_Study\Base_Case\Simulation: 

1) Rename the Simulation Control File CVsim.in to CVsim_base.in  
2) Open CVsim_base.in with TextPad 
3) Change the Print Specification File name to CVprint_GST.dat 

 

 

Turn the pumping adjustment off. 

4) Near the end of the Simulation Control File, set the value of KOPTDV to ‘00’ 
5) Save and close the file. 
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Modify the Simulation Batch File 
The command to run the Simulation program is “Simulation3_02.exe CVSim_GST.in”. We have to change the 
name of the Simulation Control File in the batch file before we can use the batch file. 

1) Open the file Run_Sim.bat with TextPad 
2) Change the Simulation Control File name in Run_Sim.bat to CVSim_base.in 
3) Save and close the file  

 

 

Run the  S im ulat ion Program for  the Base  Case  

Now we can run the Simulation program: 

1) Double-click on the file Run_Sim.bat 

The Simulation program should run to completion in a few minutes.  

 

Create Budget  Workbooks w ith Excel 

Open Excel 2007 or Excel 2012 to a new, blank worksheet. On the “IWFMTools” menu, use the drop-down 
menu next to “IWFM Version” to select ‘3.02’. 
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A window with the label ‘Budget to Excel (3.02)’ will open. Use the ‘Browse’ button to go to the 
GST_Case_Study\Base_Case\Budget directory and select the CVBudget.in file. The available budget files will 
be listed under ‘Choose Budget Table’ in the same order they are listed in the CVBudget.in file.  

 

 

Land and Water Use Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the ‘Budget to Excel (3.02)’ window, select ‘Land and water use budget’, near the bottom of the list, and 
then click the ‘Transfer to Excel’ button. This will add 22 worksheets to the workbook, one for each of the 21 
model subregions, and one (labeled ‘Subregion 22’) for the entire model area. 

Save the workbook to the GST_Case_Study directory as Base_Land_and_Water_Budget.xlsx.  

 

Root Zone Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the ‘Budget to Excel (3.02)’ window, select ‘Root zone budget’ and then click the ‘Transfer to Excel’ button. 
This will add 22 worksheets to the workbook, one for each of the 21 model subregions, and one (labeled 
‘Subregion 22’) for the entire model area. 

Save the workbook to the GST_Case_Study directory as Base_Root_Zone_Budget.xlsx.  

 

Stream Reach Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the ‘Budget to Excel (3.02)’ window, select ‘Stream reach budget’, near the bottom of the list, and then 
click the ‘Transfer to Excel’ button. This will add 75 worksheets to the workbook, one for each of the 75 
C2VSim river reaches. 

Save the workbook to the GST_Case_Study directory as Base_Stream_Reach_Budget.xlsx.  
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Groundwater Budget 
Create a new Excel workbook (Office Button -> New -> Blank Workbook).  

In the ‘Budget to Excel (3.02)’ window, select ‘Groundwater budget’ and then click the ‘Transfer to Excel’ 
button. This will add 22 worksheets to the workbook, one for each of the 21 model subregions, and one 
(labeled ‘Subregion 22’) for the entire model area. 

Save the workbook to the GST_Case_Study directory as Base_Groundwater_Budget.xlsx.  

 

Review and Interpret Results 

This section shows how to import hydrograph files to Excel workbooks, and how to compare hydrographs 
between the GST Case and the Base Case to see the impacts of the three new groundwater pumping wells.  

Create Hydrograph Workbooks w ith Excel 

First, we’ll bring the GST Case groundwater and surface water hydrograph output into Excel. Then we’ll bring 
in the Base Case hydrographs. Next, we will create new hydrographs of the differences between the GST Case 
and Base Case hydrographs. In the final step, we will graph these results. 

Start by creating the Excel workbook that will hold all of the results. Open a new Excel workbook, and save it 
in the directory GST_Case_Study as GST_Results.xlsx.  

 

GST Case Groundwater Hydrographs 
First, we will import the groundwater hydrographs of the GST Case to an Excel worksheet.  

1) Go to the GST_Case_Study\GST_Case\Results folder, and open the file CVGWhyd_GST.out with 
TextPad.  

2) Select all <Ctrl-A> and copy <Ctrl-C> 
3) Switch to the Excel workbook 
4) Put the cursor in cell A1 of tab ‘Sheet1’ and paste <Ctrl-V> 
5) Next, we use ‘Text to Columns’ to put each hydrograph in a separate column 

a) Move the cursor to cell A5 and select all cells in the range A5-A451 by holding the <Ctrl> and 
<Shift> keys and pressing <Down arrow> 

b) With these cells highlighted, go to the ‘Data’ menu and select ‘Text to Columns’. This opens a 
window labeled ‘Convert Text to Columns Wizard – Step 1 of 3’ 

c) Select the radio button next to ‘Fixed Width’, click ‘Next’ and then click ‘Finish’. Now, dates are in 
column A and each groundwater hydrograph is in a separate column. 

6) Next, we can use ‘Find and Replace’ to convert the IWFM time-date code to something Excel can 
recognize.  
a) Use <Ctrl-H> to open the ‘Find and Replace’ panel.  
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b) Next to ‘Find what’, enter ‘_24:00’. 
c) Leave the ‘Replace with’ field blank. 
d) Click ‘Replace All’.  
e) Excel should open an alert showing the number of replacements, and column A should contain 

dates. Close the alert and the ‘Find and Replace’ panel. 
7) Rename the worksheet by double-clicking the tab label ‘Sheet1’ and replacing it with 

‘GWhyd_GST_Case’ 
8) Put the cursor in cell B8 and go to the ‘View’ menu, select ‘Freeze Panes’, and choose the top item on 

the drop-down menu ‘Freeze Panes’.  
9) Scroll to the right to column BAK to see the new groundwater hydrograph we added in the Print 

Specification File. 
10) Save the Excel workbook. 

 

 

GST Case Surface Water Hydrographs  
Next, we will create an Excel worksheet with the surface water hydrographs of the GST case.  

1) Go to the GST_Case_Study\GST_Case\Results folder, and open the file CVSWhyd_GST.out with 
TextPad.  

2) Select all <Ctrl-A> and copy <Ctrl-C> 
3) Switch to the Excel workbook 
4) Put the cursor in cell A1 of tab ‘Sheet2’ and paste <Ctrl-V> (If there is no blank worksheet, crate one 

by clicking in the small area to the right of the worksheet tabs that shows this symbol: ) 
5) Use ‘Text to Columns’ to put each hydrograph in a separate column 

a) Move the cursor to cell A6 and select all cells in the range A6-A450 by holding the <Ctrl> and 
<Shift> keys and pressing <Down arrow> 
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b) With these cells highlighted, go to the ‘Data’ menu and select ‘Text to Columns’. This opens a 
window labeled ‘Convert Text to Columns Wizard – Step 1 of 3’ 

c) Select the radio button next to ‘Fixed Width’, click ‘Next’ and then click ‘Finish’. Now, dates are in 
column A and each surface water hydrograph is in a separate column. 

6) Next, we can use ‘Find and Replace’ to convert the IWFM time-date code to something Excel can 
recognize.  
a) Use <Ctrl-H> to open the ‘Find and Replace’ panel.  
b) The ‘Find what’ box should still contain ‘_24:00’. If not, enter ‘_24:00’ in the box. 
c) Leave the ‘Replace with’ field blank. 
d) Click ‘Replace All’.  
e) Excel should open an alert showing the number of replacements, and column A should contain 

dates. Close the alert and the ‘Find and Replace’ panel. 
7) Rename the worksheet by double-clicking the tab label ‘Sheet2’ and replacing it with 

‘SWhyd_GST_Case’ 
8) Put the cursor in cell B7 and go to the ‘View’ menu, select ‘Freeze Panes’, and choose the top item on 

the drop-down menu ‘Freeze Panes’.  
9) Scroll to the right to column AJ to see the new surface water hydrograph we added in the Print 

Specification File. 
10) Save the Excel workbook. 

 

 

Base Case Groundwater Hydrographs 
Now we will add an Excel worksheet with the groundwater hydrographs of the base case.  

1) Go to the GST_Case_Study\Base_Case\Results folder, and open the file CVGWhyd.out with 
TextPad. 
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2) Select all <Ctrl-A> and copy <Ctrl-C> 
3) Switch to the Excel workbook (and create a new worksheet ‘Sheet3’ if needed) 
4) Put the cursor in cell A1 of tab ‘Sheet3’ and paste <Ctrl-V> 
5) Next, we use ‘Text to Columns’ to put each hydrograph in a separate column 

a) Move the cursor to cell A5 and select all cells in the range A5-A451 by holding the <Ctrl> and 
<Shift> keys and pressing <Down arrow> 

b) With these cells highlighted, go to the ‘Data’ menu and select ‘Text to Columns’. This opens a 
window labeled ‘Convert Text to Columns Wizard – Step 1 of 3’ 

c) Select the radio button next to ‘Fixed Width’, click ‘Next’ and then click ‘Finish’. Now, dates are in 
column A and each groundwater hydrograph is in a separate column. 

6) Next, we can use ‘Find and Replace’ to convert the IWFM time-date code to something Excel can 
recognize.  
a) Use <Ctrl-H> to open the ‘Find and Replace’ panel.  
b) The ‘Find what’ box should still contain ‘_24:00’. If not, enter ‘_24:00’ in the box. 
c) Leave the ‘Replace with’ field blank. 
d) Click ‘Replace All’.  
e) Excel should open an alert showing the number of replacements, and column A should contain 

dates. Close the alert and the ‘Find and Replace’ panel. 
7) Rename the worksheet by double-clicking the tab label ‘Sheet3’ and replacing it with 

‘GWhyd_Base_Case’ 
8) Put the cursor in cell B8 and go to the ‘View’ menu, select ‘Freeze Panes’, and choose the top item on 

the drop-down menu ‘Freeze Panes’.  
9) Scroll to the right to column BAK to see the new groundwater hydrograph we added in the Print 

Specification File. 
10) Save the Excel workbook. 

 



 C2VSim Hands-On Tutorial  

190 
 

 

Base Case Surface Water Hydrographs  
We can also create an Excel worksheet with the surface water hydrographs of the base case.  

1) Go to the GST_Case_Study\GST_Case\Results folder, and open the file CVSWhyd_GST.out with 
TextPad.  

2) Select all <Ctrl-A> and copy <Ctrl-C> 
3) Switch to the Excel workbook (and create a new worksheet ‘Sheet4’ if needed) 
4) Put the cursor in cell A1 of tab ‘Sheet4’ and paste <Ctrl-V> 
5) Use ‘Text to Columns’ to put each hydrograph in a separate column 

a) Move the cursor to cell A6 and select all cells in the range A6-A450 by holding the <Ctrl> and 
<Shift> keys and pressing <Down arrow> 

b) With these cells highlighted, go to the ‘Data’ menu and select ‘Text to Columns’. This opens a 
window labeled ‘Convert Text to Columns Wizard – Step 1 of 3’ 

c) Select the radio button next to ‘Fixed Width’, click ‘Next’ and then click ‘Finish’. Now, dates are in 
column A and each surface water hydrograph is in a separate column. 

6) Next, we can use ‘Find and Replace’ to convert the IWFM time-date code to something Excel can 
recognize.  
a) Use <Ctrl-H> to open the ‘Find and Replace’ panel.  
b) The ‘Find what’ box should still contain ‘_24:00’. If not, enter ‘_24:00’ in the box. 
c) Leave the ‘Replace with’ field blank. 
d) Click ‘Replace All’.  
e) Excel should open an alert showing the number of replacements, and column A should contain 

dates. Close the alert and the ‘Find and Replace’ panel. 
7) Rename the worksheet by double-clicking the tab label ‘Sheet4’ and replacing it with 

‘SWhyd_Base_Case’ 
8) Put the cursor in cell B7 and go to the ‘View’ menu, select ‘Freeze Panes’, and choose the top item on 

the drop-down menu ‘Freeze Panes’.  
9) Scroll to the right to column AJ to see the new surface water hydrograph we added in the Print 

Specification File. 
10) Save the Excel workbook. 
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Compare  Hydrographs w ith Excel 

We now have an Excel workbook that contains four worksheets. Each worksheet contains one of the 
hydrograph output files from a C2VSim run. The easiest way to see the difference between the Base Case and 
GWP Case is to take the difference between the groundwater hydrographs of the two runs, and the difference 
between the surface water hydrographs of the two runs.  

 

Show Groundwater Head Differences 
We will add a new Excel worksheet, and then use a formula to subtract each GST Base Case groundwater 
hydrograph from the corresponding GST Case groundwater hydrograph.  

1) In the GST_Results.xlsx workbook, create a new worksheet and name it ‘GWHyd_Difference’.  
2) Switch to worksheet ‘GWHyd_GST_Case’, select all <Ctrl-A> and copy <Ctrl-C> 
3) Switch to worksheet ‘GWHyd_Difference’, place the cursor in cell A1, and paste <Ctrl-V>. This copies 

the structure and values of the ‘GWHyd_GST_Case’ worksheet. We will keep the structure and 
replace the values with formulas. 

4) We will use an Excel formula to calculate the difference between hydrograph values for each time 
step  
a) Place the cursor in cell B8 of worksheet ‘GWHyd_Difference’. 
b) Enter the ‘=’ sign, and (without hitting any key) select the tab for the ‘GWHyd_GST_Case’ 

worksheet and place the cursor in cell B8. 
c)  Enter the ‘-’ sign, and (again without hitting any key) select the tab for the ‘GWHyd_Base_Case’ 

worksheet and place the cursor in cell B8. 
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d) Hit <Return> 
e) You should have the formula =GWHyd_GST_Case!B8-GWHyd_Base_Case!B8 in cell B8 of 

the ‘GWHyd_Difference’ worksheet. The cell value should be ‘0’ 
5) Copy the formula through the rest of the ‘GWHyd_Difference’ worksheet 

a) Select cell B8, and copy with <Ctrl-C>. 
b) Select all of the hydrograph cells by holding down the <Shift> key and pressing <Right arrow>, 

the holding sown the <Shift> key and pressing <Down arrow> 
c) Paste the formula with <Ctrl-V> 

 

6) Create a graph of the difference between the GST Case and Base Case for the groundwater 
hydrograph at the pumping well, in column BAK of the ‘GWHyd_Difference’ worksheet.  
a) Place the cursor in cell BAK8 and use <Shift><Down> to select the cells BAK8 through BAK451 
b) Under the ‘Insert’ menu, select ‘Scatter’ and then ‘Scatter with Straight Lines’. This will place a 

graph in the worksheet. 
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c) Right-click inside the new graph and select ‘Move Chart…’ to open the ‘Move Chart’ window, 
then select ‘New Sheet’ and name it ‘GWHyd’ 

 

The graph shows that once groundwater pumping starts, the groundwater head of the GST Case is always 
lower than the groundwater head of the Base Case at the well location. The head falls to 0.45 ft lower for a 
brief period in the first year before recovering, and drops further in each successive year before stabilizing at a 
maximum of approximately 0.6 ft and a minimum of approximately 0.2 ft lower. This appears to be a very 
small impact. We need to add more information to the graph to better interpret it. 

d) First, we can add dates to the x-axis and a title to the graph. 
i. Use the left mouse button to select the line inside the graph, then use the right mouse button 

to select ‘Select Data…’ 
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ii. Click on the ‘Edit…’ button 
iii. Under ‘Series name:’, click the square button on the right, with the red arrow, navigate to the 

‘GWHyd_Difference’ workbook, and select cell BAK6 
iv. Under ‘Series X Values:’, click the square button on the right, with the red arrow, navigate to 

the ‘GWHyd_Difference’ workbook, and select cells A8 through A451 
v. Click on the ‘OK’ button, then click the ‘OK’ button of the ‘Select Data Source’ window 

e) Format the x-axis to be more readable 
i. Right-click on the x-axis and choose ‘Format axis…’ 
ii. We want to set the minimum x-axis value to 10/31/1972 and the maximum value to 

09/30/2009.  
iii. Under ‘Axis Options’, for ‘Minimum’, click the radio button next to ‘Fixed’ and enter the 

numerical value of 10/31/1972, which is ‘26603’ 
iv. For ‘Maximum’, click the radio button next to ‘Fixed’ and enter the numerical value of 

09/30/2009, which is ‘40086’ 
v. For ‘Major Unit’, click the radio button next to ‘Fixed’ and enter ‘365.25’ 
vi. In the left panel, choose ‘Number’, then uncheck the box next to ‘Linked to source’ 
vii. Change the ‘Format Code’ from ‘m/d/yyyy’ to ‘mm/yy’ and then click the ‘Add’ button 
viii. In the left panel, choose ‘Alignment’, and use the drop-down menu next to ‘Text direction’ to 

choose ‘Rotate all text 900’ 
f) Add titles to the axes 

i. Select the ‘Layout’ menu, then ‘Axis Titles’, then ‘Primary Horizontal Axis Title’, then ‘Title 
Below Axis’ 

ii. Type ‘Month’ and hit <Return> 
iii. Select the ‘Layout’ menu, then ‘Axis Titles’, then ‘Primary Vertical Axis Title’, then ‘Rotated 

Title’ 
iv. Type ‘Head Difference (ft)’ and hit <Return> 



 C2VSim Hands-On Tutorial  

195 
 

 

This groundwater hydrograph at the pumping well shows that each year, the water table in the GST Case falls 
sharply (relative to the Base Case) over a short period of time, and then recovers over a longer period of time. 
This cycle is repeated each year. The groundwater head difference changes for several years, then becomes a 
relatively stable repeating cycle after around six years. 

g) We can make a copy of this graph, and use it to focus on several years 
i. Right-click on the tab ‘GWHyd’ and select ‘Move or Copy…’ to open the ‘Move or Copy’ 

window 
ii. Check the box next to ‘Create a copy’ in the lower left, then highlight ‘GWHyd’ in the 

window ‘Before sheet’ and click ‘OK’. This creates a copy called ‘GWHyd (2)’. 
iii. Right-click on the x-axis and choose ‘Format axis…’ 
iv. We want to look at a three-year period, so we will set the minimum x-axis value to 

10/31/1972 and the maximum value to 09/30/1975.  
v. Under ‘Axis Options’, for ‘Minimum’, we will keep the numerical value of 10/31/1972, which 

is ‘26603’ 
vi. For ‘Maximum’, we will enter the numerical value of 09/30/1975 is ‘27698’ 
vii. For ‘Major Unit’, click the radio button next to ‘Fixed’ and enter ‘30’ 
x. Place the cursor over the line, right-click, and select ‘Format data series…’ to open the 

Format Data Series window. 
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viii. Select the second item in the left panel, ‘Marker Options’, select the button next to 
‘Automatic’, and then click ‘Close’ in the lower left corner.  

 

 

By focusing on a shorter period of time, we can get a better understanding of the monthly difference in 
groundwater heads between the GWP Case and Base Case for the first three years. The groundwater head of 
the GST Case declines during the three months when the pumps are turned on, then recovers in the following 
nine months. This pattern is repeated each year. We can see that the groundwater head did not fully recover 
after the first year, and the head difference between the two cases increases in each subsequent year of the 
GST project. The GST Case groundwater head is approximately 0.08 ft lower than the Base Case head in May 
1974, and approximately 0.12 ft lower than the Base Case after two years.  

 

Show Surface Water Flow Differences 
We can also use a similar process to create an Excel worksheet and graph to show the difference between 
each GST Case surface water hydrograph and the corresponding Base Case surface water hydrograph.  

1) In the GST_Results.xlsx workbook, create a new worksheet and name it ‘SWHyd_Difference’.  
2) Switch to worksheet ‘SWHyd_GST_Case’, select all <Ctrl-A> and copy <Ctrl-C> 
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3) Switch to worksheet ‘SWHyd_Difference’, place the cursor in cell A1, and paste <Ctrl-V>. This copies 
the structure and values of the ‘SWHyd_GST_Case’ worksheet. We will keep the structure and replace 
the values with formulas. 

4) We will use an Excel formula to calculate the difference between hydrograph values for each time 
step  
a) Place the cursor in cell B7 of worksheet ‘SWHyd_Difference’. 
b) Enter the ‘=’ sign, and (without hitting any key) select the tab for the ‘SWHyd_GST_Case’ 

worksheet and place the cursor in cell B8. 
c)  Enter the ‘-’ sign, and (again without hitting any key) select the tab for the ‘SWHyd_Base_Case’ 

worksheet and place the cursor in cell B8. 
d) Hit <Return> 
e) You should have the formula =SWhyd_GST_Case!B7-SWhyd_Base_Case!B7 in cell B8 of 

the ‘GWHyd_Difference’ worksheet. The cell value should be ‘0’ 
5) Copy the formula through the rest of the ‘SWHyd_Difference’ worksheet 

a) Select cell B7, and copy with <Ctrl-C>. 
b) Select all of the hydrograph cells by holding down the <Shift> key and pressing <Right arrow>, 

the holding sown the <Shift> key and pressing <Down arrow> 
c) Paste the formula with <Ctrl-V> 

 

6) Create a graph of the difference between the GST Case and Base Case for the surface water 
hydrograph at river node 300, near the pumping well, in column AJ of the ‘SWHyd_Difference’ 
worksheet.  
a) Place the cursor in cell AJ7 and use <Shift><Down> to select the cells AJ7 through AJ450 
b) Under the ‘Insert’ menu, select ‘Scatter’ and then ‘Scatter with Straight Lines’. This will place a 

graph in the worksheet. 
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c) Right-click inside the new graph and select ‘Move Chart…’ to open the ‘Move Chart’ window, 
then select ‘New Sheet’ and name it ‘SWHyd’ 

 

This graph shows that the difference in surface water flows between the two cases fluctuates each month, 
cycling between a period when the GST Case has higher flows and a period when the GST Case has lower 
flows than the Base Case. Perhaps the most startling thing we can see is that reducing surface water 
diversions by 2,000 AF/mo increased river flows by less than 1,000 AF/mo for this case. We can add more 
information to the graph to better understand this. 

d) First, we will add dates to the x-axis and a title to the graph. 
i. Use the left mouse button to select the line inside the graph, then use the right mouse button 

to select ‘Select Data…’ 
ii. Click on the ‘Edit…’ button 
iii. Under ‘Series name:’, click the square button on the right, with the red arrow, navigate to the 

‘GWHyd_Difference’ workbook, and select cell AJ6 
iv. Under ‘Series X Values:’, click the square button on the right, with the red arrow, navigate to 

the ‘GWHyd_Difference’ workbook, and select cells A7 through A450 
v. Click on the ‘OK’ button, then click the ‘OK’ button of the ‘Select Data Source’ window 

e) Format the x-axis to be more readable 
i. Right-click on the x-axis and choose ‘Format axis…’ 
ii. We want to set the minimum x-axis value to 10/31/1972 and the maximum value to 

09/30/2009.  
iii. Under ‘Axis Options’, for ‘Minimum’, click the radio button next to ‘Fixed’ and enter the 

numerical value of 10/31/1972, which is ‘26603’ 
iv. For ‘Maximum’, click the radio button next to ‘Fixed’ and enter the numerical value of 

09/30/2009, which is ‘40086’ 
v. For ‘Major Unit’, click the radio button next to ‘Fixed’ and enter ‘365.25’ 
vi. In the left panel, choose ‘Number’, then uncheck the box next to ‘Linked to source’ 
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vii. Change the ‘Format Code’ from ‘m/d/yyyy’ to ‘mm/yy’ and then click the ‘Add’ button 
viii. In the left panel, choose ‘Alignment’, and use the drop-down menu next to ‘Text direction’ to 

choose ‘Rotate all text 900’ 
f) Add titles to the axes 

i. Select the ‘Layout’ menu, then ‘Axis Titles’, then ‘Primary Horizontal Axis Title’, then ‘Title 
Below Axis’ 

ii. Type ‘Month’ and hit <Return> 
iii. Select the ‘Layout’ menu, then ‘Axis Titles’, then ‘Primary Vertical Axis Title’, then ‘Rotated 

Title’ 
iv. Type ‘Flow Difference (AF/mo)’ and hit <Return> 

  

Now we can see that this surface water hydrograph is the flow difference at river node 332, one node 
downstream from the modified diversion, and near the groundwater-substitution pumping well. The maximum 
flow rate of the GST Case is approximately 950 AF/mo higher than the Base Case for a period, then falls 
sharply to 400-500 AF/mo less than the Base Case, and then gradually recovers to be nearly equal to the Base 
Case before the cycle repeats. This cycle is repeated each year, with a slight drop in the GST Case flows over 
time.  

g) We can make a copy of this graph, and use it to focus on several years, as we did with the 
groundwater hydrograph 
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i. Right-click on the tab ‘SWHyd’ and select ‘Move or Copy…’ to open the ‘Move or Copy’ 
window 

ii. Check the box next to ‘Create a copy’ in the lower left, then highlight ‘SWHyd’ in the window 
‘Before sheet’ and click ‘OK’. This creates a copy called ‘SWHyd (2)’. 

iii. Right-click on the x-axis and choose ‘Format axis…’ 
iv. We want to look at a three-year period, so we will set the minimum x-axis value to 

10/31/1972 and the maximum value to 09/30/1975.  
v. Under ‘Axis Options’, for ‘Minimum’, we will keep the numerical value of 10/31/1972, which 

is ‘26603’ 
vi. For ‘Maximum’, we will enter the numerical value of 09/30/1975 is ‘27698’ 
x. For ‘Major Unit’, click the radio button next to ‘Fixed’ and enter ‘30’  
xi. Place the cursor over the line, right-click, and select ‘Format data series…’ to open the 

Format Data Series window. 
xii. Select the second item in the left panel, ‘Marker Options’, select the button next to 

‘Automatic’, and then click ‘Close’ in the lower left corner. 

 

Here we can see the monthly surface water flow difference at river node 332, downstream from the point of 
the modified diversion, for the first three years of the simulation. This shows that the stream flow for the GST 
Case is greater than that of the Base Case in the months June through August, then falls sharply to a rate 
lower than the Base Case in September, and the recovers to near the Base Case flow rate by May. The surface 
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water diversion for the GST Case was reduced by 2,000 AF/mo each month, from June through August, but the 
increase in river flows is less than half this amount. As we will see below, the remainder flows into the 
groundwater through changes in the stream-groundwater flows. 

We can also plot the difference in river flows in the Sacramento River at Freeport (river node 384, in column L 
of the worksheet). 

 

The flow difference at the Sacramento River at Freeport gage appears to be nearly identical to that at river 
node 332. This shows that when the surface water diversion is replaced by groundwater pumping, less than 
half of the water left in the river actually flows from the basin and is available for transfer. 

 

 

Compare  Budget  Tab les 

Graphs of project impacts on groundwater heads and stream flows can help us identify the broad impacts of 
the project. We can then use the detailed Budget tables to compare differences in individual flow terms to 
gain a better understanding of project impacts. In this section, we will compare GWP Case and Base Case 
Budget tables for the Land and Water Use, Root Zone, Groundwater, and Stream Reach Budgets. 
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We saw from the groundwater hydrograph and surface water hydrographs that although the GST Case 
reduced surface water diversions by 2,000 AF/mo for three months each year, the river flows during these 
months increased by less than half this amount. Also, we saw that river flows were reduced in the other nine 
months of the year, with the deficit increasing over time. 

We can use the budget output tables to check that we simulated the correct surface water diversion and 
groundwater pumping rates, and also to explore the impacts of the GST project on individual flow terms. 

Compare Land and Water Use Budgets for Subregion 4 
We can see the impact of the changes in the surface water diversion and groundwater pumping by comparing 
the Land and Water Use Budget tables for one or more subregions between the GST Case and Base Case. The 
GST pump is located in model subregion 4 and surface water diversion #27 delivers water to subregion 4, so 
we will compare the GST Case and Base Case Land and Water Use Budget tables for this subregion. 

1) Open the two Excel workbooks Base_Land_and_Water_Budget.xlsx and 
GST_Land_and_Water_Budget.xlsx.  

2) Create a new Excel workbook and save it as GST_Land_and_Water_Compare.xlsx in directory 
GST_Case_Study.  

3) Rename the worksheet ‘Sheet1’ to ‘Land Water SR4’. 
4) We want to copy the format (dates, column titles, etc) of the Land and Water Use Budget tables to 

the worksheet of the new workbook. Go to (for example) tab ‘Subregion 4 (DSA 15)’ of 
GST_Land_and_Water_Budget.xlsx. Click in the box in the upper left, above row label ‘1’ and to 
the left of column label ‘A’. This will select the entire worksheet. Use <Ctrl-C> to copy the column. 

5) Go to tab ‘Land Water SR4’ of GST_Land_and_Water_Compare.xlsx and put the cursor in cell 
A1. Use <Ctrl-V> to paste the contents of worksheet ‘Subregion 4 (DSA 15)’. 

6) Format the column headers 
a) Click on the box with ‘5’ on the left side of the workbook to select the row 
b) Use <Ctrl-1> to open the ‘Format Cells’ panel 
c) Select the ‘Alignment’ tab 
d) Use the drop-down menu under ‘Horizontal’ to select ‘Center’ 
e) Use the drop-down menu under ‘Vertical’ to select ‘Center’ 
f) Check the box next to ‘Wrap text’ 
g) Click ‘OK’ to close the panel 
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7) Next we want to replace the values in this worksheet with formulas to calculate the difference 
between the GST Case and Base Case for subregion 4.  
a) Place the cursor in cell B5 (to the right of date 10/31/1972) and press ‘=’ to start a new formula.  
b) Without hitting return or touching anything else with the cursor, select the ‘View’ menu and use 

the ‘Switch Windows’ button to choose the GST_Land_and_Water_Budget.xlsx workbook.  
c) Go to the tab labeled ‘Subregion 4 (DSA 15)’.  
d) Place the cursor in cell B6, then hit the <F4> key three times to remove the ‘$’ signs in the 

formula.  
e) Type the minus sign ‘-‘.  
f) Again, without hitting return or touching anything else with the cursor, select the ‘View’ menu 

and use the ‘Switch Windows’ button to choose the Base_Land_and_Water_Budget.xlsx 
workbook.  

g) Go to the tab labeled ‘Subregion 4 (DSA 15)’.  
h) Place the cursor in cell B6, then hit the <F4> key three times to remove the ‘$’ signs in the 

formula.  
i) Hit the return key.  

The cell formula should be ='[GST_Land_and_Water_Budget .xlsx]Subregion 4 (DSA 15)’!B6-
'[Base_Land_and_Water_Budget.xlsx]Subregion 4 (DSA 15)’!B6. The cell value should be close to 
zero. 

8) Next, we will copy this formula to all the cells in the budget table.  
a) Place the cursor in cell B6 and then move the cursor over the small black square that appears in 

the lower right corner of the cell so the cursor changes to a black plus sign. Double-click on the 
black square to copy the formulas down column B to the end of the column.  

b) Then use <Ctrl-C> to copy the formulas in this column, <Ctrl><Shift><Right> to select the other 
cells in the budget table, and <Ctrl-V> to paste the formula. 
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Review the Differences 
The Land and Water Use Budget reports the monthly balance between water demand and water supply. We 
can visually see the major difference between the GST Case and the Base Case: The values in column E, which 
is labeled ‘Ag. Pumping (+)’, are 1,760 AF/mo for June through August 1973, representing the additional 
pumping of the GST Case. The values in column F, ‘Ag. Diversion’, are -1,760 AF/mo for June through August 
1973, representing the delivery portion of the surface water diversion that was reduced by 2,000 AF/mo. These 
values confirm that the GST Case is correctly simulating the project. 

 

 

Compare Root Zone Budgets for Subregion 4 
The Root Zone Budget provides details of the monthly water inflows and outflow of the land surface process. 
It shows how changes in water availability affect root-zone water storage, return flows and deep percolation. 
We will compare the Base Case and GST Case Root Zone Budget tables for Subregion 4. 

1) Open the two Excel workbooks Base_Root_Zone_Budget.xlsx and 
GST_Root_Zone_Budget.xlsx.  

2) Create a new blank workbook GST_Root_Zone_Compare.xlsx. Name the first worksheet ‘Root 
Zone SR4’. 

3) We want to copy the format (dates, column titles, etc) of the Groundwater Budget tables to the 
worksheet of the new workbook. Go to (for example) tab ‘Subregion 4 (DSA 15)’ of 
GST_Root_Zone_Budget.xlsx. Click in the box in the upper left, above row label ‘1’ and to the 
left of column label ‘A’. This will select the entire worksheet. Use <Ctrl-C> to copy the column. 

4) Go to tab ‘Root Zone SR4’ of GST_Root_Zone_Compare.xlsx and put the cursor in cell A1. Use 
<Ctrl-V> to paste the contents of worksheet ‘Subregion 4 (DSA 15)’. 

5) Format the column headers 
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a) Click on the box with ‘5’ on the left side of the workbook to select the row 
b) Use <Ctrl-1> to open the ‘Format Cells’ panel 
c) Select the ‘Alignment’ tab 
d) Use the drop-down menu under ‘Horizontal’ to select ‘Center’ 
e) Use the drop-down menu under ‘Vertical’ to select ‘Center’ 
f) Check the box next to ‘Wrap text’ 
g) Click ‘OK’ to close the panel 

6) Next we want to calculate the difference between the GST Case and Base Case for Subregion 4.  
a) Place the cursor in cell B5 (to the right of date 10/31/1972) and press ‘=’ to start a new formula.  
b) Without hitting return or touching anything else with the cursor, select the ‘View’ menu and use 

the ‘Switch Windows’ button to choose the GST_Root_Zone_Budget.xlsx workbook.  
c) Go to the tab labeled ‘Subregion 4 (DSA 15)’.  
d) Place the cursor in cell B6, then hit the <F4> key three times to remove the ‘$’ signs in the 

formula.  
e) Type the minus sign ‘-‘.  
f) Again, without hitting return or touching anything else with the cursor, select the ‘View’ menu 

and use the ‘Switch Windows’ button to choose the Base_Root_Zone_Budget.xlsx 
workbook.  

g) Go to the tab labeled ‘Subregion 4 (DSA 15)’.  
h) Place the cursor in cell B6, then hit the <F4> key three times to remove the ‘$’ signs in the 

formula.  
i) Hit the return key.  

The cell formula should be ='[GST_Root_Zone_Budget.x lsx]Subregion 4 (DSA 15)’!B6-
'[Base_Root_Zone_Budget .x lsx]Subregion 4 (DSA 15)’!B6. The cell value should be close to zero. 

7) Next, we will copy this formula to all the cells in the budget table.  
a) Place the cursor in cell B6 and then move the cursor over the small black square that appears in 

the lower right corner of the cell so the cursor changes to a black plus sign. Double-click on the 
black square to copy the formulas down column B to the end of the column. 

b) Then use <Ctrl-C> to copy the formulas in this column, <Ctrl><Shift><Right> to select the other 
cells in the budget table, and <Ctrl-V> to paste the formula. 

Review the Differences 
The Land and Water Use Budget showed us that there is no difference in total available water between the 
GST Case and the Base Case. This means there should be no changes in the Root Zone Budget, and we can 
see that this is indeed the case. The values in column E, ‘Ag. Prime Applied Water’, are ‘0.00’, verifying that 
there is no difference in applied water between the two cases.  
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(There are slight differences in some years, such as 1976, when the original surface water diversion is less 
than 2,000 AF/mo in some months. These differences are minor, and for the purposes of this tutorial will not 
be addressed. In practice, the groundwater pumping rates for these months could be modified from 1,760 
AF/mo and set to exactly match the actual reduction in surface water deliveries.) 

 

Compare Groundwater Budgets for Subregion 4 
We can see the impact of the increased pumping on the groundwater aquifer by comparing the Groundwater 
Budget tables for one or more subregions between the GST Case and Base Case. The GST pump is located in 
model Subregion 4, and we can compare the Groundwater Budget tables for the two cases for this subregion. 

1) Open the two Excel workbooks Base_Groundwater_Budget.xlsx and 
GST_Groundwater_Budget.xlsx.  

2) Create a new Excel workbook GST_Groundwater_Compare.xlsx and save it in the directory 
GST_Case_Study.  

3) Rename the worksheet ‘Sheet1’ to ‘Groundwater SR4’. 
4) We want to copy the format (dates, column titles, etc) of the Groundwater Budget tables to the 

worksheet of the new workbook. Go to (for example) tab ‘Subregion 4 (DSA 15)’ of 
GST_Groundwater_Budget.xlsx. Click in the box in the upper left, above row label ‘1’ and to the 
left of column label ‘A’. This will select the entire worksheet. Use <Ctrl-C> to copy the column. 

5) Go to tab ‘Groundwater SR4’ of GST_Groundwater_Compare.xlsx and put the cursor in cell A1. 
Use <Ctrl-V> to paste the contents of worksheet ‘Subregion 4 (DSA 15)’. 

6) Format the column headers 
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a) Click on the box with ‘5’ on the left side of the workbook to select the row 
b) Use <Ctrl-1> to open the ‘Format Cells’ panel 
c) Select the ‘Alignment’ tab 
d) Use the drop-down menu under ‘Horizontal’ to select ‘Center’ 
e) Use the drop-down menu under ‘Vertical’ to select ‘Center’ 
f) Check the box next to ‘Wrap text’ 
g) Click ‘OK’ to close the panel 

7) Next we want to calculate the difference between the GST Case and Base Case for Subregion 4.  
a) Place the cursor in cell B5 (to the right of date 10/31/1972) and press ‘=’ to start a new formula.  
b) Without hitting return or touching anything else with the cursor, select the ‘View’ menu and use 

the ‘Switch Windows’ button to choose the Base_Groundwater_Budget.xlsx workbook.  
c) Go to the tab labeled ‘Subregion 4 (DSA 15)’.  
d) Place the cursor in cell B6, then hit the <F4> key three times to remove the ‘$’ signs in the 

formula.  
e) Type the minus sign ‘-‘.  
f) Again, without hitting return or touching anything else with the cursor, select the ‘View’ menu 

and use the ‘Switch Windows’ button to choose the GST_Groundwater_Budget.xlsx 
workbook.  

g) Go to the tab labeled ‘Subregion 4 (DSA 15)’.  
h) Place the cursor in cell B6, then hit the <F4> key three times to remove the ‘$’ signs in the 

formula.  
i) Hit the return key.  

The cell formula should be ='[GST_Groundwater_Budget .xlsx]Subregion 4 (DSA 15)'!B6-
'[Base_Groundwater_Budget .xlsx]Subregion 4 (DSA 15)'!B6. The cell value should be close to zero. 

8) Next, we will copy this formula to all the cells in the budget table.  
a) Place the cursor in cell B6 and then move the cursor over the small black square that appears in 

the lower right corner of the cell so the cursor changes to a black plus sign. Double-click on the 
black square to copy the formulas down column B to the end of the column.  

b) Then use <Ctrl-C> to copy the formulas in this column, <Ctrl><Shift><Right> to select the other 
cells in the budget table, and <Ctrl-V> to paste the formula. 

Review the Differences 
We can visually see several differences between the GST Case and Base Case. First, we see that the values in 
the column labeled ‘Pumping (-)’ are ‘0.00’ for October 1972 through May 1973, ‘1760.01’ for June through 
August 1973, and ‘0.00’ for September 1973. These values mirror what we specified in the Pumping Data File, 
and are than repeated each year through 2009. We also see that the values in the column labeled ‘Recharge 
(+)’ are ‘0.00’ for October 1972 through May 1973, approximately -200 for June through August 1973, and 
‘0.00’ for September 1973. This represents the reduction in recoverable losses that occurred as a result of the 
reduction in the surface water diversion rate. Thus the net loss to the groundwater aquifer is 1,760 AF 
extracted by the pump plus 200 AF less recharge, for a total of 1,960 AF/mo, or 5,880 AF/yr.  
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In order to have a water balance for the aquifer, this 1,960 AF/mo net reduction in water volume has to be 
offset with 1,960 AF/mo from other sources. Looking at the row for June 1973, we see that 943 AF was 
removed from groundwater storage (when the water table dropped), 982 AF less water was discharged to 
streams, 1 AF was removed from storage due to land-surface subsidence, and 34 AF flowed into the subregion 
from adjacent subregions (due to the changed groundwater head gradient).  

The values in the column ‘Gain from Stream (+)’ are even larger in July and August, and continue to be greater 
than zero for the rest of the simulation. We have found the reason why the surface water flows of the GST 
Case are only about 1,000 AF/mo greater than the Base Case, even though the surface water diversion was 
reduced by 2,000 AF/mo. The pump lowers the groundwater head adjacent to the stream, which in turn 
changes the flow rates between the stream and the aquifer.  

 

We can highlight ‘Gain from Stream’ values for the three months June through August to quickly see the 
impact of the groundwater substitution water transfer project on stream-aquifer flows in these months. We 
see from the value on the lower edge of the Excel window that groundwater discharges to the river are 
reduced by 3,715 AF during these months, 62% of the 6,000 AF reduction in surface water diversions. This 
suggests the project is only increasing river flows by 38% of the expected increase, and confirms the flow 
rates we observed in the surface water hydrographs.  
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We can also highlight 12 months of ‘Gain from Stream’ values to quickly see the annual change in stream-
aquifer flows under the GST Case. We see from the value on the lower edge of the Excel window that 
groundwater discharges to the river are reduced by 4,746 AF in the first year of the project. This is 80% of the 
6,000 AF/yr reduction in surface water diversions. This also implies that although the surface water diversion 
was reduced by 6,000 AF/yr, only 1,254 AF/yr of this water is actually available for delivery to other water 
users. The rest of the water was essentially removed from the river in a complex chain reaction when the 
pumps were operated. 

Create a Water Year Summary 
We can use the ‘WY-Month’ tool on the ‘IWFM Tools’ menu to see the differences between the groundwater 
pumping case and the base case for each flow term. We will demonstrate this by looking at the changes in 
stream-aquifer flows, labeled ‘Gain from Stream (+)’, in column F. 

Under the ‘IWFM Tools’ menu, select ‘WY-Month’ to open the ‘WY-Month’ panel.  

1) Place the cursor in the ‘Date Range’ area and select the dates from column A, cells A6 to A449.  
2) Place the cursor in the ‘Time Series Data Range’ area and select the data values from column F, cells 

F6 to F449.  
3) Put the cursor in the ‘Output range’ area and select cell S5.  
4) In the ‘Unit Conversion’ section, click next to ‘AF’ under ‘Time Series Data’ and ‘TAF’ under ‘Table’. 
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5) At the bottom of the WY-Month panel, click the boxes next to ‘Use 1000 Separator’ and the graphs 
for monthly averages and annual totals, and click ‘OK’.  

 

This produces a table with the monthly difference in stream-aquifer flows between the two cases for 
Subregion 4, with total annual difference in the right-most column. Average, minimum and maximum values 
are listed at the bottom of this table. Two graphs are also produced, to the right of the Water Year-Month 
table.  

 

The top graph shows the average monthly difference in stream-aquifer flows between the two scenarios. This 
shows the greatest difference in the months of June to August when the pumps are operating, with smaller 
values in the months when the pumps are not operating. The value is always positive, indicating that the 
aquifer does not completely recover to Base Case conditions in less than a year.   
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The lower graph shows the annual difference in stream-aquifer flows between the two cases. The flow 
difference starts around 4,000 AF/year in the first year and increases to over 5,000 AF/yr by the fifth year, 
staying at this level through 2009. This suggests that after the fifth year of the project, most if not all of the 
5,280 AF/yr in additional groundwater pumping is replenished directly from the rivers. 

 

Compare Stream Reach Budgets for Reach 53 
The new pump is located near reach 53. We can see the impact of the pumping portion of the GST Case on the 
adjacent portion of the river by looking at the Stream Reach Budget for reach 53. 

1) Open the two Excel workbooks Base_Stream_Reach_Budget.xlsx and 
GST_Stream_Reach_Budget.xlsx.  

2) Create a new Excel workbook and save it in directory GST_Case_Study with the name 
GST_Stream_Reach_Compare.xlsx.  

3) Rename the worksheet ‘Sheet1’ to ‘Stream Reach 53’. 
4) We want to copy the format (dates, column titles, etc) of the Stream Reach Budget tables to the 

worksheet of the new workbook. Go to tab ‘Stream reach 53’ of 
GST_Stream_Reach_Budget.xlsx. Click in the box in the upper left, above row label ‘1’ and to 
the left of column label ‘A’. This will select the entire worksheet. Use <Ctrl-C> to copy the column. 

5) Go to tab ‘Sheet1’ of GST_Stream_Reach_Compare.xlsx and put the cursor in cell A1. Use <Ctrl-
V> to paste the contents of worksheet ‘Stream reach 53’. 

6) Format the column headers 
a) Click on the box with ‘5’ on the left side of the workbook to select the row 
b) Use <Ctrl-1> to open the ‘Format Cells’ panel 
c) Select the ‘Alignment’ tab 
d) Use the drop-down menu under ‘Horizontal’ to select ‘Center’ 
e) Use the drop-down menu under ‘Vertical’ to select ‘Center’ 
f) Check the box next to ‘Wrap text’ 
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g) Click ‘OK’ to close the panel 
7) Next we want to calculate the difference between the GST Case and Base Case for river reach 67.  

a) Place the cursor in cell B5 (to the right of date 10/31/1972) and press ‘=’ to start a new formula.  
b) Without hitting return or touching anything else with the cursor, select the ‘View’ menu and use 

the ‘Switch Windows’ button to choose the Base_Stream_Reach_Budget.xlsx workbook.  
c) Go to the tab labeled ‘Stream reach 53’.  
d) Place the cursor in cell B5, then hit the <F4> key three times to remove the ‘$’ signs in the 

formula.  
e) Type the minus sign ‘-‘.  
f) Again, without hitting return or touching anything else with the cursor, select the ‘View’ menu 

and use the ‘Switch Windows’ button to choose the GST_Stream_Reach_Budget.xlsx 
workbook.  

g) Go to the tab labeled ‘Stream reach 53’.  
h) Place the cursor in cell B5, then hit the <F4> key three times to remove the ‘$’ signs in the 

formula.  
i) Hit the return key.  

The cell formula should be ='[Base_Stream_Reach_Budget .xlsx]Stream reach 53'!B5-
'[GST_Stream_Reach_Budget .xlsx]Stream reach 53'!B5’. The cell value should be close to zero. 

8) Next, we will copy this formula to all the cells in the budget table.  
a) Place the cursor in cell B5 and then move the cursor over the small black square that appears in 

the lower right corner of the cell so the cursor changes to a black plus sign. Double-click on the 
black square to copy the formulas down column B to the end of the column.  

b) Then use <Ctrl-C> to copy the formulas in this column, <Ctrl><Shift><Right> to select the other 
cells in the budget table, and <Ctrl-V> to paste the formula. 
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The cell values should be zeroes for the first few months, then change to non-zero numbers beginning in June 
1973. 

Review the Differences 
We can use the ‘WY-Month’ tool on the ‘IWFM Tools’ menu to see the differences between the GST Case and 
the Base Case. For this example, we will look at how the downstream flows from the river reach change. (This 
could also be accomplished by adding a hydrograph at this river node to the Print Control File and re-running 
the Simulation program.) 

Under the ‘IWFM Tools’ menu, select ‘WY-Month’ to open the ‘WY-Month’ panel.  

1) Place the cursor in the ‘Date Range’ area and select the dates from column A, cells A5 to A448.  
2) Place the cursor in the ‘Time Series Data Range’ area and select the data values from column C, cells 

C5 to C448.  
3) Put the cursor in the ‘Output range’ area and select cell P5.  
4) In the ‘Unit Conversion’ section, click next to ‘AF’ under ‘Time Series Data’ and ‘TAF’ under ‘Table’. 
5) At the bottom of the WY-Month panel, click the boxes next to the graphs for monthly averages and 

annual totals, and click ‘OK’.  

 

This will produce a table with the monthly downstream outflow difference between the two cases for river 
reach 53. This difference downstream outflow will incorporate much of the differences in flows resulting from 
the reduced diversions and increased pumping; some impacts might also occur on other river reaches. 
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This table makes it easier to compare the monthly values from year to year. We can see that the monthly 
values are relatively stable from year to year, suggesting that the project impacts are insensitive to water 
availability (i.e. wet year or dry year). Two graphs are also produced, to the right of the Water Year-Month 
table.  

 

The top graph shows the average monthly difference in downstream flows between the two scenarios. This 
confirms the information in the Groundwater Budget and suggests that the majority of the change in stream-
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groundwater flows occurs in the reach closest to the pump. The pattern is also similar to that observed in the 
stream hydrographs above.  

 

The lower graph shows the annual differences in outflows from Reach 53 between the two cases. The flow is 
reduced by approximately 4,800 AF/year after the fifth year of the project. The 6,000 AF/year project therefore 
produces only approximately 1,200 AF/year in additional inflows to the Sacramento-San Joaquin Delta.  

Summary 

This example scenario shows how the C2VSim model can be used to analyze a proposed project that will 
impact both the surface water and groundwater flow systems. Decision 1641 of the State Water Resources 
Control Board requires that Sacramento River flows are sufficient to meet Sacramento-San Joaquin Delta 
inflow requirements. DWR and the USBR want to assure that each proposed water transfer out of the 
Sacramento River Basin does not require these agencies to release additional water to meet these flow 
requirements.  

The stated goal of this project is to reduce surface water diversions at an upstream location, and to sell this 
water to a buyer located down-stream from the Sacramento River at Freeport gage. It seems logical to assume 
that when a surface water diversion in the Sacramento River Basin is reduced by 6,000 AF over three months, 
the downstream flow will be increased by this amount, or by something close to this amount. However, the 
groundwater substitution component of this project has significant impacts on river flows. The groundwater 
withdrawn from the aquifer has to come from somewhere. And in this case study, much of this water comes 
from a reduction in groundwater discharges to the river.  

The net effect of this groundwater-substitution water transfer project is that only a small portion of the 6,000 
AF actually reaches the Sacramento River at Freeport gage. If the entire 6,000 AF in reduced surface water 
diversions were sold to a downstream user, then another entity (most likely DWR or the USBR) would need to 
release additional water from upstream reservoirs to meet Delta inflow requirements. 
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This scenario could also be used to investigate the impacts of different pump locations on river flows. The 
pump is screened in the water table layer in this scenario. Surface water flow reductions during summer 
months may be reduced by screening the pump in the confined portion of the aquifer (model layer 2) or by 
locating the pump several miles away from any rivers. 
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